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This User Manual is a compilation of various WinPack references 
including: 
 

• WinPack’s Help file, the primary source of text 
• Help files for some WinPack Add-on Programs 
• Informational .TXT files which can be found in the WinPack directory 
• Informational files from the WinPack web site 

 
Nearly all of this text was written by the WinPack program author, Roger 
Barker, G4IDE, who has been diligent in keeping these items up-to-date.  
 
In addition to providing a single source of how to use WinPack, a primary 
objective of this Manual is to help the user learn what WinPack can do.  
 
In compiling the text to meet those objectives, some editing of the source 
text was done, including: 
 

• re-ordering the sequence of Help topics 
• removing redundant text that occurs naturally in Help files 
• adding context that was lost when context-sensitive Help is pulled 

away from program windows and screens  
• adding additional screen-shot graphics 

 
Very little original language was added by the editor. 
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1. Welcome to WinPack! 
 
WinPack is a terminal program used by Amateur Radio operators to communicate in a 
digital mode called “packet”. ( Packet gets its name from the short sentences, or 
packets, of data exchanged by radio in the form of tone bursts.) 
 
WinPack provides a full-featured Windows©  interface to use with a Terminal Node 
Controller (TNC), a device that generates the tones that are sent to the Amateur radio 
and transmitted. (Think of a TNC as a modem for a radio, instead of for a telephone.) 
 
WinPack has full support for: 

• mail reading and mail writing 
• bulletin listing/reading/replying 
• FBB unproto beacons (FBB is a Bulletin Board System (BBS) program) 
• compressed downloading  and forwarding of BBS messages 
• auto-connection to your local BBS 
• script files to automate such tasks as connecting 
• YAPP File Transfer   
• automatic 7plus file encode and decode 
• external servers 
• remote PMS (Packet Mailbox System) commands 
and more!  

 
Because it runs in Windows, your packet system can be running all the time, while you 
use your PC for other things. It supports TNCs in terminal mode, and it also has support 
for several host modes. It will run "on top of" the G8BPQ node software, AGWPE, and 
Flexnet (with TFEMU). 
 
If you are unable to connect to a packet BBS via radio, WinPack can be used with a 
telephone modem to connect to the land-line port of an FBB BBS (see phone modem 
support for more information), and it can use the internet to connect to a packet BBS via 
Telnet. 
 
WinPack supports a wide variety of servers and external programs, including viewers 
for special message formats, e.g. HTML. 
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My Philosophy on Amateur Radio 
 
A message from the program author: 
 
I believe that the essential elements of amateur radio are self-training and 
experimentation. If you remove those, then radio amateurs become no different to PMR 
users. (Many peoplewould say no different to CB operators, but I have seen many CB 
operators who demonstrate these essential elements.) To me, holding an amateur 
licence and being a radio amateur are not necessarily the same thing! 
 
Because of this belief, I have always resisted making WinPack a completely "push 
button" system. It still expects you to know something about your TNC, it expects you to 
know something about your PC, it expects you to learn how to use Windows. 
 
WinPack will carry out many tasks automatically, but it will also provide you with plenty 
of scope for experimentation (yes, even on packet you can experiment!).  You can 
experiment with using host mode, you can experiment with using BPQ, you can 
experiment with HTML and using WinPack in conjunction with Netscape and other 
viewers, you can experiment with using WinPack with PC Flexnet . But Please don't 
regard these aspects of WinPack as facilities which will work straight "out of the box" 
without you having to give it a little bit of thought, or having to read any of the available 
documentation - to me that isn't amateur radio! 
 
Have fun! 
 
 
73 - Roger, G4IDE 
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2. Downloading and Installing WinPack 
 
You can download the most recent version of WinPack at this website: 
 
http://www.ui-view.com/winpack/index.shtml 
 
Besides the installation and version update files, you’ll also find a few utility programs 
that might be of interest. 
 
The WinPack installation file is a self-extracting archive (.EXE) which is just over 2 MB. 
Running the archive will start the automatic installation process. You will, however, be 
given a choice on the path and name of the directory in which WinPack will be installed. 
 
If you prefer to have the installation file on two floppy disks, read FLOPPY.TXT from the 
web page, then download the special installation set for floppy disks.  
 
Note - these disk images are NOT the equivalent of splitting the installation file across 
two floppy disks with a third-party file-splitting or compression program. These disk 
images allow you to install WinPack direct from the floppies, without having to first 
rebuild the archive. 
 
To update any version later than V6.51 (the previous base version), look for the update 
file to download. Changes that have occurred in each update can be found in the 
CHANGES.TXT file, which is available at the web site. It is also installed in the WinPack 
\DOCS directory and directly accessible from the Help menu in WinPack. 
 
Keep it Clean 
 
This isn't a health advisory; it's a plea!   Please do not put any of your own files in the 
WinPack directory. Do not create sub-directories in it. Regard it as a directory which 
WinPack uses and which you should not use. Also, do not create a file called TEMP in 
the WINPACK directory. If WinPack can't create a sub-directory called TEMP, or it can't 
completely clear it from time to time, then you may get problems with 7plus encoding 
and decoding. 

http://www.ui-view.com/winpack/index.shtml
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3. License and Registration 

Licensing Conditions For WinPack V6.7 
 
If you install WinPack, you accept these licensing conditions, so please read them 
carefully! 
 
WinPack V6.7 is copyright Peak Systems, August 2001. 
 
WinPack is for use only by radio amateurs, as part of their hobby of amateur radio. 
Commercial use of WinPack is not permitted. 
 
Any amateur may pass a copy of WinPack to another amateur, provided that they pass 
on the distribution file(s) in their entirety. You are not allowed to alter the distribution 
file(s) in any way. 
 
The WinPack distribution file(s) must NOT be sent by 7plus (or in any other format) on 
the packet network, if the distribution address you send them to would result in them 
appearing on the UK network. (Effectively that means you can't send them @GBR, 
@EU or @WW.) This restriction also applies to any files that issue as part of an update. 
 
If you have a registered copy of WinPack, you must not pass on your registration 
information to any other user. 
 
Roger Barker, G4IDE 
roger@peaksys.co.uk 
 
 

mailto:roger@peaksys.co.uk
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How to Register 
 
Please note that from version 6 onwards, WinPack can be registered. An unregistered 
version is fully functional -- it isn't shareware, because you can use it for as long as you 
want. It will however occasionally display a message box reminding you that it isn't 
registered. (If you have no intention of ever registering the program, and you think the 
reminders might become annoying and you’d like to prevent them, please do not try to 
circumvent this by installing this version on top of an existing, older version of WinPack. 
 
Once WinPack is registered, the "not registered" reminder box will stop appearing. 
Instead it will  show your personal registration details when the program starts or when 
"Registration Details" is selected from the Help menu. 
 
If your registration information is displayed, there is a check box which is labelled "Show 
At Start Up" - the default is that WinPack briefly displays your registration information 
every time the program is started. If you don't want it to do that, then uncheck this box. 
Please Note - you cannot uncheck this box if the callsign in the registration information 
is not the same as the Callsign set in Personal/BBS Info.  
 
Q. What do I receive when I register? 
A. You will immediately receive an email comfirming your order. Within 48 hours 
(usually much sooner) you will receive your registration information. You should then 
use the "Register WinPack" option on the WinPack Help menu and input the registration 
information  - callsign, name, address, registration number. 
 
Q. What do I do if I haven't got a ham radio callsign? 
A. The WinPack registration number is calculated from the user's callsign, name and 
address, so you must put something for 'callsign'. You can put any group of from three 
to six letters, I would suggest that you use your initials, or an abbreviation of your name. 
 

Online Internet Registration 
Online registration via credit card payment is available from: 
 http://www.ui-view.com/winpack/winpreg.html 
 
The on-line registration service uses a secure server for inputting your credit card 
information, and is quick and easy to use. It’s the preferred method of registering. 
 
Q. Exactly how much will I pay for the registration? 
A. You will pay exactly 10 GB pounds (GBP). That is the equivalent of about 15 US 
dollars or 16 Euros. If you are outside the UK, when your credit card company 
processes the transaction, they will convert 10 GBP to your local currency using the 
current exchange rate. There is no surcharge, and paying on-line with a credit card is 
much cheaper than sending an international money order. 
 

http://www.ui-view.com/winpack/winpreg.html
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Q. What if the user's name and address is different to the credit card name and 
address? 
A. If the user's name and address is different to the credit card name and address, 
please input the user's name and address in the 'Shipping Details' section of the order 
form on the Secure Server.  
 

Registration By Mail 
Send £10 cash, cheque or UK Postal Order to:- 
 

Roger Barker, G4IDE 
79 South Parade 
Boston 
Lincolnshire 
PE21 7PN 
UK 

 
Please make sure you include your callsign, your name and your address. A suitable 
registration form is available for you to print off on the next page. 
 
You will be sent by return post a registration number. If you prefer, the registration 
number can be sent to you via internet email, but it cannot be sent via packet. You 
should then use the "Register WinPack" option on the WinPack Help menu and input 
the registration information. 
 

Registering From Outside The UK 
If you are outside the UK, then registering online may well be the easiest and cheapest 
method. Or you can either get an International Money Order for 10 UK pounds from 
your bank, or send me a personal cheque (check). If you do the latter, then please 
calculate the amount at the current exchange rate + 15% to allow for the cost of me 
negotiating the cheque. 
 
I can also accept cash payment in the following currencies - US dollars, Australian 
dollars, and all major EU currencies. Again, please add on 15% to allow for the cost of 
me changing the money  -  see FAQ #10 
 
Registering WinPack will help to ensure that development of the program 
continues. Many thanks for your support. 
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Registration Form 
 
This form can be printed by using "Print Topic" from the "File" menu at the top of this 
help window. 
 
To: Roger Barker, G4IDE 
  79 South Parade 
  Boston 
  Lincs PE21 7PN 
  UK 
 
I would like to register my copy of WinPack V6. I enclose a registration fee of 10 
ukp (UK pounds). My registration information is as follows:- 
 
 
Callsign  :  _____________ 
 
Name     :  __________________________________ 
 
Address :  __________________________________ 
 
    __________________________________ 
 
    __________________________________ 
 
    __________________________________ 
 
 
(Please write clearly. Callsign, name and at least two lines of address are 
required). 
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4. Getting Started 
 
WinPack, as its name implies, is a Windows program! It uses many standard Windows 
controls - menus, file dialogues, etc. One thing you must appreciate is that if you aren't 
comfortable with Windows, you might at first find the program difficult. If so, stick with it, 
for once you get used to Windows, you'll never go back to DOS!   And using WinPack 
without a mouse completely spoils the program. So even if you hate it, try and get used 
to clicking! 
 
Don't try to immediately use all the features of the program. Once you have used the 
setup menu option to configure WinPack to match your TNC, start off using WinPack as 
a simple terminal and completely ignore most of the features. Try out the more 
advanced features when you are comfortable with the basics. 
 

Getting Assistance 
 
There are several different sources for help about WinPack: 
 

1. WinPack has an integrated, context-sensitive Help which you can access from 
the Menu bar Help>Help Contents or by pressing the F1 key on any screen. 

2. Look for informational “*.TXT” help files that will have been installed in the 
WinPack directory or subdirectories. 

3. Look over the WinPack website for links to still more special information files: 
 http://www.ui-view.com/winpack/index.shtml  

4. This User Manual attempts to consolidate all the above information into one 
source. 

 
In addition, plese note there is a WinPack email list (reflector) which you can join to ask 
for help, learn about program enhancements, report bugs, etc. You can join at: 
 
http://groups.yahoo.com/group/winpack/join 
 
An email posting to the group usually gets a quick response from a knowledgeable user 
or even the WinPack author himself, Roger G4IDE. 
 
Remember - if you get stuck, read the help!  Context sensitive help is always available 
by pressing  F1. 
 

http://www.ui-view.com/winpack/index.shtml
http://groups.yahoo.com/group/winpack/join
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The Main Screen: Getting Around in WinPack 
 
Throughout this manual, references will be made to the various parts of WinPack’s Main 
Screen. Please note the locations of the Menu and Button bars; the Receive and 
Transmit Windows; and the Status Line. 
 
     The Main Screen 

 

Menu Bar 
Nearly all the key features of WinPack can be controlled from the menus and submenus 
available on this bar. Sections of this manual will be making continual reference to this 
bar. There is also a Menu Bar appendix to this manual which describes each menu and 
its submenus and options. 
 

Button Bar 
Some of the features accessible through the menu bar are also available from buttons 
on the button bar. There is also a ‘Button Bar’ appendix to this manual which describes 
each button; it also describes how to customize the button bar. 
 

Receive Window (s) 
All incoming text goes into the Receive Window (as does a copy of any text you send 
out). The window can be either a large single window taking up most of the screen (as 
shown above) or it can be split into two smaller windows. If it is split, then the Window 
Button allows you to select one of the two windows as the primary receive window. The 
sizes of the two windows can be adjusted as follows - Put the mouse cursor on the 

 
WinPack User Manual 
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separator bar between the two windows and it will turn into a horizontal bar. You can 
then drag the bar up and down. 
 
Note that you don't have to use a split receive window! Regard it as an advanced 
option. If you are happy with a single window, then simply ignore it.  
 
(The idea of having two receive windows was put in before the program had proper 
support for reading bulletins. It was so you could connect to your local BBS, list the bulls 
in one window and read them in the other. With split windows, the incoming text only 
goes into one of the two windows at any one time. The idea of this is that you can list 
the messages on your local BBS into one window and then read them in the other. This 
stops the message list being scrolled away as you read the messages. In fact, when 
you have listed the messages into one window, simply double clicking a message 
number will send a 'read' command for that message to the BBS, and it will be received 
into the other window.) 
 

Transmit Window 
Single lines of text can be keyed into the small transmit window near the bottom of the 
screen. . <Esc> will clear the line. When you press <Enter> the text is sent to the TNC. 
The up  and down ↓ cursor keys will allow you to scroll through your last 8 commands. If 
you key in more characters than the line length specified on the setup screen, the 
program will automatically insert a <Enter> and start a new line. This is done in an 
intelligent way by looking for a gap between words.  See also Using Short cut Keys  for 
another way to enter text. 
 

Status Line 
This is the very bottom line of the WinPack window. The status line shows information 
about the current state of the terminal. It lets you see whether the Capture feature is on  
and also how much of the transmit buffer is currently being used. If the Capture feature 
is on, then the name of the current capture file will be shown. The transmit buffer figure 
is a 'health check' and, unless you are sending a file, it should always read '0', since the 
program buffer only starts to fill when the TNC's own buffer is full. 
 
Although not shown on this picture, if you are connected to another station, the callsign 
of the connected station will be shown on the left . 
 
The red and/or green squares on the right of the line show the status of the TNC 
RS-232 status lines. Red is “positive”; Green is “negative” (unless you have selected an 
alternate option for DCD).  
 
CON (Connected): red when you are connected to another station; 
CTS (Clear to Send); red = TNC can accept data; green = TNC is OFF or the buffer full.  
DSR (Data Set Ready; Data Set = TNC): red  = the TNC is ON and connected. 
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DCD (Data Carrier Detect); red = you are connected to another station, if your TNC 
supports DCD. See DCD for additional information.  
 
Hint! Double clicking on the status line towards the left-hand end is a short cut to the 
Action>Statistics menu option. See Statistics 
 

Printing 
 
You can print the contents of either of the receive windows  (or the Edit Window if it’s 
visible) by selecting the File>Print menu option or by pressing the Print Button on the 
tool bar. If you aren't using split receive windows and the Edit Window isn't visible, 
WinPack will print the main window, otherwise you will be offered a choice as to which 
window you want to print. 
 
If there is any selected text in the window (drag the mouse to select), then you will print 
the selected text, otherwise you will print all the text in the window.  
 
Because of an apparent problem with Windows (I daren't say bug!) the title line of the 
Print Dialogue Box simply says "Print" even though I am telling it to say "Print receive 
window" or "Print edit window". 
 
You can change the printer font by using the Options>Fonts...>Printer menu option. 
 
WinPack defaults to using the full print width available. This is because many packet 
users still tend to use lines of around 80 characters, and most printers have difficulty 
fitting that number of characters across the paper even when you use the full width. If 
you want to set a margin, then you can edit the [PRINTER] section of the PACKET.INI 
file to alter the LEFT_MARGIN_MM and RIGHT_MARGIN_MM settings. 
 
You can use Print to save a message to a file. If you check the Print to file box in the 
Print Dialogue then you will be prompted for a file name and the text will be saved in 
that file. 
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Saving the Receive Window Dialogue 
 
You can use the Capture File feature to automatically log all dialogue in the Receive 
window to a file. 
 
Otherwise you can use Windows’ “cut-and-paste” feature to save the text to file: 

• right click in the Receive window and choose Select All from th pop-up menu; 
other wise drag the mouse to select only a portion of the window. 

• on the menu bar, select Edit>Copy or right click again to select Copy to copy the 
file to the Window’s Clip Board. 

• open a wordprocessing file and paste the clip board into it (see Windows HELP if 
you need help about this technique.) 

 

Right Click Tricks 
 
There are a few things that you can access by right clicking:- 
 
If you right click in the Edit Window, then the edit pop-up menu appears. 
 
If you right click on the connected station callsign in the bottom left corner of the screen, 
then you can change the callsign. (It may be incorrect for outgoing connects via nodes.) 
 
If you right click on the CPS bar graph in the YAPP and compressed mail status 
window, then you can alter the range of the bar. 
 
In other windows of the program, right clicking will bring up Windows’ editing functions, 
such as copy, cut, and paste. 
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Quick Start: Get WinPack working in 5 minutes or less 
 
I’ll assume you’ll be working with a TNC and without any host software such as BPQ, 
AGWPE, Flexnet /TFEMU , etc.) 
 
1. TNC to radio cable – must be properly connected. If you need advice about that, 
you’ll need to consult your TNC and/or Radio User Manuals. With the radio and TNC 
turned on, verify that they seem to be operating correctly – the RCV (or similar) lamp on 
the TNC should blink when the radio receives a packet (listen or watch the ‘S’ bar on 
the radio to know when this occurs.). 
 
2. TNC to PC cable – must be attached to the proper port on the TNC and on the 
computer. Please make a note of the computer port’s name, e.g. COM1, COM2, etc. 
 
3. Basic WinPack Configuration. Start WinPack. From the Menu bar, select 
Options>Comms Setup to pull up the Comms Setup window 
 

 
 
You want to change the parameters on this screen to match your TNC settings. Unless 
you already know the TNC’s current settings, you may have to experiment with the 
WinPack settings to learn the TNC’s settings. The key settings to match at first are Com 
Port and Baud Rate.  
 
To test your settings, press OK to accept them; then cycle your TNC on and off to see if 
WinPack displays the TNC’s sign-on message in the WinPack Receive window. If you 
rceive nothing, then you most probably have the COM port setting incorrect. If you see 
garbled text, then the COM port setting is correct, but the Baud Rate setting may be 
wrong.  
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If you can’t “ungarble” the TNC sign-on message by changing the baud rate, then the 
TNC may be in HOST mode. To work with WinPack, the TNC must be in TERMINAL 
mode. If some other software that you have been using has left the TNC in HOST 
mode, then you will never get WinPack to work until you get the TNC out of HOST 
mode. How to get the TNC out of HOST mode is beyond the scope of these notes, but 
not beyond the scope of your TNC manual! 
 
In all situations where you can't establish any communication, take the following 
approach - forget about WinPack for the time being and use the Windows Terminal 
program. Once you can communicate fully satisfactorily with your TNC from Windows 
Terminal, using 8 data bits, no parity, 1 stop bit, hardware handshaking, you'll find that 
you can also communicate with it from WinPack. 
 
4. Set MYCALL: Once you have WinPack and the TNC working together, set the 
MYCALL parameter in the TNC: 

• in the Receive window, make sure the TNC has given you the CMD: prompt. If it 
hasn’t, enter a Ctrl + C key combination. 

• In the WinPack Transmit window, enter the MYCALL change command for your 
TNC along with your call sign. Example: MYCALL G4IDE 

• You can verify the change by entering just  MYCALL alone 
 
At this point WinPack and the TNC should be properly set for a simple packet 
exchange. You can test this by trying to connect to another station such as a BBS: in 
the WinPack Transmit window, enter C (target callsign), where (target callsign) is 
replaced by the actual callsign of the other station; example: C G8MZX   (there is one 
space between the C and the callsign.) End the connection by logging off the BBS 
(typically with a B; or by a forced disconnect: enter a Ctrl + C key combination and then 
a D.  
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TNC Setup 
I recommend these Computer-to-TNC communication settings:- 
 

serial baud rate: 9600 
data bits: 8 
parity: none 
stop bits: 1 
handshaking: RTS/CTS 

 
You will have to read your TNC manual to find out the commands (or switches) for 
changing the settings. Some may not have obvious names and some TNCs may not let 
you change them! 
 

• Do not confuse serial port baud rate (often ABAUD or TBAUD) with the ‘on air’ 
radio baud rate (which is often HBAUD) 

• Data bits are often changed with the AWLEN command. (Kantronics usually do 
not have this command and are set to 8 bits permanently.) . If you don't set data 
bits to 8 (and 8BITCONV ON), you can't use YAPP. It simply will not work, so the 
program stops you even trying. 

• Parity is often changed with the PAR command, if available. 
• Typically Stop bits are set to 1 automatically by the TNC. 
• Handshaking is also called ‘flow control’. Use RTS/CTS (hardware control) 

unless you have a reason for selecting something else (XON/XOFF is software 
control). 

 
If you change the settings, change the TNC first and then RESTART the TNC. Virtually 
all TNCs don't start using new coms settings until they are restarted. You will then 
probably get garbled text on the WinPack screen, so change the settings on the 
WinPack setup screen to match your new TNC settings. 
 
Please see Comms Error Log for some comments about comms errors (computer to 
TNC) that can occur. 
 
There are many other TNC commands that affect station to station communications. It 
would be impossible to list the optimum settings to use with WinPack for every different 
type of TNC available. However, in the WinPack \TNCPARAM directory are files for 
most popular TNCs with settings that are known to work with WinPack. These can be 
used as a good starting point. Some of these TNC PARAM files have comments at the 
top which give advice specific to that particular TNC based on the experience of others 
using it with WinPack. It is always worthwhile to have a look at the file relevant to your 
TNC, even if you are confident that you know how to set it up. 
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Please makes sure that you adjust settings such as FRACK, MAXFRAME and 
PACLEN to suit local conditions. Consult your TNC manual for other advice on timing 
parameters. 
 
Please also see the Suggested TNC Settings Appendix of this document. 

Hint: Saving Your TNC Settings 
There is always a risk with a TNC that you will inadvertently reset it and so lose all your 
settings. The following describes an easy way of saving all your settings so you can put 
them back into the TNC if it gets reset. 
 
1. Turn Capture on and set the file named something like SETTINGS.TXT. 
 
2. Send to your TNC whatever command will tell it to list all its settings - e.g. DISP. 
 
3. When all the settings have been listed, close the capture file. 
 
4. Open the Edit Window and Load SETTINGS.TXT. Do any necessary tidying up. E.g. 
some of the settings listed may be status messages and so won't be suitable for 
sending back to the TNC. 
 
5. Save the file. 
 
Now if you ever need to put the settings back into the TNC, simply use the Send option 
to send SETTINGS.TXT to the TNC and restore your settings. 

Complete the Comms Setup settings 
 
Note: Please note under Baud Rate, the sixth comms speed option shown - 38400 - 
can be toggled between 38400 and 57600 by right clicking on the number. 

Connect String 
This is a portion of the message that the TNC sends when a 
connection occurs. It is almost always '*** CONNECTED to 
<callsign>'. You’ll have to connect with a station to find out. 
 

If your TNC doesn't use DCD to show the connected state (any self-respecting TNC 
should be capable of using DCD!) then WinPack tries to monitor the connected state by 
looking for the TNC sending this string. This Method Can Never Be Reliable. To 
enable it you must also set DCD shows con state to 'No'. See DCD Behaviour below. 
 
This string of characters is also used to work out the callsign of the station to which you 
are connected, so it is important that you input it correctly. 

Disconnect String 
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This is the message that the TNC sends when a disconnection 
occurs.  It is almost always '*** DISCONNECTED'. You’ll have t
disconnect with a station to find out. 

o 

 
If your TNC doesn't use DCD to show the connected state (any self-respecting TNC 
should be capable of using DCD!) then WinPack tries to monitor for disconnections by 
looking for the TNC sending this string. This Method Can Never Be Reliable. To 
enable it you must also set DCD shows con state to No. See DCD Behaviour below. 

Editor Line Length 
 

Input the line length to be used in the editor. If any line is longer 
than this then a <Enter> will be inserted.  
 

 
Tip - if you use no more than about 74 characters, it will allow your messages to be  
'quoted' without them becoming a complete mess. In the interests of those who have to 
read your messages, I have limited the line length to 78 characters maximum.  
 

DCD Behaviour 

  
 
If your TNC uses the DCD line to show the connected state then select Yes. If it doesn't 
then select No. You will soon find out whether it does or not by watching the DCD 
indicator on the status bar. It should be green when you aren't connected to another 
station and red when you are. All self-respecting TNCs should support DCD! 
 
However, some TNCs seem to use the DCD the wrong way round, so an extra DCD 
mode has been added which is 'INVERSE'. If this is selected, then when the DCD 
indicator is GREEN, WinPack will regard the TNC as being connected, and when it is 
RED it will regard the TNC as being disconnected. This was added to help a local 
station who had a PK-12 which definitely worked this way. However, I would think that 
there might well be a ROM update available for the TNC to fix the problem. 
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Host Mode Options 
 
This list box allows you to select a host mode if desired. For 
direct TNC use, you must select "None".  NOTE: If WinPack is 
being used in modem mode (run with a command line option of 
"/modem") this list box is disabled. 
 
 

For detailed information about the various host modes available see the Host Mode 
section of this manual. Here’s a brief overview of the modes: 
 
TELNET - uses the internet to make a telnet connection to a BBS . It does not use a 
radio connection. See Telnet for more information. 
 
BPQ - use this option only if you are running BPQ node software underneath Windows. 
See BPQ for more information.  
 
AGWPE – use this option only if you are running AGWPE, which is a Windows 95+ 
utility program that acts as a switchboard between one or more Radio/TNC 
combinations and one or more packet programs. It also has a feature for running packet 
with the computer sound card instead of a TNC. See AGWPE for more information. 
 
TF2.7b – to use this mode you need a TNC specially fitted with either TF (TheFirmware)  
or WA8DED firmware, or an SCS PTC-IIe TNC  . See TF2.7B for more information. 
 
TFEMU – to use this mode you need to load PC Flexnet software and its TFEMU 
module first. Please see TFEMU for more information  
 
Note that , when any HOST mode is selected (except for TF2.7b), other options on the 
Comms Setup window, e.g. COM port, may be either irrelevant or handled by the host 
software, so they are “grayed out’ and not accessible. 
 

Accept/Abandon 

 
 
OK: closes the screen, accepting and implementing any changes you have made in the 
setup window. 
Cancel: closes the screen, abandoning any changes you have made in the setup 
window. 
 

 Configure the Personal/BBS Info settings 
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Go to the Options menu and select Personal/BBS Info. This will bring up the window 
below.  
 

 
 
Personal Information 
 
First Name - Input your first name. 
 
Second Name - Input your second name. 
 
Callsign -Input your callsign. 
 
QTH - Input your QTH (where you live!) 
 
QRA - Input your QRA locator/grid square if you know it. 
 
WAB – Great Britian operators only: input your WAB square if you know it (WAB = 
Worked All Britian) 
 
 
Log Information 
 
This information is used if you select the auto logging option on the Options>Logging 
menu. WinPack will log all connections and disconnections in a file called 
TEXT\AUTOLOG.TXT. 
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Frequency - Input the frequency, for example, 144.650 MHz 
 
Power - Input the power, for example, 10dBW . 
 
Mode - Input the mode, for example, F2D. 
 
 
BBS Information 
This information is needed only for Auto BBS sessions.  
 
BBS Callsign - Input the callsign of your local BBS. 

Please Note: If you enter a BBS Callsign, WinPack will automatically activate 
scheduled BBS sessions and bulletins message downloads according to 
the AUTOTIME.TXT times and the SELECT.TXT word matches. An explanation 
of these features and files can be found in the Selection List Editor section 
 
If you do not want WinPack initiating Auto BBS sessions on its own, either do 
not enter a BBS Callsign or edit the AUTOTIME.TXT file to remove the time 
schedule with the the Selection List Editor 

 
 
BBS Prompt - Input some text (as much as possible) from the prompt that the BBS 
sends. For example, a BBS might send  2: G4IDE de GB7OPC  04-Jul 20:00z >  , so I 
set the prompt  to G4IDE de GB7OPC. I obviously can't include the stream prompt 2 
and the time and date because they change. Also, do not include the > in the prompt 
field because WinPack checks for  > at the end of the line automatically. As far as I 
know, all BBSs end the prompt with >  (Funny feeling that someone will tell me I'm 
wrong!)  NOTE – Incorrectly setting this prompt is the source of many Auto BBS session 
problems!   Please see the FAQs page for more information. 
 
“To” label - Read a message on the BBS, at the top it will have a few lines that say, 
"To", "From", "Title", etc. or similar words. Put here the word that starts the “To” line. I 
think in English speaking countries it will always be "To". 
 
“From” label - Read a message on the BBS, at the top it will have a few lines that say, 
"To", "From", "Title", etc. or similar words. Put here the word that starts the “From” line. I 
think in English speaking countries it will always be "From". 
 
“Date/Time” label – - Read a message on the BBS, at the top it will have a few lines 
that say, "To", "From", "Title", etc. or similar words. Put here the word that starts the 
“Date/Time” line. . If there isn't one then put "Date/time". 
 
“Message #” label - - Read a message on the BBS, at the top it will have a few lines 
that say, "To", "From", "Title", etc. or similar words. Put here the word that starts the 
“Message #’ or “Msg#” line. If there isn't one then put "Message #". 
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“Title” label - Read a message on the BBS, at the top it will have a few lines that say, 
"To", "From", "Title", etc. or similar words. Put here the word that starts the title line. It 
may well be "Subject" rather than "Title". 
 
Message End Indentifier- (The following is irrelevant if you are using FBB compressed 
download). 
 
At the end of each message the BBS will send some text that says "END OF 
MESSAGE" or something similar. Put as much of that text as possible in this field. 
 
My BBS sends something like ==========[ End of message 12345 from G4IDE to ...  
So I input ============[ End of message 
 
A local NNA BBS sends  <End of message 38869>   well, not always 38869, so you 
would input only    <End of message 
 
List: Bulletins – 
(The following is not relevant if you are using the FBB unproto beacons). 
Different BBSs use different commands for the L(ist) function. I suggest you ask you 
BBS for ‘HELP’ about that. For example, L may list all bulletins in “newest first” order 
since you last list command. LR may do the same in “oldest first” order. 
 
If you regularly check bulletins, then it may be OK to use a List command that lists 
everything since your last listing. If it has been awhile, you may want to do a manual 
listing using a command that limits how many how far back you go; or re-set your 
personal options on the BBS to a more recent last listed message number. 
  
WinPack does not, at the moment, sort the BBS message list, it simply adds the new 
lines to the end of the old list. What you use for the list command depends on whether 
your local BBS is FBB or NNA. 
 

FBB 
FBB - set the list command to LR. This results in the oldest message being listed 
first. The FBB  L command lists the newest first. 

 
If your BBS is very busy and you frequently get disconnected during a session, 
you may find that bulls often get listed twice - this is because FBB only updates 
your list pointer when you make a disconnect with B. In this case, try using a list 
command  of LR $NUM- this will list from the last message in your message list. 
Using this command also allows WinPack to process a partial list if you get 
disconnected whilst downloading it. 

 
NNA 
NNA - the order in which messages are listed is set by using the BBS’s LR 
command. You should set it so that the BBS tells you that they are being listed in 
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chronological order. The BBS will save your setting, so you only need to do this 
once. Set the WinPack list command to L. Please note that on NNA the sysop 
can set the maximum number of messages that you can list. This is to stop you 
listing hundreds and hundreds of messages if you haven't connected for a long 
time. If you set WinPack to connect two or three times a day  then this won't give 
you any problems. Alternatively, you can set the list command to L $NUM-, this 
will list from the last message in your message list. 

 
List: Personal – 
 (The following is irrelevant if you are using the FBB unproto beacons). 
This is the command that WinPack sends to the BBS to get it to list your unread 
personal messages. For an FBB BBS it should be LN, for an NNA BBS it should be LM. 
If necessary, check with the BBS ‘HELP’ for the command to list “just messages to me”. 
 
 
Ok - Select this button to accept the new data. It will be written to PERSONAL.TXT. 
 
Cancel - Select this button to discard any new data you may have entered. 
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6. Mail and Bulletins 
 
This is the aspect of WinPack where it really excels – Bulletin Board System (BBS) 
message management. Most of the features – and the apparent complexity – of 
WinPack derive from its ability to simplify the uploading, downloading, and processing of 
BBS messages, both mail and bulletins. (Mail is a message addressed to a particular 
individual; bulletins are messages addressed to anyone interested in the topic.) 
 
Here’s an overview of what WinPack can do: 

1. Initiate an automatic logon to your BBS, perhaps at scheduled times. 
2. Upload any mail or bulletins from you. 
3. Download any mail to you. 
4. Download a summary list of new bulletins. 
5. Download the complete text of selected bulletin types you want to read. 
6. End the current BBS session. 
7. Assist in processing downloaded mail & bulletins(e.g. read, hold, delete, archive) 
8. Assist in composing a message you want to send (e.g. necessary fields, address 

book, spell checker, mailing lists). 
 
For you to really understand this section of the User Manual, you should be familiar with 
your local BBS; the mail and bulletins features it provides; and the basic commands it 
expects for functions such as reading mail or listing bulletins  Therefore, before you try 
to use WinPack’s automated features, I suggest you manually log-in to your BBS and 
do any of the following exercises for which you are unfamiliar. If necessary, use the 
BBS’s ‘Help’ command to find the appropriate command: 
 

1. Send a message to yourself. 
2. Read and then kill that same message. 
3. Download a listing of the most recent 5 bulletins. 
4. Read one of those bulletins. 
5. Set  “paging”  to off so that message lists and text flow continuously. 

 
Armed with that knowledge, you will in a good position to understand this section of the 
Manual which is divided as follows: 
 
Auto BBS Session 
Scheduling Auto BBS Sessions 
Reading and Processing Mail 
Reading and Processing Bulletins 
Using Themes to Filter Out Unwanted Bulletin Listings 
Writing Messages 
Sending messages 
Creating and using a Mailing List 
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Auto BBS Sessions 
 
One of WinPack's most powerful features is that it can automatically connect to your 
local BBS and carry out the tasks you would otherwise do on a manual connection.  
 
Auto BBS sessions will only work if you have filled out the BBS Information on the 
Personal, BBS and Log Information screen (Options>Personal/BBS Info menu 
option).  
 
Note that if you do fill out the BBS Information, WinPack will automatically begin Auto 
BBS session at the times specified in the AUTOTIME.TXT file. It will also download any 
bulletin messages according to the criteria in the SELECT.TXT file. Both of these files 
can be editied by the Selection List editor. 
 
Auto BBS sessions can also be intiated: 

• if you select Auto BBS Session from the Mail menu 
• if you click on the Mailbox Button on the Button bar 

 
Note - If you select Auto BBS Session when an auto BBS session is already running, 
then it will toggle the visibility of the script and upload/download status windows. 
 
Exactly what happens during an Auto BBS session will vary slightly according to what 
Mail Options you have selected and what tasks are scheduled.  
 
At the start of the session, you may be prompted as to whether you want this to be a 
“mail only” session. If you only want to upload messages and collect any personal mail 
that is waiting on the BBS, then say "Yes". If you also want to collect the message list 
and any specific bulletin messages that you have selected, then say "No". 
 
WinPack will then connect to your local BBS and carry out the following actions: 
 

1. Read any waiting personal mail, save it in WinPack, and then kill it on the BBS. 
2. Collect the bulletin list (if you answered "NO" to the “Mail only? question),  but 

see the comment below. 
3. Download any previously marked bulletins of interest. 
4. Download the complete content of any bulletin types matching the criteria in the 

SELECT.TXT file  (see the Selection List editor). 
5. Upload any messages that you have written. 

 
Obviously the message list is not downloaded if you are using the FBB unproto beacons 
– it has been “downloaded“ automatically via the beacons. 
 
If you have mail to forward to the BBS, and you are using compress forwarding, 
WinPack will not collect the message list on that session, because of the way that FBB 
handles disconnects. The only exception to this is if you are using a list bulletins 
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command on the Personal/BBS Info window of LR $num-.  ($num is a WinPack 
token) 

Auto BSS Sessions and BBS Paging 
 
For the Auto BBS download feature to work correctly, you must have the paging option 
turned off in your setup on your local BBS. On FBB and many other BBSs this is the OP 
command. It works as a toggle – - alternately enabling and disabling the feature --  
make sure it reports OFF. Also on FBB  LC * is a good idea. 
 
The following applies mainly to FBB BBSs and people who have been using TPK (or 
others who may not have requested a LIST in some time):- 
 
If you have been using a packet program that never actually uses the L or LR 
command, then, the first time that WinPack connects and sends LR the list could be 
huge. Here in the backwoods of Lincolnshire that isn't a problem, but in some areas 
listing a thousand or so messages might not make you too popular. To avoid this you 
can do the following:- 
 
1. Manually connect to the BBS. 
2. Send  OP until paging is ON. 
3. Send L. 
4. When you get the first "... Continue <A>bort ..."     message, send  A to stop listing. 
5. Send  OP until paging is OFF. 
6. Send b to disconnect. 
 
Your list pointer is now updated to the top of the  message list. 
 
If you are using the FBB message beacons, the above procedure is not needed, but you 
must ask your sysop to give you U status on the BBS. If your FBB BBS profile is set so 
that, when you connect, the BBS lists any new personal mail, it is worthwhile disabling 
this feature. It isn't needed, because WinPack will find out what new mail you have, and 
it wastes air time.  
 
Also, the more text you receive before you get to the first BBS prompt, the more chance 
your BBS.TXT script file has of seeing something in the incoming text that looks like a 
BBS prompt (but isn’t)  - which will totally mess up the Auto BBS session. To stop the 
BBS sending you the list of new mail when you connect, manually send the command 
OM. It is a toggle - alternately enabling and disabling the feature. 
 



 

Reading Mail 
Menu bar: Mail>Read Mail 
 
To read your personal messages or any bulletin texts you have downloaded, either go 

to the  Mail>Read Mail menu option or select the Read Mail button . This will bring 
up the Select a Message to Read window. From the message list, select a message 
either by double clicking it or by moving the cursor bar to the required line and the 
pressing the Read button. 

 
 
The message Status indicator preceding each entry can have the following values:- 
Y  The message has been read. 
N  The message has been downloaded but not read. 
R  The message has been read and a reply has been sent. 
D  The message is 7plus and has been processed. 
S  The message has been processed by a server. 
X  This is a message which is not in the normal WinPack format. 
 'X' status messages may be created by other programs. 
  WinPack uses an 'X' status message called YAPPLOG.TXT 
  to report YAPP File Transfers. 
 
You can use the Delete button to delete any message except those that you haven't 
read ( N). To delete N messages hold down the <Ctrl> key and click the Delete button. 
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The Archive button works exactly like the Delete button, except that, before deleting 
the message, it makes a copy of it in WinPack’s \ARCHIVE\(CALLSIGN) subdirectory, 
where (CALLSIGN) is replaced with the callsign of the sender. The archived file is 
named according to the date and order that it was originally received in the format 
YYMMDD##. For example, a message from G4IDE, originally received on 25th 
December 1999 will be archived in the ARCHIVE\G4IDE directory, and will be called 
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99122501.TXT. A second message from G4IDE received on that day would be archived 
as 99122502.TXT. 
 

Message Window 
(either personal mail or a downloaded bulletin message) 
 
When you open a mail message in the Select a Message to Read window (Menu: 
Mail>Read Mail) or in the Bulletins list (Menu: Mail>Read Bulletins) if you select the 
UNREAD button or double click on a downloaded message (N or Y), content of the 
message will be displayed: 
 

 
 
Buttons at the bottom of the screen provide some or all of the following mail processing 
options, depending on whether you are reading a personal message or a bulletin: 
 
Next Unread 
This option will cause the next unread message (if there are any) to be displayed. The 
currently displayed message will be marked as read (Y) but will not be deleted. If you 
are reading bulletin text and have selected only a part of the message list to view, e.g. 
you have filtered messages according to a particular "To" field, then this option will be 
disabled. 
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Keep Message 
The message will be marked as having been read (Y), but will not be deleted and you 
will be returned to the message list. 
 
Delete Message 
The message will be deleted and you will be returned to the message list. 
 
Archive/To File 
You will be offered an option of  a.) archiving the message or b.) saving it to file.  
 
a.) Archiving puts a copy the message in the ARCHIVE subdirectory of WinPack and 
then deletes the original in the personal mail list or in the bulletin list. 
 
If you are reading a personal message, then it will be archived in a subdirectory of 
ARCHIVE\RECEIVE, named according to the callsign of the sender. The archived file 
will be named according to the date that it was originally received. For example, a 
message from G4IDE, originally received on 25th December 1999 will be archived in 
the ARCHIVE\RECEIVE\G4IDE directory, and will be called 99122501.TXT. A second 
message from G4IDE received on that day would be archived as 99122502.TXT. 
 
If you are reading a bulletin, then it will be archived in a subdirectory of 
ARCHIVE\BULLS, named according to the topic of the bulletin, and the file name will 
be derived from the message number on the bulletins list. 
 
b.) Saving to file allows  you to save a copy of the message into a text file of your own 
choice. The message is not deleted. You can choose to put the message in a file on its 
own, or append the message to an existing file - which is useful for keeping related 
messages together.  
 
Reply To Sender 
Selecting this option allows you to send a reply to the person who sent the message 
that you are reading. An R will be placed in front of the message on the personal mail 
list and the Write a Message form will open. See Writing Messages 
 
Reply To Topic 
(Not available if you are reading personal mail.) 
Selecting this option allows you to send a bulletin to the topic relevant to the message 
which you are reading. By topic I mean the 'TO field of a bulletin. See Writing Messages 
 
Quick Reply With Auto-Quote 
A quick reply option is available by right clicking on the Reply To Sender or Reply To 
Topic button. A message header form will be filled in with the same values as used 
when you left click on these buttons, but you won't be shown in the Write a Message 
form. Instead you will be put straight into the Edit Window as if you had been shown the 
form and clicked OK. See Writing Messages 
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If you mark some text in the message before you right click the reply button, the text will 
be quoted in the Edit Window preceded with a short header saying who sent the 
message. For example, if you are replying to a bull from G4IDE, the quoted text will be 
presented something like:- 
 

G4IDE wrote:- 
> Some text from G4IDE. 
> Some more text from G4IDE. 
> etc. 

 
The beginning " wrote:-" line is configurable constant in PACKET.INI. It is 
REPLY_QUOTE in the [TERMINAL] section. You can suppress it by changing it from 
REPLY_QUOTE=wrote:-  to  REPLY_QUOTE=* 
 
Using the Quick Reply feature will probably give you a better idea of how works than 
this explanation! 
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Bulletins 
Bulletins are the general messages or postings on Packet Bulletin Board Systems. 
Executing a LIST command will produce a summary list of bulletins similar to this 
(format varies by BBS software): 
 
Msg# TSL D Dim To @ BBS From  Date/Time Title 
143767 BF D 2933  WINPAC@WW     LU8FBC  0318/1609 SPY.P03  
143766 BF     1515  SOLAR @WW      IW2MLN 0318/1608 Geophysical Alert 
143765 BF     1006  EQUAKE@WW      IW2MLN  0318/1604  Seismograph project 
143764 BF D 1180  AGW   @WW      LU8FBC 0318/1602  MHEARD12. 
 
One of WinPack’s particular strengths is in helping you managing the bulletin list by: 

• Automatically downloading the bulletin summary list and then let you mark 
specific messages for which you want to download the full content 

• Downloading the full content of those messages during the next auto download 
session  

• Assisting you in processing downloaded messages by marking them as 
Have Read, Have Not Read; Delete; or Archive. 

 

Set Bulletin Columns 
Menu bar: Options > Bulletin Columns 
 
Any program like WinPack that processes the 'raw' message list from a BBS has to 
know where the various columns of information are. i.e. where the To column is in the 
list, where the From column is, etc.  
 
Once you have got WinPack working and have collected your first message list from 
your local BBS, you should run the Bulletin Columns option on the Options menu. 
Use each item on this submenu in turn –  FROM, TO, AT, TITLE -- and follow the 
prompts on the status line. 
 
Note Very Well!- Of all the avoidable "problems" that users have reported with 
WinPack, not setting the bulletin columns is by far the most common! If you are not 
using the BBS’s unproto beacons and you choose not to bother setting up the Bulletin 
Columns, then it is unlikely that any of the automatic mail functions will work properly. 
Selecting bulletins to read using To, From, etc, will not work and bulletin themes will not 
work 
 
NB- if you are using the FBB unproto message beacons, the list columns are 
automatically set and the Bulletin Columns submenu is unavailable 
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Reading Bulletins 
 
When you select the Read Bulletins option on the Mail menu, the message list will be 
displayed, positioned at the start of any new messages that have been added since you 
last used this option.  
 

 
 
You can move around the list using the vertical or horizontal scroll bars, the PgUp/PgDn 
keys, or by clicking somewhere in the All Messages horizontal bar graph at the top of 
the screen. The bar graph will show you where  you are positioned in the whole list; the 
vertical scroll bar on the list only moves you around within a viewable section  of the list 
(for viewing, the list is loaded in sections). 
 
The first character on each line is the status of the message: 

• * means it will be downloaded during the next Auto BBS session. 
•  N means you have downloaded the message content but not read it. 
•  Y means downloaded and read. 
•  K means downloaded, read, and marked for killing (deletion).  
• no character present means you have not downloaded the message and it is not 

marked for a future download. 
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To read a message that is marked N or Y, simply double click that message to open the 
Message Window and view the message contents. 
 
If you want to get the full text of a list entry without an N,Y, or K, double click anywhere 
on the line or move the text cursor anywhere on the required line and press <Enter>. 
This will place an * at the beginning of the line and, during the next Auto BBS session, 
the message text will be downloaded. A second double click or <Enter> will  clear the  *  
indicator. 
 
If you double click on a message line, an action occurs according to the status: 
 
Status  Action 
(blank)  The status becomes * 
*    The status becomes blank 
Y or N   The message is displayed for reading. 
 
If you hold down the Ctrl key while you click, different actions occur: 
 
Status  Action 
Y or N   The message is killed; the status becomes K. 
K    The status becomes blank. 
 

Bulletin List Buttons 
The buttons at the bottom of the screen have the following functions:- 
 
Unread - display the next unread message. If you have made a list selection based on 
the To, From, etc buttons, then this button changes to a Dump button 
 
Dump - this button replaces the Unread button if a filter selection has been made using 
To, From, etc. It allows you to put the text from all the bulletins in the current list 
selection into a file. Because it can create quite a large file, you will first be asked to 
confirm that this is what you really want to do.  
 
From - This buttons allows you to filter the displayed message list by sender. A window 
will appear prompting you to input the required From. (You can use  *  as a wildcard. 
e.g. If you input  G4* , then all messages from callsigns starting with G4 will be listed.) A 
maximum of 350 messages can be displayed in the list when you use this filter. If more 
than 350 are available, then only the last 350 are shown. 
 
To  - This button allows you to filter the message list by topic. You will be prompted if 
you want to list all the topics. If you say "no", you simply key in the topic of interest and 
all messages matching it will be listed (You can use  *  as a wildcard. e.g. If you input 
DE* then all messages to topics callsigns starting with DE will be listed). If you say 
"yes", the whole message list is processed and a list of all the topics in it is shown, 
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along with the count of the messages for each topic. You can then select a topic of 
interest from the list. 
 
[The prompting as to whether or not you want to list all the topics can be over-ridden by 
editing PACKET.INI.]. If you don't want the topics list to be available, you can disable it 
by editing the [BULLETINS] section of PACKET.INI. 

 
If you choose to list all the topics and you have a large 
message list, reading it and listing all the topics can take 
some time. However, once you have viewed the topics list in 
a bulls reading session, then displaying it again is 
instantaneous.  
 
The resulting Select a Topic window will show the number of 
topics in total. The number next to each topic is the number of 
bulls in the message list for that topic. Select a topic from the 
list by either highlighting it and then pressing the Select 
button, or by double clicking it. 
 
A maximum of 350 messages can be displayed in the list 
when you use this filter. If more than 350 are available, then 
only the last 350 are shown. 
 
 

 
At- This buttons allows you to filter the displayed message list by the  at/@ address. A 
maximum of 350 messages can be displayed in the list when you use this filter. If more 
than 350 are available, then only the last 350 are shown. 
 
Title - filter the message list by Title. A window will appear prompting you to input text 
that you want to occur somewhere in the title. This button allows you to filter the 
message list by title. A maximum of 350 messages can be displayed in the list when 
you use this filter. If more than 350 are available, then only the last 350 are shown. 
 
Themes - This button allows you to select a theme from a list of the bulletin themes that 
you may have created For more information on themes, see What Are Themes? below. 
A maximum of 350 messages can be displayed in the list when you use a theme. 
 
All Bulls - If you select this button, then the list is restricted to showing only entries 
marked N or Y (messages text available).  If more than 350 messages are available, 
then only the last 350 are shown. 
 
All List - clear all filters and displays the whole list. 
 
New - positions the list so that  the top line on the screen is one message before the 
first new message. (That is a really bad explanation, so try it and it should be obvious!) 
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Delete - If you drag the mouse to mark a block and select Delete, then all the message 
list lines in the marked block will be deleted. (If no text in the list is marked, selecting 
Delete has no effect.) 
 
Lines preceded with a Y, N or *  will normally not be removed. If you want the act of 
pruning to delete list entries for downloaded bulls marked Y (and their associated 
messages text), then first check Block Delete Bulletins on the Options>Bulletin 
Deleting menu. 
 
NB- if your bulletins list command in Personal/BBS Info is set to LR $NUM-, or 
anything else using $NUM, avoid marking/deleting the last line of the list. 
 
Prune - The Prune button works differently according to whether or not a block of lines 
in the list has been marked by dragging the mouse:- 
 
If text in the list is not marked, then the bulletins list will be pruned down to 
approximately the number of lines set in the Bulletin List Prune Size under the 
Options > Bulletin Deleting menu. 
 
If text in the list is marked,  then all the message list lines from the top of the list to 
the end of the marked block will be pruned, except lines marked Y, N or * . If you want 
the act of pruning to delete list entries for bulletins marked Y (and  delete the 
downloaded messages corresponding to those entries), then first check Block Delete 
Bulletins on the Options > Bulletin Deleting menu. 
 
NB- if your bulletins list command in Personal/BBS Info is set to LR $NUM-, or 
anything else using $NUM,  avoid marking/pruning the last line of the list.  
 
Done - Select when you have finished reading bulletins. 
 

What Are Themes? 
When you are reading bulletins lists in WinPack, you have single criteria filter buttons 
–UNREAD, TO, FROM, AT, TITLE, etc --  which allow you to select all the bulletins TO 
one particular topic, or FROM one particular sender, etc. But to filter bulletins by 
multiple selection criteria, you need to use a special feature call “Themes”. 
 
For example, because of the way that people address messages, you often find that two 
(or more) different topic addresses will be used for the same subject, e.g. WINPAK and 
WINPAC. If you want to see just the bulletin headers for both those topics you would 
need to use a theme. You could even add a FROM criteria to the two TO parameters to 
limit the WINPAC and WINPAK headers to those from a particular person. As you can 
imagine, themes offer countless filtering combinations. 
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When you install WinPack, no themes exist and pushing the Theme button at the 
bottom of the Read Bulletins window just produces an error message. 
 
To create a theme, you’ll need to use a WinPack “Add-on” program called the Themes 
Editor. See Themes Editor section of this manual for more information. 
 

More about Pruning The Bulletin List 
 
In addition to using the Delete and Prune buttons as described above, WinPack prune 
the list automatically, either when the program is started or at user-defined times. An 
automatic prune will behave as if you have used the Prune button without having 
marked a block - see above. 

1. To prune the list when the program is started, add a command line option of 
/AUTOPRUNE - see Command Line Options for more information on how to do 
this. 
  

2. To prune the list at user-defined times, use File>Selection List Editor and add 
some times to the Auto Times list with PRUNE as a suffix. For example 12:30 
PRUNE, 22:45 PRUNE. An automatic prune will be run at those times each day 
(assuming that WinPack is running). 

 
PLEASE NOTE that, as explained above, your settings of Block Delete Bulletins and 
Bulletin List Prune Size will affect what happens. See Bulletin Deleting options for 
more information on what these two options do. 
 
If you prune the bulletins list, or delete a block of lines from it, then normally any lines 
within the deleted section for which a bull has been downloaded and which have a 
status of Y will not be deleted. Normally, to get rid of those lines you must first kill the 
bulletin. However, if you enable Block Delete Bulletins from the Options > Bulletin 
Deleting menu, these lines will be deleted and the associated bulletins will 
automatically be killed.  
 
Even with this option selected, you cannot delete bulletins with a status of N. WinPack 
will assume that, if you downloaded them, you want to read them. So you’ll need to 
open them and then delete them 
 
Bulletins marked D will always be deleted (irrespective of the setting of Block Delete 
Bulletins) because they are 7plus parts from which the 7plus has been extracted and 
put in the 7EXTRACT directory. 
 
If while you are in Read Bulletins you click the Prune button, and you haven't marked a 
block of bulletins, then the list will be pruned down to approximately the number of 
bulletins set by the Bulletin List Prune Size option under the Options > Bulletin 
Deleting menu. For example if you have Bulletin List Prune Size set to 2,000 and you 
have 10,000 lines in your bulletins list, then the first 8,000 lines will be deleted and the 
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last 2,000 or so will be left. The final number left in the list may be slightly more, 
depending on the setting of Block Delete Bulletins and whether you have any bulletins 
in the section to be deleted which are marked * or N. The default value for Bulletin List 
Prune Size is 5,000. 
 

Automate the Download of Selected Bulletins 
 
Normally, if you want to read the content of a bulletin, you must: 

1. First, download the list of bulletins (headers) in one Auto BBS session. 
2. Then, review the bulletin list and mark the bulletins for which you want to 

download content in the next Auto BBS session. 
3. Then, download the content of those bulletins in the next Auto BBS session. 

 
However, using the Selection List Editor “Add-on” program, it is possible to 
immediately download the content of all bulletins that meet specific criteria. This saves 
you the steps of reviewing bulletin headers and waiting until the next Auto BBS session 
to read the bulletin. For more information about this feature – and about scheduling 
automated Auto BBS sessions -- see the Selection List Editor section of this manual. 
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Mail Options 
Menu bar: Mail>Mail Options 

 
BBS programs have different 
enhancement and limitations which 
WinPack handles via the Mail Options 
window: 
 
WinPack's default is to have none of thes 
enhancements enabled and the only box 
checked in the Mail Options window will 
be Ask “Mail only this session?”  
 
In its default mode, WinPack downloads 
the local BBS message list in an Auto BBS 
session by sending L or LR. It downloads 
messages by using  r <msg_no>, and it 
forwards messages in a plain text format 
(MBL/RLI protocol). 
 
This works fine, but there are usually more 
efficient ways of carrying out these tasks.  
 
 
 

For BBSs running F6FBB or G1NNA, software compression can often be used for both 
forwarding mail to the BBS and for downloading messages. Please read enhanced mail 
facilities for more information. See also YAPP Transfer Status Window 
 
If you check Use Split Sessions and your local BBS is FBB, WinPack will not attempt 
to use both compressed download and compressed forward on the same connect 
session. This option is needed because FBB V7 will not allow you to use both in the 
same session (FBB V5.15c does). If you don't select both compressed download and 
compressed forward, or your local BBS is G1NNA, this option is ignored. 
 
If your local BBS is running F6FBB software, it may be possible to accumulate the 
message list from the FBB unproto beacons. Please read enhanced mail facilities for 
more information. If you want to use the FBB unproto beacons, select Use FBB 
unproto lists in the Mail Options window. If you do, WinPack will fill in The BBS 
addresses unprotos field with a default unproto address of  >FBB. You can change 
this if needed. You must also change your TNC’s HEADERLN parameter to ON. 
 
The Using TH-D7 or similar option is only available if you have checked Use FBB 
unproto lists and Host mode is set to NONE on the Comms Setup window  
(Options>Comms Setup menu). It should be left unchecked except in the 
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following special circumstances: The Kenwood TH-D7, and possibly some other 
devices, don't have a HEADERLN parameter. They always operate as if HEADERLN is 
OFF. If you are using such a device, then you must check this option, otherwise it will 
fail to collect the FBB unproto beacons. If you do check it, then you must make sure that 
your TNC does not put any semicolons in monitored frame headers. 
 
If you check the TPK compatibility mode box, then the compressed forwarding, 
compressed downloading, and FBB unproto list options will all be enabled. 
 
The Human mode option is a special case. Some BBSs are configured so that they 
won't allow a user to do anything that looks like BBS forwarding. This is most likely to 
occur with some USA types of BBS software, and with WinFBB (if the sysop has 
configured it in a particular way). 
 
If you check Human mode, WinPack will not send its SID banner (something like 
[WinPack-6.3-$] ) to the BBS, and it will not attempt to add its own BID to messages 
when they are being forwarded. It will behave just as if you were running a manual 
connection. This should allow WinPack to be used with even the fussiest of BBSs (and  
the fussiest of BBS sysops!) 
 
BBS software systems I know might give problems are:- 
 

Win FBB, depending on how the sysop has set it. 
DOS FBB, again depending on how it is set up. 
AA4RE 
W0RLI 

 
If you use a BBS that falls into this category, you can get round it by using Human 
mode option on the Mail Options setup screen. 
 
Ask "Mail only this session?" - When you manually start an Auto BBS session 
WinPack will prompt you "Mail only this session?" in some situations. If you say “yes”, 
bulls will not be downloaded on that session. (WinPack won't always display this prompt 
because in some situations the question is not relevant.) The prompt was originally put 
in at the request of several users, but several others have found it a nuisance. If you 
uncheck the box on the Mail Options form, WinPack will assume that you are always 
answering "No" and will not display the prompt. If unchecked, Auto BBS sessions will 
always download the bulletin list. 
 
The normal choice of modes would be:- 
1. If you have previously used TPK and your local FBB BBS sends the unproto 
beacons, select TPK compatibility mode. (See above for some comments on using a 
TH-D7 or similar device.) 
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2. If your local BBS is FBB but it doesn't send the beacons, or it sends the beacons but 
you turn your packet system off for long periods, select only compressed forward and 
compressed download.  
 
3. If your local BBS is NNA running V3 or later of the software, select compressed 
forward and compressed download. Please note that, when using compressed 
forwarding to an NNA BBS, FBB style compression is used, which is supported by the 
BBS. 
 
4. If your local BBS is NNA running a version older than version 3, select compressed 
forward. 
 
5. If your local BBS is neither FBB nor NNA, select neither compressed forward nor 
compressed download. 
 
6. Finally, if you find you still have trouble, select Human mode. 
 
Some Advice: Don't Keep Swapping Options! 
It should be obvious from the above that there is an optimum way to use WinPack 
according to your specific situation. You can swap between compressed and non-
compressed downloading and forwarding as much as you want. You can also swap 
between using and not using the unproto beacons as much as you want, but the setup 
changes that this causes mean the whole of your current message list will be deleted 
every time you change your usage of the unproto beacons.  
 
Also, you must make sure that there is no personal mail waiting to be downloaded or 
waiting to be sent to the BBS before you change your usage of the unproto beacons. If 
you don't you may lose some messages or find your system trying to download 
messages that don't exist. 
 
You have been warned! 
 

Renumbering the Message List 
 
Included in the WinPack directory is a separate program called RENUMBER.EXE 
 
This program is designed to allow you to renumber your WinPack message list, after an 
FBB BBS sysop has renumbered the messages on the BBS.This is quite a complex 
procedure and results are not guaranteed! If you value the bulls you have on your 
system, please back them up before attempting to renumber. 
 
When the BBS sysop renumbers the BBS. He must do the following:- 
 

1. Tell you when he is going to do it, so you can avoid automatic WinPack connects 
until – 
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2. He must tell you the "offset" of the message numbers on the BBS. After a 
renumber, the message numbers will have moved downwards by a fixed amount. 
This will usually be a multiple of 10. He can only tell you what the offset is after 
he has renumbered. If he puts the information in the BBS log-on on message, 
you can simply make a manual connect, get the offset and then log off. 
 
(If the sysop won't co-operate in this, you can work it out for yourself by looking at 
the number of a message on the BBS before and after the BBS has renumbered 
- subtract one from the other to give you the required offset). 

 
3. Once you know the offset, run RENUMBER, tell it the offset and click the 

"Renumber" button. It will then renumber the WinPack message list and the 
result should be that the message numbers exactly match those on the BBS. 

 
Restrictions 
 
RENUMBER has only ever been tested against the G3WCS FBB renumber program. 
Other BBS renumbering utilities may not use the fixed offset method, in which case the 
WinPack numbers will not match those on the BBS. 
 
If you have a lot more messages in your WinPack message list than the BBS has in its 
list, it could happen that the offset used by the BBS would result in some of your 
messages numbers going negative. E.g. - The BBS numbers are from 40,000 to 50,000 
and it renumbers with an offset of 35,000, so it's new range is 5,000 to 15,000. Your 
WinPack numbers are from 30,000 to 50,000, so an offset of 35,000 results in your 
lowest number being -5,000! To avoid this, all you need to do is to check if the offset 
used will give a problem, if it will you simply Prune your message list in WinPack to get 
rid of some of the low numbers. 
 
If you don't use the FBB beacons, check your bulletin columns after renumbering! If 
the numbers were above 100,000 before renumbering and are now below 100,000, the 
columns will have moved one position to the left. 
 
The current version of RENUMBER will not renumber your personal messages in 
WinPack. This only matters if you use the FBB headers and have personal messages 
waiting on the BBS for you to collect at the time the renumber is carried out. If that 
happens, WinPack will try to download the personal messages using the old numbers, 
which will fail. However, you can still get any such messages by clicking them in the 
bulls list, so they aren't lost. 
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Writing Messages 
Menu bar: Mail>Write a Message 
 
To write messages, both personal mail and bulletins, you use the Write a Message 
option on the Mail menu. (There are also options for editing and deleting any messages 
that you have previously written). This will bring up the Write a Message window. 
 

 
 
The buttons and field on this window do the following: 
 
Type - This is the type of the BBS message. It can be P for personal or B for a bulletin. 
 
To Field (not the To Button)  - For a personal message (P) this field is the callsign of 
the recipient. You can either: 

• type in the callsign of the recipient 
• use the Address book to insert a callsign and name - see To Button below.  
• or send the same message to several different recipients using a mailing list. See 

Creating And Using Mailing Lists below 
 
For a bulletin (B) type message this field would be a BULLETIN TOPIC  - you can 
either: 

• key in a topic of your own choice 
• select from a list of topics. 
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If possible, it is better to use a selection from the list. By using a topic that is in common 
use you are more likely to get replies to your message. For an explanation of each topic 
in the list, go to the Bulletin Topics List. 
 
To drop the Topics list down into the Write a Message window, enter a B in the Type 
field and then click on the small down arrow that appears in the TO Field (or press Alt 
and cursor down). NB- you can edit  the TOPICS.TXT file in WinPack’s \BULLS 
directory to add and delete topics of your own choice; or if you think the program’s Topic 
List is a bad idea, simply delete TOPICS.TXT and you will then not get the list. 
 
Name - This is the name of the recipient. It is only useful as a mnemonic for storing in 
the address book. 
 
At - For a personal message this is the home BBS of the recipient. For a bulletin it is the 
circulation area - GBR, EU, WW, etc. 
 
Title - This is the title or subject of the message - up to 30 characters long. 
 
OK Button - Pressing this button means that you accept the header information and 
WinPack will open an Edit Window where you can input the message text. 
 
Cancel Button -  Pressing this button cancels the message. 
 
7plus Button - If you press this button, you will be able to select a file to send using 
7plus. For more information see 7plus. 

Address Book 
Below these buttons is the Address Book window. This is the list of callsigns and 
addresses in the address book. The list will scroll. To use an entry to fill in the header, 
you can highlight it and press the To Button, or press <Enter> when an entry is 
highlighted, or double click on an entry. It is updated using the Add and Delete buttons.  
The buttons below the Address Book window are: 
 
To Button – Use this button to fill in the message the header with the currently 
highlighted entry in the address book. Click first on the entry you want. 
 
Add Button - Pressing this button causes the information currently in the header to be 
added to the address book. To create address book entries without sending a message, 
you can keep filling in the header and pressing Add then press Cancel when you have 
finished. 
 
Delete Button - Pressing this button deletes the currently highlighted address book 
entry. 
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Sending Messages 
 
You can send your message in one of three ways: 
 

1. Automatically: If you use the Write Message feature of WinPack, after your 
message is written and closed, it will be uploaded automatically at the next Auto 
BBS session. 
 

2. Manually Line–by-Line from the WinPack Transmit Window: 
a. CONNECT to the BBS 
b.  send the S (or SP or SB) “send mail” command 
c. at the title prompt, enter the message’s title  
d. at the message text prompt, enter the message text line by line. You don’t 

need to use the <Enter> to send each line. WinPack will do that when the 
line is full. Press <Enter> (twice) only to start a new paragraph. 

e. end the message by sending a Ctrl+Z or /EX on a separate from the 
Transmit Window 

 
3. Manually using the Edit Window: 

(similar to #2 but you can compose the message before you log onto the BBS) 
a. first compose the message in the Edit Window (File>Edit Window).When 

done, use the Edit Window’s menu  (F10 or right click) to hide the 
window  

b. from the Transmit Window, CONNECT to the BBS  
c. send the S (or SP or SB) “send mail” command 
d. at the title prompt, enter the message’s title   
e. at the message text prompt, open the Edit Window (File>Edit Window or 

Edit Button ) and then the Edit Window’s menu  (F10 or right click)  
f. select Send to send the Edit Window text  
g. end the message by sending a Ctrl+Z or /EX from the Transmit Window  
 
Hint: When composing your message in the Edit Window, you can even 
include the BBS mail commands in the message text with. For example, start 
the message with: 

SP G4IDE               ”send private mail to” command on separate line 
New Information      message title on separate line 

You can also include the “end message” command -- a Ctrl+Z or /EX – by 
placing it on a separate line at the end of the message. 
 
Then, after you connect to the BBS (step 3b), just send the Edit Window text 
(step 3e & 3f) and forget about steps c, d, and g. 
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Creating And Using Mailing Lists 
If you regularly want to send the same message to several recipients, then you may find 
it helpful to create a Mailing List. 
 
Mailing Lists live in the MAIL\LISTS subdirectory. Each list contains the packet 
addresses of the recipients for messages sent to that list. It can also contain comment 
lines - these must start with  ; . You should create a list with a plain text editor - either 
the WinPack editor or NotePad is recommended. 
 
The file name of a list must obey the following rules - it must be a valid DOS file name, 
with an extension of  .TXT and the first part of the name cannot have more than five 
characters. Therefore CLUB.TXT or LOCAL.TXT would be valid list names, but 
MYCLUB.TXT would not be (too long). 
 
Here is an example of a list which I called TEST.TXT:- 

;This is my list for testing WinPack. 
G0OPC @ GB7WNM 
G8MZX @ GB7SKG 
G4IDE @ GB7OAR.#16.GBR.EU 

 
To send a message to the members of a list, you put the list name preceded by an 
exclamation mark in the To field of the Write A Message header form. With my 
example list, I would sent the message to "!TEST". WinPack will check if the list exists 
and it won't allow you to proceed if it doesn't. 
 
When you connect to your local BBS and upload mail, WinPack copies the message to 
each recipient in the list and deletes the original. Please note that this is not as efficient 
as using a carbon server on the BBS, because you have to upload the message once 
for each recipient, whereas if you use a carbon server you only upload it once. 
 
If you get disconnected from the BBS during the forwarding session, you will find that 
the unsent individual messages will be in your WinPack outbox, not the original 
message, but these can be forwarded on the next connect. 
 
 



 

7. Text Editor: The Edit Window 
Menu bar: File>Edit Window 
 
WinPack’s Edit Window is a simple text editor, similar to the Windows’ Notepad 
program. You can also access it from the button by pressing the Edit Window button 

. The Edit Window will appear over the Transmit Window and part of the Receive 
Window. 
 

 
 
When using the Edit Window for writing mail, for best results, only put a <Enter> at the 
end of paragraphs. Let the window flow the text for you. When the text is transmitted, 
WinPack will make sure that text lines are no longer than the line length setup in 
Options>Comms Setup". The end result is more pleasing to the eye if you have not 
put a <Enter> at the end of every line. 
 
The window can be zoomed up to the full size of the WinPack screen by selecting 
Zoom from the pop-up edit menu, or by pressing Ctrl+Z when the cursor is in the Edit 
Window. Using either option again returns the window to its normal size. 
 
The top line of the Edit Window shows a character count for the text being edited - 
helps you keep within the message size guidlines! (This isn't visible in the picture 
above). 
 
If you have the Quinion spelling checker installed (see README.TXT) on your PC, 
then pressing Alt+F9 will allow you to check the spelling of the text in the window. If you 
have Microsoft Word installed on your PC, then pressing Alt+F7 will allow you to 
check the spelling of the text in the window.  See Spell Checkers.  
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The Edit Window’s  Menu Options 
The pop-up edit menu is activated by either pressing F10 when the cursor is in the Edit 
Window, or right clicking with the mouse (twice for Win95) in the window. 
 
Here’s what the menu choices do:- 
 
Send - If you select the send option, the text currently in the window will be sent to the 
TNC. The idea is so that you can easily compose messages in an editor, rather than 
sending them a line at a time straight to your local BBS. 
 
When the text is sent the window is cleared. However, the text is also copied to the 
Windows clipboard, so, if you want to get it back, press Control+V. 
 
Signature - Selecting this option will allow you to add a signature at the end of the text. 
You will be presented with a list of available signature files and you can pick which one 
you want to use. This option has the same effect as selecting  Options> Signature. 
 
Note that if you use the signature button rather than this menu option, then the default 
signature is used - you won't be able to select your signature. See also Signature 
Options. 
 
Quote - If you mark a section of text in the Edit Window by dragging the mouse over it 
and then select this option, the text will be 'quoted'. That means a  > will be put at the 
beginning of each line. The idea is that you can load a message from someone else into 
the edit buffer and quote sections of it in your reply. How successful the quoting is 
depends on the line length used by the sender. However, the program attempts to do 
some intelligent reformatting on the text if the lines are too long. 
 
Save - This option allows you to save the contents of the window to a file. 
 
Load File - This option allows you to load an existing text file into the window. Any 
existing text in the window is lost. See also Using Drag and Drop. 
 
Paste From - This option allows you to insert an existing text file into the Edit Window. 
It is inserted at the current cursor position in the window. Any existing text in the window 
is retained. 
 
Clear - If you select this option the window is cleared. 
 
Hide - Selecting this option will hide the Edit Window again. However, its contents will 
be preserved. To remind you that the Edit Window is still active, the Edit button will 

gain a red box around it  . 
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Abandon  - this option is only available when you are composing mail or editing a 
message. If you select it, then the message that you are writing (the entire process) is 
abandoned. 
 
Zoom - Selecting this option will zoom the edit  window up to the full size of the 
WinPack screen, selecting it again returns the window to its normal size. You can do the 
same thing by pressing Ctrl+Z. 
 
Insert Link - This option allows you to insert a text link into a message. It is an 
advanced and somewhat experimental option. See Text Links. 
 
 

Printing from the Edit Window 
 
You can print the contents the Edit Window by selecting the File>Print menu option or 
by pressing the Print Button on the tool bar. WinPack will ask you which window you 
want to print. 
 
If there is any selected text in the window (drag the mouse to select), then WinPack will 
print the selected text, otherwise it will print all the text in the window.  
 
You can change the printer font by using the Options>Fonts...>Printer menu option. 
 
WinPack defaults to using the full print width available. This is because many packet 
users still tend to use lines of around 80 characters, and most printers have difficulty 
fitting that number of characters across the paper even when you use the full width. If 
you want to set a margin, then you can edit PACKET.INI and alter the 
LEFT_MARGIN_MM and RIGHT_MARGIN_MM settings in the [PRINTER] section. 
 
You can use Print to save a message to a file. If you check the Print to file box in the 
Print Dialogue then you will be prompted for a file name and the text will be saved in 
that file. 
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8. File Transfers 
WinPack support both YAPP and 7plus file transfers 

YAPP File Transfers 
 
YAPP is the most popular protocol for sending binary files (programs, graphics, 
application files, such as formatted documents, etc) via packet. It was originally devised 
by WA7MBL. There have been a few extensions made to the original system. WinPack 
supports the most popular of these which is FBB style 'crash resume'. This allows you 
to resume transferring a file after a previous attempt failed part way through. 
 
The following items are covered in this section of the manual: 
 
transfer status window 
Using YAPP to Send A File 
Using YAPP to Receive a File 
Resuming a YAPP File Transfer 
YAPP Auto Receive 
YAPP Options 
 

The Transfer Status Window 
This window appears during both YAPP File Transfers  and FBB compressed mail 
transfers.  
 
File Name or Message Title 
For a YAPP transfer, this shows you the name of the file currently being transferred. For 
FBB compressed mail transfer it shows the message title. 
 
File Size 
This shows the size in bytes of the file currently being transferred. It is not shown if the 
transfer is FBB compressed mail. 
 
Status 
This shows the current status of the transfer, 'Waiting for Initialisation', 'Receiving data', 
etc. 
 
Transfer (cps) 
This shows the approximate data rate for the current file transfer. To be precise, it 
shows the total number of characters transferred for this file divided by the number of 
seconds that have elapsed since the transfer started. It does not include the time taken 
in preliminary protocols, only the time whilst the actual data is being transferred. 
 
For outgoing transfers, WinPack can only count the data as it goes to the TNC, it has no 
way of knowing if it has yet been transmitted. Therefore, for small uploads, or even for 
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large uploads if your TNC has a large buffer, it will initially be very misleading, because 
all the data 'rushes' into the TNC buffer. However, if will then gradually adjust itself to a 
more meaningful value. The true cps achieved is the lowest value it falls back to whilst 
waiting for the 'FF' from the BBS. 
 
The default maximum value for the bargraph is 80 cps, but you can change it by right-
clicking on it. 
 
Transfer (%) 
The bargraph shows the percentage of the file that has been transferred, and the 
caption shows an estimate of how many minutes the transfer will take to complete, 
based on the current cps rate. The estimated time may be severely distorted by data 
rushing into the TNC buffer in the same way as the cps. You can disable the display of 
the estimated time by putting "SHOW_TIME_ESTIMATE=FALSE" in the "[YAPP]" 
section of PACKET.INI. 
 
Sent or Received 
This shows how many bytes of the file have been transferred. If you are sending the file 
then it will be labelled 'Sent', if you are receiving the file then it will be labelled 
'Received'. 
 
Abort 
If you press this button then the transfer is aborted. Don't  use it unless you really have 
to! This is an uncontrolled abort and the other end of the link will still think you are 
transferring the file. All normal failures are handled automatically. 
 

Using YAPP to Send a File 
Menu Bar: YAPP> Send a File 
 
The following describes what to do if you want to upload the file to a BBS. If you are 
wanting to send it to a friend directly (without a BBS) then it is easier; jump to step '4'. I'll 
assume the file is called TEST.EXE. 
 
1. Tell the BBS you want to send it. With FBB you have to go into FBB DOS and then 
send the command YPUT TEST.EXE. With an NNA BBS you use the command YU 
TEST.EXE. 
 
2. The BBS will then ask you for a description - key in something suitable. 
 
3. The BBS will now prompt you to send the file. 
 
4. (If you are sending the file to a friend then ignore '1', '2' and '3' and start with this 
step). Select 'Send A File' from the WinPack YAPP menu. A standard Windows file 
dialogue will open up. If you don't know how to use a Windows file dialogue, give up at 
this point and learn how! 
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5. Using the file dialogue select the file you want to send. The dialogue will open in the 
PUB directory, but you can send a file from any directory on your PC. 
 
6. When you have selected the file, the rest of the process is automatic. The YAPP 
transfer window opens and you don't have to do anything else. If the transfer fails then 
you will get a message saying why. 
 
NB- When a file is being sent, there can be quite a lot of data, typically several 
thousand bytes, buffered within the program and in the TNC. When the screen reports 
Sending End Of File, transmission won't immediately finish, all the data that is 
buffered has still got to be transmitted. So don't press Abort thinking the transfer has 
failed! 
 

Using YAPP to Receive a File 
Menu Bar: YAPP> Receive a File 
 
The following describes what to do if you want to download the file from a BBS. If you 
are wanting to receive it from a friend directly (without a BBS), then jump to step '3'. I'll 
assume the file is called TEST.EXE - it must of course be a file that is on the BBS! 
 
1. Tell the BBS you want to download it. With FBB you have to go into 'FBB DOS' and 
then send the command YGETT TEST.EXE. With an NNA BBS you use the command 
YD TEST.EXE. 
 
2. The BBS will prompt that it is ready to send the file, and a couple of funny characters 
should appear in the WinPack receive window. 
 
3..If Auto Receive on the YAPP menu is enabled, the program will now receive the file 
completely automatically, otherwise … 
 
4. Select 'Receive a File from the YAPP menu, the rest of the process is automatic. 
The YAPP transfer window opens and you don't have to do anything else. If the transfer 
fails then you will get a message saying why. 
 

Resuming a YAPP File Transfer 
Menu Bar: YAPP> Receive Resume 
 
If you have received a large part of a file and then the link between you and the sending 
station fails, this option allows you to resume the transfer from the point at which it 
failed, so long as the sending station can support FBB-style 'crash resume'. 
 
I'll assume that you want to resume downloading a file called TEST.EXE from a BBS. 
Most of the following procedure is exactly the same as if you were starting a normal 
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download. If you are receiving the file from a friend directly (without a BBS), then jump 
to step (3). 
 
1. Tell the BBS you want to download the file. With FBB you have to go into 'FBB DOS' 
and then send the command YGETT TEST.EXE. With an NNA BBS you use the 
command YD TEST.EXE. 
 
2. The BBS will prompt that it is ready to send the file, and a couple of funny characters 
should appear in the WinPack receive window. 
 
3. Select 'Receive Resume' from the YAPP menu, the rest of the process is automatic. 
The YAPP transfer window opens and you don't have to do anything else. 
 
4. WinPack tells the other station how much of the file it already has and the transfer 
carries on from there. If the file does not already exist then the program behaves as if 
normal YAPP Receive had been selected. If the transfer fails then you will get a 
message saying why. If you get an immediate abort then the sending station does not 
support FBB-style resume. 
 

YAPP Auto Receive 
Menu Bar: YAPP> Auto Receive 
 
If you enable this option, then, all the time you are connected to another station, the 
program will continuously scan all received text for the special characters that signify 
that the other station is trying to send you a file using YAPP protocol. 
 
As soon as these characters are received, the program will behave as if Receive 
Resume has been selected from the YAPP menu. Therefore YAPP files can be 
received without you having to do anything at all. 
 
Because resume mode is used, you need to be a little bit careful about leaving files in 
your download directory. If a file exists with exactly the same name as the one being 
received,  the program might attempt to append incoming data to the existing file. 
 

YAPP Options 
There are some YAPP options that can be altered, but I have deliberately made it a little 
difficult to change them to deter casual 'fiddling'! 
 
To change these settings you have to edit the file PACKET.INI which is created in your 
WinPack directory the first time you run the program. Look for a section in the file titled 
[YAPP]. All the options are in that section. 
 
TNC_PROMPT=cmd: 
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This is the prompt that you get from your TNC. I've never seen one that doesn't use 
cmd:, but I'm sure there must be one somewhere! If yours uses a different prompt then 
you will have to change this setting. 
 
TIMEOUT=300 
This is the length of time the program will wait, when downloading a file, without 
receiving anything from the sender before it aborts the transfer. It is in seconds, so the 
default is 5 minutes. 
 
BREAK_LENGTH=3 
TNCs can be put into command  mode by sending a 'break' signal. The 'official' length 
of a break is anything longer than two characters. Three characters should be fine - but 
if you find your TNC doesn't seem to respond correctly after a YAPP transfer, until you 
have switched it off and back on again, you can try a higher value. 
 
COMMAND_MODE=CTRL+C 
The TNC has to be put into command mode before a YAPP transfer can commence. 
The default is that it is done by sending a 'Control C' character. The alternative is to use 
a break signal. If you get an error message saying that your TNC could not be put into 
'transparent' mode then try changing this setting to use break. The line must then read 
COMMAND_MODE=BREAK. 
  
CMDTIME=1000 
This means 1000 milliseconds. It must be the same length of time as your TNC's 
CMDTIME setting. The default is almost always 1 second, and it is very unlikely that you 
will ever need to change this setting. Please note that the setting used for the TNC may 
be in units of a second, not a millisecond. 
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7plus File Transfers 
 
For direct transfers of binary files, you can use YAPP. But for a mailbox to transfer 
binary files to remote users, it needs them to be formatted as messages of a suitable 
size. 7plus is a system that allows users to transfer binary files through the normal BBS 
system, without causing complete mayhem. 
 
This section tells you how to: 
 

• configure WinPack for using 7plus 
• send files using 7plus 
• automatically decode 7plus files received in an Auto BBS sessions  
• automatically decode 7plus if you are manually connected to the BBS and 

reading messages. 
 
If you don't know what 7plus is, or why it is used, see What Is 7plus below 
 
Note: The use of Seven Plus to send binary files is one of the most controversial 
subjects on the UK packet network. It is controversial because Seven Plus is so often 
used incorrectly by people sending very large files, or sending parts that are far too 
large. Before you use Seven Plus you should familiarise yourself with the DCC 
document "Guidelines For The Use Of The Packet Radio Network" which is in the 
Appendix. A copy is also included with WinPack and can be viewed by clicking the 
Guidelines icon in the WinPack Program Group of Windows. 
 

Configuring WinPack to Use 7plus 
 
7plus operations can be configured using the Options>7plus Setup submenu, 
including setting the 7plus “part size”. These are discussed in the Menu Layout 
Appendix. 

Using Seven Plus To Send Files 
When you use Mail>Write A Message, there is a button available labelled "7plus". If 
you press this button, you will be able to select a file to send using 7plus. 
 
Zipping the File - Once you have selected the file you are given the option of zipping it 
to make it smaller. You need either PKZIP or WinZip on your PC for this to work.  
 

• For PKZIP, WinPack uses a PIF file, PKZIP.PIF, in the WINPACK directory, to 
run PKZIP. The PIF file assumes that PKZIP.EXE is in a directory in your DOS 
PATH. If it isn't, then you must either put it in a directory that is included in your 
PATH, or edit the PATH environment to include the directory where PKZIP.EXE 
lives. 
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• For WinZip, you need to edit the [TERMINAL] section of the PACKET.INI file 
and add a line with a ZIP command - ZIP=C:\winzip\winzip.exe -min -a. but of 
course with the correct path for your copy of WINZIP! Also, if you are using 
Win95, you will probably would be using a file named WINZIP32.EXE. 
 
Note: be sure to include the –min –a parameters. Also, if your directory path 
include a name longer than 8 characters, you’ll need to use the Windows 
abbreviation for 8 character. For example, my WINZIP directory is a subdirectory 
of the Program Files directory. So my ZIP command is: 
ZIP=C:\progra~1\winzip\winzip32.exe -min -a 

 
•  [To have WinZip unzip any ZIP files you receive, you’ll also need to add a 

second line with an UNZIP command - UNZIP=C:\winzip\winzip.exe -e -o -j   -  
but again with the correct path and name for your copy of WINZIP]. 

 
Parts per Day – based on the overall size of the file and the ‘part size’ set in 
Options>7plus Setup>Part Size,  WinPack will split the file into parts. If more than 3 
parts are created, WinPack will ask how many parts per day you want to release. (In the 
interest of not overloading the network, you should consider sending only a few parts 
day on non-critical files). Here’s how WinPack handles the release of files: 
 
Say the file you are sending has been split into 9 parts and you choose to release 3 
parts per day. All WinPack mail files have a time stamp encoded in the file name that is 
used to store them on your PC. The Seven Plus parts will be time stamped: 

• 3 with the current time, 
• 3 with the current time + 1 day  
• 3 with the current time + 2 days. 

When WinPack uploads mail to the BBS, it will not send a file if the time stamp is ahead 
of the current time, so your files will not be sent until the current time has passed their 
time stamp. 
 

Seven Plus Receive During Auto BBS Sessions 
Please Note - from V6 onwards, WinPack handles received 7plus slightly differently to 
earlier versions. There are now separate directories used for extracted 7plus parts and 
for decoded 7plus files. Also, a record can be kept in a log file of all 7plus decode 
attempts. 
 
If the Auto 7plus Decode option on the Options>7plus Setup submenu is checked, 
then all personal mail and bulletins received during Auto BBS sessions are scanned to 
see if they contain 7plus data. If they do, the data is extracted and put in WinPack’s 
7EXTRACT directory. 
 
When all the parts of a 7plus set have been received, WinPack will attempt to decode 
the file and will send you a system message as to whether the decode was successful 
or not. 
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If Log 7plus Decode on the Options>7plus Setup menu is checked, then, every time 
that WinPack attempts to decode a 7plus file, an entry will be made in the log file 
7PLUSLOG.TXT. By looking at the log you can see when a file was decoded, if the 
decode was successful, whether it was received as a bulletin or as personal mail, and 
who sent it. You can view the log file with Notepad or you can load it into the WinPack 
Edit Window. 
 
If the decode is successful then the parts are either deleted or moved to the 
7PLUSOLD directory, depending on the setting of the Keep 7plus Parts option on the 
Options>7plus Setup menu. Normally the decoded file will be moved to the 7DECODE 
directory. However, if a file by the same name already exists in the 7DECODE directory, 
the decoded file will be left in the 7EXTRACT directory. Both the system message and 
the log entry will show whether or not the file was moved. 
 
If a .COR file is received for a 7plus file for which all the parts have been received but 
which contains errors, WinPack will attempt to use the .COR file to repair the 7plus file. 
 
If the decode is unsuccessful then a .ERR file will be produced in the 7EXTRACT 
directory. 
 
The above process can obviously go wrong in several ways! If some parts of a set are 
never received, the parts that have been received will languish for ever in the 
7EXTRACT directory. Also, if you are happen to receive two different sets at the same 
time with the same file name (this does sometimes happen), then things can get very 
messy! 
 
Therefore, it is a very good idea to occasionally look in the 7EXTRACT directory and 
delete any rubbish that has accumulated. 
 
If a .ERR file is produced, then to send it to the sender of the 7plus data as follows:- 

1. Select Mail>Write a Message and start a message to the sender.  
2. From the Edit Window menu select Load and load in the .ERR file form the 

7EXTRACT directory. 
3. Send the message. 

 

Seven Plus Receive During A Manual Connect 
If you want to read and decode a 7plus file whilst you are manually connected to the 
BBS, then you must do the following:- 
 

1. Make sure that Scan Capture Files on the Options>7plus Setup sub-menu is 
checked. 

2. Manually connect to the BBS. 
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3. Click the Capture button or select File>Capture from menu and input a file 
name. This file is only used as a temporary store for the data, so, if you wish, you 
can always use the same name and overwrite the file each time. 

4. Read the message or messages with the 7plus in them - you can capture several 
in the one file. 

5. Close the capture file - and the 7plus will be extracted and decoded, just as if it 
was in a message that had been read in an Auto BBS session 

 

What is 7plus? 
 
This following was written by Brian, G8ASO. I thank him for giving his permission to use 
it. It explains the basic theory of 7plus and why it is used. As far as WinPack is 
concerned, the only difference is that the tasks of encoding and decoding the 7plus 
parts, selecting a suitable part size, and controlling the release of the parts to only a few 
per day, are automated. 
 
Brian has also written an excellent series of notes intended to give help to packet users 
in understanding how the system works and answering some of the often asked 
questions. I thoroughly recommend them. For a current list of the files available send a 
REQuest FILe message: 
 

                                 SP REQFIL @ G8ASO.GB7GLO.#46.GBR.EU 
(Message Title)       STARTNDX.ASO 
(Message Text)       /EX 
 

 
"What is this system that fills my screen with nonsense, and compels otherwise sensible 
people to deride each other?" 
 
That is a quote from an enquiry recently. It could be compressed forwarding traffic 
between users of FBB, NNA, TPK or MSYS software. Or on some frequencies inter-
node linking traffic. Or binary files being transferred. 
 
The problem with binary files, be they program files or compressed data files or picture 
files is that they contain characters that are used to define end of file, end of line, etc. 
which are used in normal mailbox operation. Also when sending data through the 
Packet Radio network, errors may occur in spite of the safety mechanisms incorporated 
into the AX25 protocol. Plain text with errors is still usually legible for humans. We can 
correct or ignore errors (as long as numbers aren't falsified) and thus still understand 
what it meant. Even at an error rate of 10%, we can still get the meaning of the text. On 
the other hand, the successful sending of a binary file requires that every byte is 
transferred without error. 
 
How can this problem be overcome? The answer is to convert binary files to a format 
compatible with the BBSs. This task is done by ASCII-encoders like UUencode or more 
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commonly now 7plus. UUencoding often doubled the size of the binary file. Instead 
7plus uses checksums on each and every line of code, and can recognize the exact 
position of errors and can process errors without having to resend entire files over and 
over again. UUencoded files can usually be sent in a network that only uses 7-bit codes. 
 
The encoding scheme 7PLUS uses, could well be called a 7-three- quarter-bit encoding, 
because on the smallest scale, 31 bits of the original data are encoded into 32 bits (4 
characters) of the 7PLUS code. That is one of the reasons, why 7PLUS is called 
7PLUS. This causes an overhead of 1/32 = 3.125%. Because of the required line 
delimiters, checksums, head and foot lines, the overhead increases to about 13% to 
15%. 
 
The characters used by the 7PLUS algorithm (in HEX notation) are 21 - 29, 2B - 7E, 80 
- 90, 92, 94 - FC. Characters not used: 00 to 20 (Control codes and the space 
character) also 2A, 7F, 91 and 93. 
 
To process 7plus files, either encode or decode you require the 7plus program, there 
are versions for IBM compatible machines, Atari, Amiga and Archimedes. Though 
obviously a program for one machine will not work on one of the others. 
 
When preparing files for transmission, they should be compressed (the norm on PCs is 
to use PKZIP), if at all possible, to minimise the air time they will take. Then using 
7PLUS the files should be split into sections, of perhaps 5k long maximum. You should 
not send too many files/sections during a day - other people want to use the channels 
after all. When you compressed files you can combine program and documentation in to 
one file. Note: There is a recommendation of a maximum of 10 parts of 5k long being 
transferred on packet [editor note: WinPack’s default is 4k]. 
 
Items which are sent should not be copyright, unless it is your copyright, or where the 
copyright holder has given permission to allow distribution. As this is Amateur Radio, 
the files should reasonably be expected to have relevance to the hobby. 
 
When you receive all the parts of a file distributed using 7plus it is simply re-constructed 
by running the program and telling it the name of the segmented files. If there are errors 
it will generate an error report, which would then be sent to the originator and a 
correction file generated. The program is run again with the original sections and the 
correction and it should all come together .... or generate another error file! If the original 
was sent as bulletins, watch out for corrections also sent as bulletins. 
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9. Scripts 

About Scripts 
WinPack supports a simple form of script. A script is a series of commands that the 
program can process. It makes it easy for you to automate such functions as connecting 
to your local BBS, downloading the message list, etc. 

Sample Scripts 
Three sample scripts, DXCLUST, BBS and SETTIME are provided with the program. If 
you want to try using scripts, please read the comments in these examples using the 
Edit Window. I suggest you leave these scripts without changes and create copies with 
new names if you want to create a new script. Note – All Script files have a .TXT 
extension. 

Special WinPack Scripts 
There are three special scripts - STARTUP, EXIT and BBSBYE  that will be executed 
automatically at appropriate times - if  they exist in the WinPack SCRIPTS subdirectory. 
 

• STARTUP will be executed whenever you start the program. (A copy of the 
SETTIME script renamed to STARTUP is actually the script that I use as my 
startup script. SETTIME is installed during the WinPack installation). 

• EXIT will be executed when you quit the program.  
• BBSBYE, if it exists, is executed when WinPack disconnects at the end of an 

Auto BBS session. It can be used to drop you off a TheNet style node, after 
disconnection from the BBS (see comment below about EXIT_IF_DIS). It can 
also be used to run external programs that process mail after a BBS session 
(see the PROC keyword). 

 

Creating Scripts 
Scripts are created by using a text editor. You can create them in the Edit Window and 
then save them in the SCRIPTS subdirectory 
 
Each line of text in a script consists of a key word and then optionally some text that is 
used as part of the command. Lines in a script starting with a ; (semi-colon) are ignored. 
Lines that the script interpreter can't understand are also ignored! 
 
See Script Keywords below. 
 

Playing A Script 
Menu bar: Scripts>Play a Script 
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Script - Current Command 
This window shows you the script command that is currently being processed. In this 
case it is waiting for the end of the prompt from a BBS. The '^M' means a <Enter> 
character. For more information see about scripts. 
 
Script Cancel Button 
This button allows you to cancel a script that is playing. 
 

Script Keywords 
The following is a list of all the keywords are understood by the WinPack script 
interpreter:- 
 
OPENCAPTURE <filename> -opens a capture file as if you had used the "File", 
"Capture" menu option. 
 
CLOSECAPTURE -closes the capture file. 
 
CLOSE -  causes WinPack to close down. Any commands in the script after CLOSE are 
ignored. 
 
DIS_IF_CANCEL - Sets a flag to force a disconnect if the script is cancelled for any 
reason. 
 
EXIT_IF_CON - exit from the script if there is a connection. 
 
EXIT_IF_DIS - exit from the script if there is no connection. Designed to be used in the 
BBSBYE script when using that script to drop you off a TheNet node after 
disconnecting from the BBS:- 
 

;give up if we're already disconnected 
EXIT_IF_DIS 
;wait for the node message 
WAITLINE Reconnected to BOST72 
;disconnect from the node 
SEND b 

 
FBBSYNC - sends a sync request to the local BBS if you are using the unproto list. See 
enhanced mail facilities. 
 
HOTKEY <key> - this assigns a hot key to a script. Valid values for <key> are F2 to F9 
for normal function keys, or F2S to F9S for shifted function keys (F5S is not allowed, 
because Shift+F5 sends the FBB sync requests.). The script can then be played by 
simply pressing the specified key. 
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IF_EXIST <filename> - the script is cancelled if the file <filename> doesn't exist. 
 
KILL <filename> - delete file <filename>. 
 
LOG_FREQ <frequency/power> - sets the frequency and power for subsequent log 
entries. Example:- 

LOG_FREQ 144.950MHz/10dBW 
 
PLAYTUNE <tune_name> and PLAYWAV <tune_name>  
Both commands work exactly the same. PLAYWAV is only retained for compatibility 
with older versions of WinPack. The .WAV or .MID (MIDI) file <tune_name> is played. 
The file must be in the WinPack WAV subdirectory. WinPack looks for a .WAV file first, 
if there isn't one it looks for a .MID file. E.g. "PLAYTUNE TALK" will play the file 
TALK.WAV or TALK.MID in the WAV subdirectory. If you create your own WAV files, 
they must be 8 bit, mono, 11kHz sampling rate. 
 
The special option "PLAYTUNE RANDOM" will select at random a MIDI file from 
WinPack’s \WAV\RANDOM directory and play it. (You need to create the directory and 
put some MIDI files in it before you can use this option.)  
 
Example of how this command might be used:- 
 
In the BBS.TXT script you could put:- 
 

C $BBS 
WAITCON 
PLAYTUNE RANDOM 
etc... 

 
This would result in a random tune be played whenever WinPack runs an Auto BBS 
session. 
 
RECONNECT - has the following effect:- 
 
1. A button with the caption 'R' will appear on the status bar. 
 
2. If a disconnection occurs the script will be rerun. This will carry on happening until 
you click the button - which makes it disappear. 
 
3. After the first reconnection the caption will change to '1', the next time it will go to '2'. 
When it reaches '9' it goes to 'A' and then carries on through the alphabet. The idea of 
this is to let you know how frequently you are getting disconnected! 
 
The sole purpose of the reconnection facility is to enable you to automatically reconnect 
to a DX Cluster if the link drops out. How successful it is depends on what causes the 
disconnect - if it is caused by a Cluster crash then this instant reconnect will normally 
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fail. The default delay before attempting a reconnect is 10 seconds. You may find it 
better to increase this:- 
 

(a) Make sure WinPack is not running. 
 
(b) Edit PACKET.INI in the WinPack directory using a text editor such as 
Windows Notepad. 
 
(c) Look for a section entitled [TERMINAL]. In that section there is an entry which 
says RECONNECT_DELAY=10. Change the 10 (seconds) to a bigger value. 
 
(d) Save the file. 

 
RUN <program_name 
Run a program. The program must conform to the standard WinPack external program 
format and be in the SCRIPTS subdirectory. This facility is designed mainly for dealing 
with password schemes. Please Note  that RUN will only work if you are connected. 
External programs are designed to either send their output to the TNC if they were 
started by an external user or by a script, or to the screen if the external command was 
input by the sysop. Therefore an external program can only be run from a script if there 
is a connection. There are some situations when this is too restrictive, and so the PROC 
keyword was introduced:- 
 

PROC <program_name> - Occasionally you may want to run a program from a 
script that does something like processing mail. At the time the program runs, 
there might not be a connection, so RUN cannot be used. PROC can be used in 
these circumstances. It works exactly like RUN except that any status returned 
by the program is ignored, and any output is sent to the WinPack screen. 

 
SEND <text>  -send specified <text> to the TNC. 
 
SENDFILE <filename> - sends the file as plain text, YAPPFILE sends the file using 
YAPP. 
 
SENDPASSWORD  - -sends a password. Normally based on the previous line of text.  
See Password Support. 
 
STAY_CONNECTED - This key word is only relevant to the BBS.TXT script. It tells 
WinPack to stay connected to the BSS at the end of Auto BBS sessions. However, if the 
session uses FBB compressed forwarding, then STAY_CONNECTED will be ignored, 
because FBB will not accept normal BBS user commands after compressed forwarding 
protocol has been used. Note that using this key word will mean that WinPack always 
stays connected to the BBS at the end of an Auto BBS session. If you only occasionally 
want to stay connected, then the Stay Connected option on the Action menu is 
available. 
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STOPTUNE - stops whatever is currently being played. This command is designed to 
be used in the BBSBYE.TXT script if PLAYTUNE or PLAYTUNE RANDOM is used in 
BBSBYE.TX. It allows you to play a MIDI tune during an Auto BBS session, but stop it 
when the session ends. 
 
SUSPENDREMOTE - Most WinPack users will want to have Enable Remote on the 
Options menu checked, so that people who connect to their system can use the 
Remote Access Commands. This can occasionally cause a problem if another system 
you connect to sends what looks to WinPack like a remote command, when in fact it 
isn't. The common example is that, if you connect to a JNOS converse server it has a 
line that starts "/bye" as part of its help - if WinPack sees that and "Enable Remote" is 
checked, then it disconnects! But, if you use SUSPENDREMOTE in a script, then it will 
temporarily disable the remote commands. It is reset when a disconnection occurs. An 
example script using it might be:- 
 

C SLCHAT 
WAITCON 
SUSPENDREMOTE 

 
Note - you must WAITCON before you SUSPENDREMOTE, since SUSPENDREMOTE 
is ignored if you aren't connected. 
 
TIMEOUT - By default, a script will time out if it has been waiting for an event to occur 
for more than 5 minutes. However, you can change the time out period by using the 
TIMEOUT key word. E.g. - 
 

TIMEOUT 10 
 
sets the time out to 10 minutes. You can change the time out more than once within the 
same script. The time out reverts to the default of 5 minutes when a new script is 
started. 
 
TITLE <text> - If you put a title line in a script, then, when you use the "Play A Script" 
menu option, the list displayed will contain the title <text> rather than just the file name. 
 
WAITCON<text> and WAITDIS 
Wait for a connection to be established. The <text> is optional. If used it should consist 
of words or phrases that will be received if the connection attempt fails. You can 
include several options, separated with '|' characters. Please note that it is case 
sensitive.  Example - you might put WAITCON retry count exceeded. If, whilst waiting 
for the connection, a line is received containing "retry count exceeded", then the Auto 
BBS session will be abandoned. 
 
WAITDIS waits for a disconnection. 
See also WAITPROMPT below. 
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WAITFOR <text> and WAITLINE <text> 
These two commands are similar, but NOT the same:- 
 
WAITFOR <text> waits for <text> to be received. It checks the text character by 
character as it is received and exits as soon as <text> is found. It doesn't wait for the 
end of a line. WAITFOR can normally be used. 
 
WAITLINE waits until a line of text has been received (a line ends when a <Enter> 
character is received) and then scans it for the specified <text>. So it only exits after the 
<Enter> on the end of the line containing <text> is received. 
 
You can also specify  text that will cause the script to be cancelled. You put this text 
after the text that you are waiting to receive. Example:- 
 

WAITLINE Welcome To WinPack | DISCONNECTED | no PMS 
 

Will wait for "Welcome To WinPack", but will cancel the script if either 
"DISCONNECTED" or "no PMS" is received. 

 
WAITLINE was specifically introduced to allow scripts to process FBB sysop 
passwords. FBB sends an identifiable prompt  followed by the password numbers. E.g. 
"GB7OPC-0> 23 45 32 78 57". Therefore you have to look for the prompt, but you 
cannot move on to the next stage of the script and process the password information 
until the whole line has been received. "WAITLINE GB7OPC-0>" allows you to do this. 
 
WAITPROMPT <text> 
Wait for a line which both contains the text specified in "BBS Prompt" in Personal/BBS 
Info and ends with a '>'.  
 
The <text> is optional. If used it should consist of words or phrases that will be received 
if the BBS is not available. You can include several options, separated with '|' 
characters. Please note that it is case sensitive. 
 
Example - you might put "WAITPROMPT Busy from|all ports in use". If, whilst waiting 
for the BBS prompt, a line is received containing either "Busy from" or "all ports in 
use", then the Auto BBS session will be abandoned. 
 
See also WAITCON above. 

Control characters and Tokens 
The SEND command will normally put a carriage return on the end of <text>. There 
aren't many situations where you wouldn't want to send a <Enter>, so it is pointless 
always having to specify it. But if you don't want a <Enter> sent, then put a '~' character 
(tilde) on the end of the text. e.g. "SEND *~" will send an asterisk without a <Enter> 
after it, which is very handy for auto-bauding AEA TNCs. 
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If you want to include control characters in SEND commands, you can do it by putting a 
^  followed by the character.  E.g. to send a Ctrl+G, you would put ^G. 
 
Usually any WAITFOR text will also end with a <Enter> because you will normally be 
waiting for a prompt of some sort from the other end. However, there may be times 
when the text you are waiting for doesn't end with a <Enter>. Therefore you have to put 
in the <Enter> if it is part of WAITFOR text. You do this by putting in 'M. The ^ is a 
shifted 6 on a UK keyboard. 
 
Have a look at the sample scripts and it will be obvious what to do. 
 
The script interpreter understands a limited number of tokens, which are described in 
the tokens list. 
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The Tokens List 
 
The purpose of tokens is to enable commonly used information to be put into script files 
or into the signature file by the program. 
 
All the tokens start with the $ (dollar) character. If the program finds any of these tokens 
in a script or in the signature file, it substitutes them with some other text. Some tokens 
are used for personal information, which is read from PERSONAL.TXT.  These tokens 
are:- 
  $MYCALL 
  $1STNAME 
  $2NDNAME 
  $QTH 
  $QRA 
  $WAB 
  $EMAIL_ADDRESS 
  $BBS 
  $BBS_PROMPT 
 
To change them use the Options>Personal/BBS Info menu option (this automatically 
edits PERSONAL.TXT file). 
 
$VERSION makes the program version available. It is used in the WINPACK.SIG file. 
 
$WINP_PATH makes the WinPack path available. It is used in SELEDIT.XTR and 
ALARM.XTR. 
 
$CONNECTED_CALLSIGN - the callsign of the station currently connected to your 
WinPack system. 
 
$CONNECTED_NAME - the name of the person currently connected to your WinPack 
system. This is derived by looking up the connected callsign in the WinPack address 
book. If a callsign is not found in the address book, then the default for 
$CONNECTED_NAME is blank, however this can be altered via the 
NO_CONNECTED_NAME entry in the [TERMINAL] section of PACKET.INI. 
 
$CONNECTED_CALLSIGN and $CONNECTED_NAME are designed to be used in 
shortcuts, in BYE.TXT and in TALK.TXT. 
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All the other tokens are associated with the date and time, which the program reads 
from your PC clock. These tokens are:- 
 
Token  Substituted  Example 
$YYYY the year    1995 
$YY  the year        95 
$MMM the month      Dec 
$MM  the month        12 
$DD  the date        31 
$HH  the hour        17 
$NN  the minute        52 
$SS  the second        45 
$TZ  the time zone     UTC 
 
The examples are as if the program was processing the tokens at 17:52:45 on 31st 
December 1995. 
 
The main purpose of the date/time tokens is for setting the TNC's date and time from a 
startup script. Have a look at the script called SETTIME.TXT in the WinPack \SCRIPTS 
folder which is a good example of how to use tokens. I actually use that script as my 
start up script. 
 

The Script Status Window 
 
Dialogue windows are displayed when a script is playing 
 
One shows the name of the script and the command that is currently being processed. 
 
There is also a cancel button available in case the script gets stuck 
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Capture File 
 
You can have WinPack automatically store all Receive window text in a special Capture 
File. To initiate a file capture, use either  the File>Capture menu option or the Capture 

button on the button bar  to initiate capturing. (the button changes to  when 
capture is on ). 
 

 
 
The Open a capture file window will appear and ask you to name the captue file with a 
.txt extension. By default, WinPack will keep Capture files in the WinPack \CAPTURE 
subdirectory. You can change this if you would like. 
 
All received text will be stored in the file until you close it by deselecting the option. 
 
Note: Capture will not work in HOST mode operation unless you are connected with a 
station. That’s because the monitor stream and the connected mode stream are 
completely separate in HOST mode. (With a TNC in terminal mode, it's all one stream.) 
 
For capturing connection information only, another option is to use Logging 
(Options>Logging menu). The Auto Log feature will automatically capture connection 
information, while the Auto Dump feature will automatically capture all transmitted and 
received text of any connections. 
 
 

Command Line Options 

 
WinPack User Manual 

From V5.5, WinPack supports a few command line options. They were all requested by 
users who had fairly specialised requirements. None of them are relevant to my use of 
the program and so I haven't really been able to test them. 

version 6.80 
0 67 6/13/2002 
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You'll probably find it best to keep the normal WinPack icon without any command line 
options and set up a new one with the required options. 
 
To set command line options in Windows 3.1, highlight the icon, then select 
File>Properties in Program Manager and add the required options to "Command Line", 
for example, C:\WinPack\Packet.Exe /NOCOM 
 
In Win95+, if you haven't created a shortcut to WinPack\Packet.exe then you should do 
so. You can then right click on the shortcut icon, select "Properties", "Shortcut" and 
add the options to "Target". 
 
Modem Mode 
If you add the option /MODEM to the WinPack command line, then WinPack will run in a 
mode designed for use with a telephone modem on the land-line port of an FBB BBS. If 
you want to sometimes use WinPack with a TNC and sometimes with a telephone 
modem, then I would suggest creating two icons for the the program - one with the 
/MODEM option and one without it. For more information, see phone modem support. 
 
Suppress the Splash Screen 
/NOSPLASH will stop WinPack displaying a "splash screen" when it starts up. By 
default it displays SPLASH.BMP to give you something to look at while the program 
loads. 
 
Automatic Prune 
/AUTOPRUNE will cause WinPack to automatically prune the bulletin list when the 
program is started. See Pruning The Bulletin List. 
 
Options for use with Wisp 
Three options were put in for a user who wanted to run the program alongside the Wisp 
satellite system. The idea was that GSC in Wisp would run WinPack in between  
satellite passes. The /AUTO BBS and /NOCOM options are possibly of use in other 
situations. 
 
/AUTO BBS - specifying this will cause an Auto BBS session to start 30 seconds after 
WinPack is loaded. An optional delay can be specified, so "/AUTO BBS15" will result in 
the session starting 15 minutes after the program is loaded. 
 
/AUTOEXIT - the program will exit 1 minute after the first Auto BBS session ends. 
Designed to be used in conjunction with "/AUTO BBS". 
 
/NOCOM - WinPack will not attempt to use a COM port. It allows you to use the 
program just to read mail. 
 
Multi-user Option "/USER=" 
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/USER=   is to help people who have more than one amateur in the family, or who use a 
club station, and want to be able to use the same WinPack system with different 
callsigns. The idea is to set up one Windows icon for each user, with a different /USER=  
on each command line. 
 
My wife is also an amateur (G4GZL), so I could have two icons, one that had 
/USER=G4IDE on the command line, and one that had /USER=G4GZL. WinPack would 
then maintain separate copies of PERSONAL.TXT, called G4IDE.TXT and 
G4GZL.TXT. (PERSONAL.TXT contains all the information on the Personal/BBS Info 
screen). It would also create separate mail send and receive subdirectories for G4IDE 
and G4GZL. 
 
Because the user name is used as the file name, it must be 8 or less characters and 
only contain valid DOS file name characters. Your callsign is the obvious thing to use. 
 
If STARTUP.TXT is used to set MYCALL in the TNC using the $MYCALL token 
("SEND MYCALL $MYCALL"), this system can work fairly well. I have tested it by 
running G4IDE and G8MZX (the other callsign that I hold) from one system. 
 
If you use the unproto beacons, WinPack scans the beacons for personal mail for all 
users, and maintains a separate list for each user of any mail waiting on the BBS. 
 
Please take note of the following in you plan to use multiple users:- 

• Clear up any incoming or outgoing personal mail on your system before you start 
using multiple users. Otherwise you may lose it. 

 
• If you write mail but don't forward it, then it won't get uploaded to the BBS until 

you next use the WinPack system, simply because packet BBSs won't allow 
another callsign to forward mail from your callsign - it would infringe the "third 
party" regulations. 

 
• Similarly, mail will only be downloaded from the BBS for the callsign using 

WinPack at the time that the auto BBS connect occurs. You won't lose mail, but it 
can only be downloaded when you are using the system. 

 
• Set the Bulletins List (Options>Personal/BBS Info )command to LR $NUM. 

Everyone shares the same bulletin list in WinPack, but the BBS maintains a list 
pointer for each callsign  So, if any user uses LR, messages could be listed more 
than once .(This is irrelevant if you are using the FBB unproto beacons). 
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Drag and Drop 
WinPack supports "drag and drop" of files from File Manager. 
 
First of all, please note that there are some restrictions on when you can drag and drop. 
The rough rule is that if anything else is going on, e.g. reading mail, running a script, 
reading bulls, then the drag and drop is ignored. 
 
If you drop a file onto WinPack, it normally assumes that you want to send it to the TNC 
(there is an exception to this - see the comments below. If the file extension is ".TXT" or 
".BAT", then it sends it as an ASCII file. If the extension obviously means that it is a 
binary file (".EXE" ,".COM", ".ZIP", etc.), then it will send it using YAPP protocol. If the 
file type cannot be determined, then you will be prompted as to whether it is a binary or 
ASCII file. 
 
NB- you will always be prompted about .DOC files, since that extension is often used for 
text files in DOS, but is also used for Microsoft Word files. 
 
Be careful using "drag and drop"! If the file is an ASCII file then it is sent to the TNC 
even if you aren't connected - because it could be a setup file. You won't be allowed to 
start a YAPP send if you aren't connected to another station. However, remember that, 
unless the other station is running software that supports auto-detect of YAPP transfer 
(such as WinPack!), you must make sure that it is ready to receive the file before you 
"drop" it. 
 
If the Edit Window is open then drag and drop works differently. If the file is dropped in 
the Edit Window then it replaces the text currently in the window. If it is dropped 
anywhere else then it is ignored. 
 



10. Advanced Features 

 
WinPack User Manual    version 6.80 71 6/13/2002 

Dynamic Data Exchange 
Dynamic Data Exchange (DDE)  is a mechanism supported by the Windows operating 
system that enables two applications to "talk" to each other by automatically exchanging 
data. 
 
From V5.2 onwards, WinPack supports DDE and can act as a DDE source. 
 
To use the DDE facilities available in WinPack requires other programs to be written to 
take advantage of them. The file DDE.ZIP on the distribution disk contains a simple 
program which should provide sufficient information for any programmer who wishes to 
investigate the possibilities of writing programs to link to WinPack using DDE. 
 
What might these programs do? Lots of things! Here are two ideas that have occurred 
to me:- 
 
1. A program that would link to WinPack and monitor DX information from a DX cluster. 
As each "spot" was received, the program could automatically look up the DX callsign 
on a CD-ROM callbook, or perhaps operate a rotator to turn a beam in the required 
direction. 
 
2. A packet checkers or chess game that used WinPack for the communications, so the 
game would not have to include all the code to link to the TNC, etc. 
 
 

DX Clusters 
 
Although WinPack is not written specifically as a program to use for connecting to a DX 
Cluster, it does have several features which make it very useful for that purpose. 
 
You can use a script file to automate the process of connecting to the Cluster, which is 
very useful if you have to connect via two or three nodes. In the WINPACK\SCRIPTS 
directory you will find a sample script file named DXCLUST.TXT. You can edit this file to 
make it pertinent for your DX Cluster link  -- callsign, path, prompt, etc. (I suggest you 
first make a copy of the original file under another name in case you need to reference it 
later.) Note that the F3 key is the current default hot key for the DXCLUST.TXT file. 
 
Also note that the script uses the RECONNECT script key word to automatically 
reconnect if the link drops out. If a script runs using the RECONNECT key word, as 
soon as a disconnect occurs the script will be automatically re-run. If that happens, then 
the Stop Reconnect button will appears in case you don’t want the script to 
automatically re-run. Once the button has been pressed the reconnect feature of the 
script is disabled and the button disappears. See also about scripts. 
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WinPack will run when minimized, so you can connect to the Cluster and then minimize 
the program and carry on using your PC for other tasks. When minimized the program 
uses hardly any of your PC's processor time. 
 
If the Options> Enable Beep menu option is enabled, the Cluster spot 'bells' will still 
sound when the program is minimized. Also enabling the Options>Restore on Beep 
menu option will cause the program to 'pop up' from being minimized every time a bell 
occurs. 
 
When minimized, WinPack looks at every line of text received to see if it is a Cluster 
'spot'. If it is, then the caption of the WinPack icon in the Windows task bar (bottom of 
the screen) changes to show the callsign of the station spotted and its frequency. If you 
select  the Options>Icon on Top menu option, then the program icon will always float 
on top of other programs so you will always be able to see the spots. 
 
If you have a sound card in your PC then WinPack can announce the DX 'spots' as they 
come in. This feature is enabled from the Options>Use Speech.. Announce DX Spots 
menu option. 
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 Enhanced Mail Facilities 
This section describes three facilities that are available with some BBSs. They help to 
make reading  mail and bulletins, sending mail, and collecting the BBS message list 
easier and more efficient. First, I will describe these facilities and then I will describe 
how WinPack handles them. 
 
FBB Unproto List (F6FBB BBSs only) 
 
If an F6FBB BBS has the unproto list facility enabled, then, each time that a new 
message arrives at the BBS, it will send out an unproto transmission giving the 
message headers. The transmission looks like:- 
 
GB7OPC>FBB: 10758  B    928 WINPAC@GBR    G8MZX  951005 Servers? 
 
If your local BBS is sending the unproto list, these beacons are very obvious. Software 
that can use the beacons – such as WinPack -- accumulates them into a message list. 
Therefore it becomes unnecessary to connect to the BBS and use L or LR to update 
your message list. The first software to make use of this facility was F1EBN's brilliant 
TPK program. 
 
If you want to use the FBB unproto message beacons, you must ask your sysop to give 
you U status. On FBB V7, to be able to use compressed download and compressed 
forward, you also need 'F' status. 
 
The idea behind unproto message beacons is that, if users leave their systems on for 
most of the time, they can collect the BBS message list without connecting. Also, in 
theory, it reduces the bandwidth needed for users to collect the message list, because 
one frame provides information for a lot of users. 
 
In practice it doesn't work all that well, because most users don't leave their systems on 
all the time, so their systems miss messages and they get out of synch with the 
beacons. To regain synch, WinPack and other packet programs have a sync 
mechanism  (see next paragraph) whereby users can ask the BBS to transmit all the 
message headers theyu have missed. So someone puts their system on in the evening, 
sends a sync, and the BBS transmits the beacons for a lot of messages. Then someone 
else turns on their system, sends a sync, etc...and we are right back to everyone 
making individual bulletin list requests. 
 
FBB Synchronisation Requests 
A mechanism is available by which your system can tell the BBS that it has missed 
some message beacons. This will happen either because a beacon collided with 
another transmission on the frequency or because you have had your system switched 
off. You can request the BBS to resend all the message beacons starting from a 
particular number by sending out a synchronisation (sync) request. 
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WinPack will automatically send out a sync request whenever it hears a beacon with a 
message number higher than the next number that it expects to hear (it keeps a record 
of the last number that it has received in the LASTNUM.TXT file in the WinPack BULLS 
directory ). There is a degree of sophistication built into this to stop it sending out too 
many sync requests within a short time period. 
 
You can send out a sync request manually by pressing Shift+F5. (Before V6.4, 
WinPack used a script - FBBSYNC.TXT - to send the sync request. This script is 
attached to the F5 key and is still available. However, Shift+F5 is a better option 
because it does not have the overhead of loading a script.) Please Note - WinPack will 
never send a sync request if less than 20 seconds have elapsed since the last one was 
sent. 
 
You may also find it useful to put FBBSYNC as the last line in your STARTUP.TXT. 
This will make sure that your message list starts to be updated as soon as WinPack 
starts up. 
 
Note: In order to be able to send sync requests, your TNC's UNPROTO parameter 
must be set to the BBS callsign. e.g. UNPROTO GB7OPC. The only exception to this is 
if the BBS can't hear you direct, in which case the UNPROTO setting must include a 
suitable digipeater path, e.g. UNPROTO GB7OPC VIA STUMP. This is identical to the 
requirement for TPK. 
 
If you want to use the FBB unproto message beacons. You must ask your sysop to give 
you U status.  
 
Compressed Download 
Some F6FBB BBSs and some G1NNA BBSs allow the user to download messages in 
compressed format. This reduces the usage you make of the channel and can make the 
download process significantly quicker. To read a message in compressed format from 
an F6FBB BBS, the user's software must send something like 'F< 12345' - this would 
tell the BBS to send message number 12345 in compressed format. With a G1NNA 
BBS the protocol is slightly more complicated, but the end result is the same. On FBB 
V7, to be able to use compressed download and compressed forward, you you must 
ask your sysop to give you F status. 
 
Compressed Forward 
You can forward mail to the BBS in compressed format. This should work for any type 
of BBS provided that it supports FBB style compressed forwarding.  
 
WinPack-Specific Issues 
So far I have described what is available from the BBS, the following comments are 
specific to how WinPack uses these facilities. 
 
Obviously WinPack supports the F6FBB unproto list, compressed download and 
compressed forward. (If it didn't, I wouldn't have bothered with this section!  See Mail 
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Options.) In doing so WinPack  behaves very much like TPK, but there are some 
differences:- 
 
1. The Unproto List (and TPK) 
You can use compressed download and compressed forward even if your local BBS 
does not send out the message beacons. (You could do that with TPK, but it required 
the use of an external program to create the message list - such as my MAKELIST 
software). The Mail Options dialogue in WinPack allows you to enable compression, but 
not to select to use the unproto list. This means that the message list will be collected 
using L or LR, but mail will be downloaded and forwarded in compressed format. 
 
If you turn your system off a lot, you may find that it is better not to use the unproto list, 
even if your local BBS sends the beacons. That is because most BBSs impose a limit 
as to how far back they will go with the beacons in response to a sync request. E.g. if 
you start up WinPack and it sends out a sync request for message number 1000 when 
your local BBS has now reached number 1500, it is unlikely that the BBS will go back 
that far. It will probably send a special unproto message to tell your system to reset its 
message number to, say, 1400, so you will never see the message titles between 1000 
and 1400. 
 
2. FBB 'Version 1' protocol 
WinPack supports the 'Version 1' extension to the FBB compressed forward protocol, 
and therefore supports FBB forward resume. That means if you lose the connection to 
your local BBS in the middle of uploading a message, the upload can be restarted from 
the point at which the disconnection occurred. To use this facility your local BBS must 
have Version 1 protocol enabled, some do not. 
 
3. R: Lines 
If you have ever read a message by using v <msg_no> rather than r <msg_no>'then 
you will know that at the top of each message there are lines that contain routing 
information. Sometimes this information is useful - but not often! If the message has 
travelled a long way then it is not unusual for the R: lines to take up a lot more space 
than the actual message! If you use R then the R: lines are squashed into a simple list 
of BBSs through which the message has passed. E.g. !GB7OPC!GB7IOE!GB7ZPU! 
etc. 
 
When compressed download is used, FBB sends all the R: lines. WinPack squashes 
the R: lines very much as if you have read the message on the BBS using  R, except 
that the R: line of the BBS from which the message originated is left intact. I think this is 
the optimum way to process R: lines. 
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External Programs 
WinPack has a list of remote commands, all preceded with / (a forward slash character) 
that are available to users of your system for carrying out functions like downloading 
files, or leaving you a message. 
 
It is possible to add to this list of commands by using external programs. The way it 
works is that if WinPack receives  a command preceded with / that is not on its internal 
list (see remote access), it looks to see if it has an external program available by that 
name. If it does then it will start that program. 
 
An example external program is supplied with WinPack, it is called LOC and it works 
out distances and bearings between locations. A user of your system would send /LOC 
to activate it. 
 
You can also run the external programs yourself from within WinPack. If you aren't 
connected, simply input the command just as a user would. If you are connected, then 
you precede the command with a singled quote character, e.g. '/LOC. (This format can 
also be used when you aren't connected). 
 
External programs live in the EXTERN subdirectory. To create an external program you 
must have some knowledge of programming. However, anyone who has written an FBB 
PG program will find it very easy to write a WinPack external program. 
 
Anyone who is interested in exploring the possibilities of external programs should unzip 
the file EXTERN.ZIP on the installation disk, and have a look at the example program 
called DEMO. It is written in VB, but FRMEXT.FRM can be viewed in a text editor, and 
the comments at the top of the ExternAction subroutine explain how to write a WinPack 
external program. Of course, if you want to write program using VB then you can use 
DEMO as a starting point. 
 
What can external programs do? Well, a CD-ROM callbook access external program is 
an obvious idea, or some sort of information database, or how about a noughts and 
crosses game? Or even an adventure game? 
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Network Use of WinPack 
From V6.43 onwards, WinPack has some support for running on a network. This 
support is really limited to the situation where a user wants to run WinPack on one PC, 
and be able to read and write messages from another PC. An increasing number of 
users seem to want to do this. It would not work well in a multi-user situation, because 
of file locking preventing more than one user accessing some of the files at the same 
time. 
 
Please note that the network support is fairly experimental and I haven't yet used it very 
much myself. 
 
Setting It Up 
(This assumes that you have got two PCs, both running Win31 or later. WinPack is 
installed on the "WinPack" PC, the other one is the "remote" PC.) 
 
1. The drive with WinPack on it must be shared on the network with full access rights 
available to the remote PC. 
 
2. Map this drive as a network drive on the remote PC. 
 
3. Check to see if the following files are in the Windows SYSTEM directory on the 
remote PC. If they aren’t copy them from the Windows SYSTEM directory on the 
WinPack PC. 
 

VBRUN300.DLL 
CTL3DV2.DLL 
THREED.VBX 
CMDIALOG.VBX 
MSCOMM.VBX 
MCI.VBX 
 

4. Set up a shortcut or a program group icon on the remote PC to the file PACKET.EXE 
in the WINPACK directory on the WinPack PC. To the end of the command line add  
/remote. For example, if the drive on the WinPack PC is mapped as drive E: on the 
remote PC, then the command line would be "E:\winpack\packet.exe /remote". 
 
5. Run WinPack from the remote PC. It should say Remote Network System on the 
title bar, and some of the menu options, particularly on the Action menu, should be 
disabled. You should now be able to read and write mail and read bulletins. 
 
Restrictions when Using a Network 
1. You can only read bulletins on one PC at a time. 
 
2. You can't read bulletins on either PC whilst the WinPack PC is running an Auto BBS 
session. 
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3. You can't write mail on the remote PC whilst the WinPack PC is running an Auto BBS 
session. 
 
4. The tracking of new personal messages and outgoing mail, as shown by the icons in 
the top right corner of the screen is not instantaneous. See below. 
 
5. You can get in a bit of a mess with viewers, unless you can arrange them so that the 
drive letters on the two PCs match. For example, if you have a viewer set up as 
C:\VIEWERDIR\VIEWER.EXE on the WinPack PC, then C:\VIEWERDIR\VIEWER.EXE 
must also exist on the remote PC, or you will get an error message that WinPack can't 
find the viewer. (This isn't a problem if you don't use viewers!) 
 
Tracking Mail 
The remote PC will not immediately display changes to the number of new messages or 
the number of messages waiting in the outgoing mailbox. It only updates the displayed 
status when it rescans the MAIL\SEND and MAIL\RECEIVE directories. The default is 
that it does this every 5 minutes, but you can change the frequency by changing the 
RECOUNT_INTERVAL value in the [MAIL] section of PACKET.INI. 
 
The WinPack PC will also not track changes that are made as a result of reading/writing 
mail on the remote PC. The status is only updated when you read mail or when an Auto 
BBS session is due. If you want the WinPack PC to also periodically scan the mail 
directories, then edit PACKET.INI and change the RECOUNT_MAIL setting to TRUE. 
 
Note that rescanning the mail can cause the PC to "freeze" for several seconds if you 
tend to keep a lot of mail in the list after you have read it. 
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Password Support 
Menu bar: Options> Password 
 
Some BBSs only allow their users full access if they supply a password. This normally 
works on the basis that the user sends some sort of trigger (e.g. '@' with NNA style 
passwords) the BBS then sends something back, often a string of numbers, and the 
user has to give the correct response. 
 
WinPack has internal support for F6FBB sysop style passwords, G1NNA style 
passwords and MD2 passwords. Other types of password are supported by external 
servers. Servers for virtually all BBS password systems are available. A bulletin to 
WINPAC, saying what sort of password system your BBS uses is the best way to get 
information. 
 
To automatically send an FBB or NNA password, you have to tell WinPack the style of 
password being used, provide a suitable BBS.TXT script file, and provide a text file 
containing the required user password information. 

F6FBB Sysop Style Passwords 
 
1. Select F6FBB on the Options>'Password submenu. 
 
2. Use the script file SCRIPTS.TXT as a guide for your BBS.TXT script file. 
 
3. Put your password matrix in the file WINPACK_FBB.TXT - an example file is 
provided. Please note that you may need to remove the row and column headings from 
your matrix as supplied by your BBS sysop. If the 'matrix' as supplied by your sysop is a 
single row of characters you can leave it like that. It doesn't have to be 8 rows of 10 
characters. 

G1NNA Style Passwords 
 
1. Select G1NNA on the Options>'Password submenu. 
 
2. Use the script file SCRIPTS.TXT as a guide for your BBS.TXT script file. 
 
3. Put your password matrix in the file WINPACK_NNA.TXT - an example file is 
provided. Please note that you may need to remove the row and column headings from 
your matrix as supplied by your BBS sysop. 
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MD2 Passwords 
1. The WinPack installation disks will put MD2PASS.EXE, MD2PASS.CFG and 
G4IDEMD2.DLL in WinPack’s \SCRIPTS\PROGRAMS directory. 
 
2. Edit MD2PASS.CFG and put in it your MD2 password string and some text from the 
prompt the BBS sends when it asks you for the password. This text must be text from 
the line that actually contains the password challenge. My example should make it 
obvious what to do. 
 
3. Edit the BBS.TXT script file. Exactly what it needs to contain depends on your 
connection path to the BBS, but it wants to be something like this:- 
 

SEND C $BBS 
WAITCON 
RUN MD2PASS 
WAITPROMPT 

 
If you usually get a very fast connect to the BBS, you may not need 
the WAITCON. 
 
4. Give it a try by using the F2 key in WinPack. You should see "RUNNING MD2PASS" 
appear in the Script status window, and, when the BBS sends the password challenge, 
it should send back the correct response to the BBS. If it doesn't send a response at all, 
check the prompt line in MD2PASS.CFG. If it sends the wrong response, then the 
password string you have put in MD2PASS.CFG is probably not the same as the one 
you have registered with the BBS. 
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Pause the Receive Windows 
 
Normally, WinPack’s receive window(s)  will automatically scroll as new data is received 
and the latest data is always visible. This can be a nuisance if you are trying to scroll 
back to view something that has gone off the screen -- any new data will make the 
screen scroll down again! 

If you press the Pause Button , then the automatic scrolling is disabled, and you 
can now scroll back and view previous data. Don't leave pause on for too long, because 
while it is enabled all new data that is received is put into a buffer, which can only hold 
about 30,000 characters. 
 

Automatic Receive Window Pause 
 
An automatic pause feature is also available. It works by triggering a timed pause 
whenever you scroll the active receive window backward. At the end of the specified 
time period (usually set to around 15 seconds) the pause is disabled. It can also be 
disabled by clicking the pause button. 
 
By default this feature is disabled. To enable it, proceed as follows:- 
 

1. Make sure WinPack is not running.  
2. Edit PACKET.INI in the WinPack directory using Windows Notepad or similar 

text editor.  
3. Look for a section titled [TERMINAL]. In that section there is a line that says 

PAUSE_SECONDS=0.  
4. Change the 0 to give an automatic delay of how ever many seconds you require.  
5. Save the file. 

 
If at any time you want to disable the feature then change the setting back to 0. 
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Phone Modem Support 
If you add the option /MODEM to the WinPack command line when you start WinPack, 
then WinPack will run in a mode designed for use with a telephone modem on the land-
line port of an FBB BBS. If you want to sometimes use WinPack with a TNC and 
sometimes with a telephone modem, then I would suggest creating two icons for the the 
program - one with the /MODEM option command line and one without it. 
 
In modem mode,  the caption bar will include the text (Modem) and several things 
internal to the program will work differently. Do not try to use either compressed forward 
or compressed download in modem mode, and, of course, you can't use the FBB 
beacons! 
 
From V6.4, the Comms Setup you use in modem mode is saved independently of the 
Comms Setup you use with a TNC, so you don't have to keep changing it if you 
sometimes use a modem and sometimes use a TNC. 
 
To the best of my knowledge, an FBB BBS, when used via the modem port, normally 
requires a password. Here is a sample BBS.TXT file for modem use  - the phone 
number is fictitious, so don't try to use it! 
 

HOTKEY F2 
TITLE Connect to the local BBS 
;Send some modem initialisation stuff if needed. 
;Probably best to at least send an ATZ, so you 
;get the OK back and you then know the modem 
;is responding. 
send AT&F&D3&R0S7=40 
waitline OK 
;Dial the number. 
send ATDT01205654321 
;Wait for the login prompt. 
waitfor Callsign : 
send G8MZX 
waitfor Password : 
send QKVRTX 
;Wait for the BBS prompt. I found that it was 
;better to put in the actual text than to use 
;the WinPack WAITPROMPT option. I'm not sure why, 
;and, after many phone calls trying to find out 
;why, I gave up on it! 
waitfor GB7OAR Next Roger 
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Remote Access 
If someone connects to your system, then there are a few remote options available. To 
let others know about them, put something in your TNC’s CTEXT message that 
contains something like  /HELP to get help .The remote options are all case 
insensitive. All  commands can be abbreviated to a minimum of / and one letter, e.g. 
/help, /hel, /he and /h are all valid. 
 
/BYE -  disconnect. When someone disconnects from your system, WinPack 

sends them the message in BYE.TXT. in your WinPack directory, if it 
exists.This file can contain WinPack tokens - see the tokens list. Also, you 
can have more than one option for this file. You must have BYE.TXT, but 
you can also have BYE1.TXT, BYE2.TXT... up to BYE9.TXT.. If you have 
more than one version available, WinPack will pick at random which one it 
uses. This adds a bit of variety to what a user sees when he connects to 
your system. 

/HELP -  sends the file USERHELP.TXT in your WinPack directory 
/MSG -  to leave a message in your Read Mail Inbox. 
/DIR -   list the files in your WINPACK\PUB directory. 
/CD  -   change directory. 
/YGET <filename>  - download <filename> using YAPP, where <filename> is replace 

with the exact name of the file. 
/GET <filename>   - download <filename>   in ASCII , where <filename> is replace 

with the exact name of the file. 
/TALK -  alert you that the user wants to talk. When someone connects to your 

system and sends the /TALK command, WinPack sends them the 
message in the file TALK.TXT, which is in your main WinPack directory. 
This files can contain WinPack tokens - see the tokens list.  You can  also 
have more than one option for the file. You must have TALK.TXT,  but 
you can also have TALK1.TXT, TALK2. TXT... up to TALK9.TXT. If you 
have more than one version available, WinPack will pick at random which 
one it uses. This adds a bit of variety to what a user sees when he 
connects to your system. 

 
Note: There is no “upload” command. To upload a file to you , they simply send it using 
YAPP. As long as you have Auto Receive checked on the YAPP menu, the program 
detects they are sending a file and stores it in the WINPACK DOWNLOAD directory. 
[Shouldn't DOWNLOAD be UPLOAD? No. The DOWNLOAD directory is primarily 
where you put files that you download from a BBS, i.e. files that you receive. So if you 
receive a file from someone, it goes in the DOWNLOAD directory. Clear as mud, right? 
 
All the above commands are internal remote commands. WinPack also allows the list of 
remote commands to be extended by the use of external programs. These work very 
much like FBB PG programs. See WinPack External Programs. 
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Servers 
WinPack supports servers. These are programs that can process an incoming message 
and send information to the sender of the message, without the WinPack sysop having 
to do anything. 
 
A full discussion of how the servers work, is beyond the scope of this manula or the on-
line help. However, the following explanation should help you understand them from the 
point of view of a user. 
 
WinPack checks the title of every incoming personal message. If the title starts with a '/' 
then it checks to see if there is a program in its SERVERS directory with that name. For 
example, if the message title is /REQCFG,  then it looks for a program called 
REQCFG.EXE . If it exists then the program is started and allowed to process the 
message. 
 
Three servers are supplied with WinPack, they are REQCFG, REQDIR and REQFIL. If 
you want to find out what they can do, send yourself a message via your local BBS 
entitled /REQCFG . The reply to that message will explain the use of the servers. 
 
For example, the REQFIL server responds to REQFIL (request for file) messages sent 
to your system. For example, if someone sends you a personal message entitled 
/REQFIL AFILE.TXT, then WinPack will send them the file AFILE.TXT (assuming it 
exists on your system). The REQFIL server will send files as either plain text or 7plus, 
according to whether or not they contain binary data. 
 
The "root" directory for REQFIL is the directory specified by the PUB_DIR entry in the 
[TERMINAL] section of PACKET.INI. The default is WinPack\PUB. You may make 
subdirectories in the main PUB directory, and people can obtain files from 
subdirectories with requests like /REQFIL SUBDIR\FILE1.TXT. 
 
To allow people to easily request images for HTML documents that you might send out, 
REQFIL will also look in the HTMLIB directory. Example:- 
 

You send out an HTML document which uses WINPACK.GIF in your HTMLIB 
directory. Someone reads the document, but they haven't got WINPACK.GIF, so 
they send you a message entitled /REQFIL WINPACK.GIF. WinPack can't find the 
file in your PUB directory, so it looks for it and finds it in the HTMLIB directory. 

 
The file SERVERS.ZIP contains the Visual BASIC source code for one server. That 
should form a good base for anyone who wants to write WinPack servers. 
 
Besides servers that respond to a special request, there are also several other types of 
servers:- 
 

• Servers that process all the incoming personal messages. These are placed in 
the SERVERS\RECEIVE directory. One server of this type is supplied with 
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WinPack, it is ACK. It scans every personal message for lines starting with /QSL 
and, optionally, /ACK. If it finds one then it sends an acknowledgement message 
to the sender of the incoming message. It is configurable - see the file 
SERVERS\RECEIVE\ACK.INI. 

 
• Servers that process all outgoing mail. These are placed in the SERVERS\SEND 

directory. One server of this type is supplied with WinPack, it is BACKUP. It 
makes a backup copy of all your outgoing mail in the ARCHIVE subdirectory. So, 
if you don't want a backup of all your outgoing mail, you must delete the file 
SERVERS\SEND\BACKUP.EXE. 

 
• Servers that process all the incoming bulls. They are placed in the 

SERVERS\BULLS directory. No servers of this type are supplied with WinPack, 
but a server for checking PGP signatures in incoming bulls has been written and 
is available on request. However, it is useless unless you have the PGP 
program, which I cannot supply. You also need to understand the general 
principles of how PGP works. 

 
• Servers that are run immediately before bulletins are downloaded during Auto 

BBS sessions. They are placed in the SERVERS\PREBULL directory. These 
servers take no command line arguments, and the idea is that they can do tasks 
such as processing the message list. 

 
• Servers thart are run at the end of  Auto BBS sessions. They are placed in the 

SERVERS\POSTAUTO directory. These servers take no command line 
arguments, and the idea is that they can do tasks that need to be closely tied to 
Auto BBS sessions. 
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Short Cut Keys 
WinPack lets you set up frequently used strings of text so that you can key them in to 
the transmit window or the Edit Window with a single key stroke. 
 
The keys that can be used to "hold" the text are Ctrl+F1 to Ctrl+F9. Note that Scripts 
run from the F1 thru F9 keys, ie. without the Ctrl key.) 
 
To setup the text you must edit PACKET.INI and create entries in a section entitled 
[SHORTCUTS]. You will need to create the section, by default it doesn't exist. 
 
The maximum length for a shortcut is 500 characters. 
 
You can use tokens in shortcuts, see the tokens list for information on what tokens are 
available. 
 
Some example entries:- 

F1=This is some text^M 
F2=c gb7ide^Mll 10^Mb^M 

 
An example using tokens:- 

F4=De $MYCALL $HH:$NN >>^M 
 
(The ^M in the above examples is replaced with a <Enter>.) 
  
To send the text, you must make sure the cursor is in the transmit window or the Edit 
Window, then press Ctrl and the appropriate function key. 
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Signature Options 
Menu bar: Options>Signature Setup 
 
WinPack allows you to add signatures to messages that you write. It supports multiple 
signature files. These files have an extension of .SIG and live in the main WINPACK 
directory. One signature file is supplied with the program, which is called 
WINPACK.SIG, but you can easily create others yourself. 
 
The signature files can contain tokens from the tokens list, you can look at 
WINPACK.SIG for an example of how the tokens can be used. 
 
WinPack always regards one signature file as its default signature. If you have Auto 
Signature enabled, this default signature is automatically added to any mail messages 
that you write. You can change which signature file is regarded as the default by using 
Options>Signature Setup>Default Signature 
 
If you don't enable Auto Signature, you can add a signature to a message by using 
either the signature button or by using the Signature menu option. (This menu option is 
available both on the top level Options menu and on the Edit Window pop-up menu). 
 
If you use the signature button, the default signature is automatically used. If you use 
the Signature menu option, you can choose from a list of available signatures. Right 
clicking with the mouse on the signature button gives a short cut to the Signature menu. 
 
Please note that, if you create new signature files, you must restart WinPack for these 
to become available on the signature list. This is because the list is loaded when the 
program starts. 
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Speech 
Menu bar: Options> Speech 
 
WinPack can use your sound card to announce various events. It can announce 
connections and disconnections, the arrival of new mail, the callsign and frequency of 
'spots' when you are connected to a DX cluster, and it will tell you when someone is 
calling you with the /talk  remote command 
 
When you connect to a station, the announcement is made up from the file CONN.WAV 
(which says "connected to") and the WAV files for the individual characters in the 
callsign. You can, if you wish, create your own WAV files for particular stations. For 
instance, if you create GB7OPC.WAV and put it in the WinPack \WAV directory, then 
everytime you connect to GB7OPC this file will be used. This allows you to get a more 
natural announcement for stations to which you frequently connect. 
 
If you create your own WAV files, they must be 8 bit, mono, 11kHz sampling rate. 
 
WinPack will also play MIDI files. If there isn't a .WAV file with the name for which it is 
searching, then it will look for a .MID file.  
 

For Win 3.0: 
For these options to work you must have a sound card fitted and an MCI Sound driver 
installed. If you have problems then check in Control Panel, Drivers and see if it lists 
[MCI] Sound. If it doesn't then select "Add..." and see if an MCI Sound driver is 
available on your system. 
 
If you try to enable these options and have a sound card fitted, but get lots of messages 
about MCI.VBX not being loaded and MMSYSTEM.DLL not being found, then your PC 
does not have multimedia extensions - probably because you are running Windows 3.0. 
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Spell Checker 
 
WinPack has support for two spelling checkers; 
 
1. Spell Checker for Edit Boxes, written by Brian Quinion, is free for private use. This 
isn't supplied on the WinPack disk, it is too big, but it is available on the internet from: 
 
http://clever.net/quinion/mqa/spell.htm  
 
The two files you need are SPEL302E.ZIP and UKENG.ZIP (UKENG.ZIP is the 
dictionary, there are also dictionaries available for other languages). 
 
Unzip these files into the WinPack directory and you will find that, when you are in the 
Edit Window, pressing Alt+F9 brings up the spell checker. If you want to add your own 
words to the dictionary you must first create a default dictionary. To do this you input 
some text in the Edit Window,, which should contain at least one incorrectly spelt word, 
then press Alt+F9. The spell checker will pop-up and you can use Options>Add to 
create a dictionary. I would suggest calling it DEFAULT.DIC. 
 
This spelling checker can be installed into Windows so that it is a resident application 
and is available to check the spelling in any edit box. If you want to do this, please read 
the README.1ST file that comes with it. I cannot support this program. 
 
(Please Do Not approach Quinion Associates to register WinPack! 
For some reason this has happened occasionally in the past). 
 
 
2. Microsoft Word’s Spell Checker - If you have Microsoft Word installed on your PC, 
then pressing Alt+F7 will allow you to check the spelling of the text in the window.  
 
Please Note - to use this feature, you must have Windows OLE2 installed on your PC. 
If you are using Win95 or higher, then OLE2 will already be installed. If you are using 
Win3.1, then it may not be installed. If OLE2.DLL is present in the Windows SYSTEM 
directory, then it probably is. The following URL gives information about downloading 
and installing OLE2 for Win3.1: 
http://support.microsoft.com/support/kb/articles/Q123/0/87.ASP  
  

http://clever.net/quinion/mqa/spell.htm
http://support.microsoft.com/support/kb/articles/Q123/0/87.ASP
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Text Links 
Text Links are an advanced and somewhat experimental feature. Links can be inserted 
into messages by using the Text Links Editor(below) 
 
What are Text Links? 
Text links are special text in a bulletin or personal message, surrounded with <  >. 
 
Use of Text Links 
Double-clicking anywhere within a link causes a responding message to be 
automatically put in the WinPack outgoing mail box. The main idea of links is to make it 
easy to send REQFIL messages and messages to other types of servers. For example I 
might put in a bull:- 
 

If you want more information on how links work in WinPack, here is the 
information to request a links FAQ file <TO="G8MZX@GB7SKG" 
TITLE="/REQFIL WINPLINK.TXT">. 
 

That information can obviously be used by anyone, but people using WinPack from this 
version onwards can simply double click on the link to automatically send a message - 
and they know that the REQFIL information will be exactly as the sender of the original 
message specified. 
 
Rules For Text Links 
Links are surrounded by <  > and have a format like:- <TO="G4IDE@GB7OAR" 
TITLE="A test message" CONTENT="Some text"> All links must have the TO and 
TITLE fields. CONTENT is optional. If no content is specified, then the message will 
include just a blank line. All field text must be surrounded with string quotes ("  ") or with 
single quotes ('  '). However, field text in AX25MAIL protocol links in HTML messages 
must be surrounded by string quotes - see below. Links can be split over more than one 
line. Control characters can be put in the CONTENT field of links - e.g. the two 
characters "^M" will be translated to control 'M' (carriage return) when the link is 
interpreted by WinPack. The maximum length for a link is 250 characters. 
 
Compatiblity with the WinPack AX25MAIL protocol 
 
If you use Netscape as your viewer for HTML files, WinPack supports a special protocol 
type called AX25MAIL which is designed to make it easy to reply to the sender of the 
document. 
 
If the sender puts in a link of the form: 
 

<A HREF="ax25mail:g8mzx@gb7skg.#15.gbr.eu">Mail To Roger</A> 
 
in their message, you can click on the link and WinPack will behave as if you have 
clicked the Reply To Sender button. A message header form will be filled in with the 
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address as specified in the link and with a message title based on the title of the 
sender's message. 
 
It is also possible to use the AX25MAIL protocol type to automatically submit a reply to 
a form included in an HTML document. If the sender makes the FORM tag something 
like:  
 

<FORM Name="A Test" Action="ax25mail:g8mzx@gb7skg.!15.gbr.eu"> 
 
then clicking the Submit button on the form causes a message to be generated 
containing the information you have put in the form. It will be addressed as per the 
Action field of the FORM tag. Don't worry, you can look at the message, so there's no 
way it is going to disclose your darkest secrets! 
 
In addition, starting with Version 6.35, links that are compatible with WinPack style text 
links can now be put in an AX25MAIL link. For example, clicking on the following HTML 
link  
 

<A HREF="ax25mail: To='g8mzx@gb7skg.!15.gbr.eu' Title='/REQFIL 
FILE1.TXT' Content='/REQFIL FILE2.TXT'">Mail To Roger</A> 

 
would automatically send a message to G8MZX. The title of the message will be 
"/REQFIL FILE1.TXT" and the message content will be "/REQFIL FILE2.TXT". Please 
note that the format of the HTML and text links means that this link will work if it is 
clicked in your HTML viewer, or if it is double clicked when reading the text message in 
WinPack. This is a special format of the AX25MAIL protocol and the previous formats 
are still supported. 
 
Please Note -  
1. The AX25MAIL protocol only works with Netscape when used as a viewer for 
messages read in WinPack. It doesn't work with pages downloaded using WinpScape in 
Telnet mode.  
 
2. The text submitted from a form is in raw format. It is not encoded and is perfectly 
readable, but hardly "user friendly". There is little point sending out a form unless you 
are able to process the replies. The use of forms should definitely be regarded as 
experimental. 
 
3. Netscape does not like # characters in a form “Action” field. You will see that in the 
above example I have used a !. WinPack will translate this. The alternative would be to 
omit the full hierarchical address and simply put "g8mzx@gb7skg". 
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 Text Links Editor  
.This editor allows you to insert links into messages you write in WinPack - see Text 
Links (above) for more information about how they are used. The editor helps you to get 
the format of the link correct 
 
You must remember, when creating a link, that the link will be used by another WinPack 
user, who is reading your message, to automatically send a message from his system. 
It is therefore important that you set up links correctly. 
 
TO= 
Put the callsign of the person or system to whom the message will be sent. 
 
AT= 
In this box you put the BBS of the person to whom the message will be sent. 
 
TITLE= 
In this box you put the title of the message that will be sent. 
 
CONTENT= 
Here you put any required content for the message. You can include WinPack tokens, 
seeing as the person using the link is bound to be a WinPack user, because no other 
sofware supports Text Links. 
 
Please note that for the most common use that I envisage for Text Links - sending 
REQFIL requests - no content is needed. 
 
EXAMPLE 
I want to put a text link in a bulletin which will allow other WinPack users to 
automatically REQFIL AFILE.TXT from my WinPack system. Therefore, in the Text 
Link Editor, I put:- 

"TO=" G4IDE 
"AT=" GB7OAR 
"TITLE=" /REQFIL AFILE.TXT 

 
No content is needed. 
 
When I click Ok, the following text is inserted into the bulletin:- 

<TO=G4IDE@GB7OAR" TITLE="/REQFIL AFILE.TXT"> 
 
Another user of WinPack V6.4 or later, when reading my bulletin, can simply double-
click on the link and automatically send the REQFIL. 
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Viewers 
 
The concept of viewers is something new to AX25 packet radio. Please read the 
following carefully. If you don't understand what viewers do, you will find it very difficult 
to set them up! 
 
What are Viewers? 
Viewers allow you to "view" the contents of messages that contain other than plain text. 
They allow you to do it automatically without having to manually start another 
application. 
 
"Viewing" means to look at the contents of a file. Normally, if you receive a 7plus file 
which contains, say, a zipped JPG image,  to look at the image you must first unzip the 
file, then you must run another program to actually look at the image. If you have 
configured a viewer for JPG files in WinPack, then, when you read the SYSTEM 
message telling you that the file has been received, you will be offered the opportunity 
of viewing it. You won't need to unzip it and the viewer application will be started by 
WinPack. 
 
Viewers can be configured for any file type for which you have a suitable program 
available, not just for image files. For example, you can set up viewers for WAV files, 
MIDI files or HTML files. 
 
Viewers  work in two ways:- 
 
1. They allow an incoming non-7plus SB or SP to be viewed by an external application. 
 
2. They allow the contents of decoded 7plus files to be viewed by an external 
application. 
 

Viewing non-7plus SBs and SPs 
This requires the sender of the message to include information about its contents in the 
title, therefore it requires something which currently does not happen! Hopefully it will, 
once this feature of WinPack is in general use. Because SBs and SPs are plain text, 
there isn't much you can put in them that benefits from being viewed with an external 
program, except for HTML - which is plain text! Here's an example of how it works:- 
 
I send an SB to WINPAC at GBR entitled "Something from Roger ^.htm". Someone 
using the new version of WinPack reads it and his system recognises the "^.htm" as 
being an indicator of file type. His system checks to see if he has a viewer configured 
for files with the extension ".HTM", if he has, then WinPack asks if he wants to view the 
file using the external program. You therefore have a facility for sending and receiving 
messages which can be made far more readable than if they are viewed as boring plain 
text. (To send HTML you do, of course, need an HTML editor!) 
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Viewing decoded 7plus files 
When WinPack successfully decodes a 7plus file, it sends you a SYSTEM message. 
When you read that message, WinPack will check to see if you have a viewer 
configured for the file type, if you have, then it will ask you if you want to view the 
decoded file. A lot of 7plus is, of course, zipped up. If WinPack finds a zip it will look in it 
and see if there is a viewable file. One restriction is that you can only view one file in 
each zip - otherwise it would become unmanageable. However, the vast majority of 
7plus zips only contain one file. The file offered for viewing is the first one in the zip for 
which a viewer is configured. This has implications for viewing HTML - see Complex 
HTML 

Configuring PKUNZIP.PIF 
To be able to unzip 7plus files and allow you to view the contents, WinPack has to be 
able to run PKUNZIP.EXE and it does this by using PKUNZIP.PIF. The PIF file 
assumes that PKUNZIP.EXE is in a directory in your DOS PATH. If it isn't, then you 
must either put it in a directory that is in your PATH, or edit the PATH environment to 
include the directory where PKUNZIP.EXE lives. 
 
Please check the above carefully - an awful lot of people seem to have had problems 
setting up the PKZIP.PIF supplied with WinPack! 
 
I have only tested it with PKUNZIP 2.04g. I've no idea if it works with earlier versions or 
with other unzippers. 

Configuring viewers 
To be able to view files, you need to tell WinPack what viewers to use for each file type. 
This is done by creating a section in PACKET.INI called [VIEWERS] and putting in it the 
information about the programs you wish to use as viewers. 
 
The format of each line is <file type extension>=<path to viewer> . There is one 
important exception:- 
 

If a WWW browser is used as a viewer, it can take an awful long time to load. 
Netscape allows you to pass files to the program whilst it is running by using a DDE 
link, so avoiding having to keep reloading it. Internet Explorer *V.3 is compatible 
with this feature of Netscape. If you use a browser that is compatible, you can put 
NDDE at the end of its line, to tell WinPack to use Netscape style DDE. Please note 
- my own tests suggest that Internet Explorer V.2 is not compatible. If you want to 
take advantage of DDE, don't close your browser after you have viewed a file; 
minimise it instead. 

 
A WinPack add-on program ("extra") is provided to make configuring viewers easier. It 
appears on the WinPack File menu as Viewers Editor.  (Remember you can  press F1 
to read the help.) 
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My viewers under Windows 3.11:- 
 

[VIEWERS] 
htm=c:\netscape\netscape.exe 

wav=c:\windows\recorder.exe 

mid=c:\windows\mplayer.exe 

bmp=c:\windows\pbrush.exe 

pcx=c:\windows\pbrush.exe 

jpg=c:\netscape\netscape.exe 

gif=c:\netscape\netscape.exe 

txt=c:\windows\notepad.exe 

doc=c:\winword\winword.exe 
 
My viewers under Windows 95:- 
 

[VIEWERS] 
htm=c:\progra~1\micros~2\iexplore.exe ndde 
wav=c:\windows\sndrec32.exe 
mid=c:\windows\mplayer.exe 
bmp=c:\progra~1\access~1\mspaint.exe 
pcx=c:\progra~1\access~1\mspaint.exe 
jpg=c:\progra~1\micros~2\iexplore.exe ndde 
gif=c:\progra~1\micros~2\iexplore.exe ndde 
txt=c:\progra~1\access~1\wordpad.exe 
doc=c:\progra~1\access~1\wordpad.exe 

 
Note - the directory names have to be the short, DOS compatible names. 

The SPK Viewer 
If you set up a viewer for SPK files, then this viewer has a special function. It is intended 
that a SPK viewer should be intended for speaking messages. (A sample SPK viewer 
which works with the SoundBlaster Texto’LE utility is supplied with WinPack). Not only 
will the SPK viewer work with messages with ^.SPK in the title, it will also work with any 
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message. If you press Ctrl+T ('T' for talk) whilst reading a message, then the SPK 
viewer will be called, even if the message title doesn't include the "^.SPK" indicator. 
See the SPKVW10.ZIP file in the main WinPack directory. 
 
The UIV Viewer 
If you set up a viewer for UIV files, then this viewer has a special function. It is intended 
that either UI-View or UI-View32 is used as the viewer program for UIV files. UI-
View(32) will regard the message as being either a log file or a Station List snapshot, 
depending on the structure of the message. If the viewer program is already running, 
WinPack will pass the message to the viewer using DDE, so a new copy of the program 
isn't started each time. If you press Ctrl+U whilst reading a message, then the UIV 
viewer will be called, even if the message title doesn't include the "^.UIV" indicator. 
 
 

Enabling "Use Viewers" 
Make sure that Options>Use Viewers menu option is checked. It should now all work! 
 

Complex HTML 
If you want to send an HTML document containing images or sound, then you should be 
careful as to the order in which you zip the files. The main HTML document should be 
the first file in the zip, so that will be the file which  WinPack offers for viewing. If you do 
this, then provided that all references to other documents, images, etc, are local to the 
main document, you should find that it can all be viewed successfully. On the other 
hand, if you build the zip and put, say, a GIF image as the first file, then WinPack will 
offer that file for viewing, not the HTML file. 
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Weather Beacons 
 
The following is also contained in the WINPWX.TXT file in the WinPack  \DOCS 
directory: 
 
This explanation assumes you have some knowledge of APRS. If you don't, then this 
file is probably of no interest. Please don't ask me to give an explanation of APRS - it's 
far too big a subject, and a vast amount of information is available from other sources. 
 
WinPack can send APRS style weather (WX) beacons provided:- 

1. You are using WinPack in a host mode. 
2. You have some other software that can create a file containing the beacon 

information at regular intervals, something like:  C:\Wxprog\Wxreport.Txt 

How WX Beacons Work 
Here is the format of the file your WX software needs to create: 
 

Aug 17 1998 19:47 
272/000g006t069P000b10150h61 

 
The first line is the time the file was created, the second line is the WX report. The 
format of the report is up to you/your software. WinPack will append the report to your 
normal BTEXT, and it will assume that your BTEXT is in the format of an APRS location 
report. Here's an example:- 
 
I run BPQ. My BTEXT entry in the [BPQ] section of PACKET.INI is: 
 

BTEXT=!5258.23N/00002.77W-Boston 
 
WinPack will remove the -Boston and replace it with  _  plus the WX report from the 
file. So with the above example file, the beacon that would be sent is - 
 

!5258.23N/00002.77W_272/000g006t069P000b0150h61 
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Telling WinPack Where The WX File Is 
You need to tell WinPack where to find the WX report file. To do this you must edit 
PACKET.INI (when WinPack is not running!) and create a new section called [WX]. In 
this section you must make a FILE_NAME entry. e.g. - 
 

[WX] 
FILE_NAME=C:\Wxprog\Wxreport.Txt 

 
This PACKET.INI entry is the trigger for WinPack to try and send WX report beacons, 
without this entry WinPack behaves as normal. 
 

WinPack Ignores Old WX Reports 
 
If the report in the file is older than a certain number of minutes, then WinPack won't 
send the report, instead it will send the unaltered BTEXT. The default maximum age is 
5 minutes, but this can be altered by editing the MAX_AGE_MINUTES in the [WX] 
section of PACKET.INI. Please Note - the MAX_AGE_MINUTES entry will be created 
by WinPack provided that you have first created the [WX] section and put in the 
FILE_NAME entry. 
 



 

11. Add-On Programs 

What Are "Add -ons"? 
 
"Add-ons” (originally called “Extras") are programs that can be added to the WinPack 
File menu, but are not actually part of WinPack. Virtually any program can be used, but 
it obviously makes sense if it is in some way related to WinPack! 
 

 
A newly installed WinPack system should show five "Add-on" 
options at the bottom of the File menu: 
 
This section of the manual provides information about  
 
 

 
Creating an .XTR file to associate the Add-on to WinPack 
 
And 5 add-on programs: 
 
Start Alarms – alerts you to the arrival of selected packets 
SelectionList Editor – prescribes messages to be downloaded in an Auto BBS session 
Themes Editor – creates multi-criteria filters for reading bulletins listings 
Viewers Editor – associates downloaded file types with a viewing program 
WinpScape -- monitors all text received by WinPack, looking for HTML documents (web 
pages), which automatically display using your web browser  
 
Many authors have created other useful Add-ons for WinPack. 
 
Some of Mike’s, G0OPC add-ons can be found at the WinPack site: 
http://www.ui-view.com/winpack/g0opc/g0opc.htm 
 
Another interesting site is Ken’s GW3TMH: 
http://www.gb7abc.freeserve.co.uk/ 
 
Virgilio’s, HP2VX site is one of the most extensive: 
 http://www.qsl.net/hp2vx/page2.html 
 
Doing a web search on “WinPack” and “Add” or “Server” or similar keywords should 
produce still more. 
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Creating an .XTR file for an Add on 
 
Each “Add-on" has a small file that is read each time WinPack is started. These files 
have an extension of .XTR, they must be in the main WINPACK directory. The format of 
a .XTR file is as follows:- 
 
The file can contain from two to five lines. As the lines are read they are checked for 
any valid tokens from the tokens list. Any that are found are substituted. This is mainly 
of use for specifying a program path - see the comment below. 
 
Line 1 is the caption for the File menu - if you don't want the “Add-on" to appear on the 
menu, leave this line blank. 
 
Line 2 is the path name for the “Add-on" program. You can specify a full path, or a path 
relative to the main WinPack directory using the $WINP_PATH token. To do the latter, 
you must put a path such as:- 
 

$WINP_PATH\THINGDIR\MYTHING.EXE 
 
WinPack will automatically replace $WINP_PATH with its main directory path. If 
WinPack is in D: then the above example would become:- 
 

D:\WINPACK\THINGDIR\MYTHING.EXE 
 
Line 3 is either True or False according to whether you want the “Add-on” to be 
automatically started when WinPack starts. The default is False. 
 
Line 4 is either True or False according to whether you want the “Add-on” to be 
terminated when WinPack is closed down. The default is False. 
 
Line 5 (optional -- new from V6.4) specifies the name of a picture file to use on a button 
that will be added  to the button bar for starting the “Add-on”. Example:- 
 

BUTTON=$WINP_PATH\ICONS\MYTHING.ICO 
 
This will add a button and use an icon for it called MYTHING.ICO in your WinPack 
ICONS directory. Line 1 in the XTR file is used as the tooltip for the button. The picture 
file can be either an icon file (file extension .ICO) or a bitmap file (file extension .BMP). 
 
If you don't want an icon on the button, there is room for only about two letters as a text 
caption. To specify a text caption you would put, for example:- 
 

BUTTON="MT" 
 
If you don't put in a "BUTTON=" line, then no button is added to the button bar. 
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Example 1 - if you wanted to have Windows Notepad available from the WinPack file 
menu, go into the WINPACK directory and create a file called NOTEPAD.XTR. Put the 
following lines in the file:- 

Windows Notepad 
c:\windows\notepad.exe 
False 
False 

 
Example 2 - if you find the Alarm program useful and would like it to automatically start 
whenever you run WinPack, edit the ALARM.XTR file and change the third line from 
"False", to "True". If you would like to add a button for it to the button bar, then add a 
line saying, for example:- 

Button=$WINP_PATH\ICONS\CLOCK.ICO 
 
Example 3 - an “Add-on” for viewing the 7plus log file. Go into the WINPACK directory 
and create a file called VIEWLOG.XTR. Put in the following 4 lines:- 

View 7plus Log 
C:\WINDOWS\NOTEPAD.EXE $WINP_PATH\7PLUSLOG.TXT 
False 
False 

 
This will allow you to view the log file using Notepad. 
 
Note for Programmers 
When an “Add-on” is started from the File menu, WinPack does not attempt to change 
to the “Add-on”'s directory. Therefore the path for any work files should be derived from 
the EXE file's path. E.g. by using App.Path in Visual BASIC or by parsing argv[0] in 'C'. 
Do not make any assumption in your program about what directory it will be started from 
- it may not even be the main WINPACK directory. 
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The Alarm “Add-on” 
Menu bar: File>Start Alarms 
 
The Alarms program gives an audible warning when selected items of text are 
monitored by WinPack. Once you start it, there is help available with the F1 key. 
 
Alarm is a program separate from WinPack, as are all Add-Ons. It works via a DDE link 
to WinPack. It is passed all the text that WinPack receives. Whenever Alarm sees one 
of your user-selected text strings in the text it receives from WinPack, a user-selectable 
warning sound is activated and the line containing that text is displayed in the Window. 
Alarm normally uses the PC speaker, however, in some newer systems, the sound card 
may be used instead of the speaker and the number of working alarm sounds may be 
limited to one. 
 
Start WinPack, then start Alarm by clicking on the Start Alarms option on the File 
menu in WinPack. 
 
Alarm will normally run minimised. Look for it as a separate program button in the Task 
bar at the bottom of your screen.  
 
To set it up, click on the task bar button to maximize it. Then enter your alarm alarm 
string – the text you want it to watch for -- by using the program’s Options>Text menu 
option. Enter the text in the lower window and press the Add button to make it part of 
the alarm text string. The text matching isn't case sensitive, so whatever you input is 
converted to upper case. You can input as many different strings of text as you want, 
and they can be as long as you want. When you have input your strings, click Finished. 
You can of course alter the text any time you want. 
 
There are four alarm sounds available - choose which one you want with the 
Options>Sound menu option. 
 
When you’re done configuring Alarm, minimize it again. Then, whenever any of the 
alarm strings is detected, you will hear the alarm sound. Alarm will stay remain 
minimised, but you can click on the task bar button to bring up the Alarm window and 
see what message WinPack received that had the alarm text in it. 
 
There are two other menu options which I added to V2 of Alarm specifically for my own 
use. They may well not be of interest to most other users:- 
 
Whilst running a 10m port on my BPQ node during the Sporadic E season, I wanted to 
have an alarm whenver anything was monitored on that port. Therefore I put "Port=3" 
as an alarm text. However, that resulted in an alarm occurring every time my own 
system sent a nodes broadcast, so I added an Options>Exclude menu option to Alarm 
which allows me to specify text which will cause a line to be ignored, even if the line 
contains a specified alarm text. By putting "G4IDE-1>NODES" as an exclude text, I 
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could ignore my own nodes broadcasts. 
 
I also wanted to log everything heard on the 10m port for later analysis, so I added the 
Log Alarms menu option. If it is checked then all lines which contain an alarm text and 
don't contain an exclude text will be logged. The log files are put in the TEXT 
subdirectory of the main WINPACK directory and have names like AL970620.TXT, 
which would be the alarm log file for 20th June 1997. 
 

Restrictions 
If an alarm is still sounding when another line containing an alarm string is monitored, 
the second line is ignored. 
 
Alarm sounds, particularly the siren, may cause WinPack to lose characters. It doesn't 
happen with my system, but it is something to watch out for. 
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Selection List Editor 
Menu bar: File>Selection List Editor 
 
 

 
 
The Selection List Editor (SELEDIT.EXE) is an “Add-On” program that lets you specify 
parameters to: 

• download the complete text of selected bulletins types during an Auto BBS 
session 

• schedule automatic Auto BBS sessions at prescribed times. 
 

The Selection List Editor lets you edit the WinPack SELECT.TXT and 
AUTOTIME.TXT files to your liking. SELECT.TXT sets the bulletin download filters and 
AUTOTIME.TXT sets the times for selective downloads. 
 
(Selection List Editor was designed in the hope that people will make more effective 
use of these features and is dedicated to all those who say that the UK packet network 
is only for mail. It is dedicated to proving them wrong! G4IDE - October 1997) 
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Getting Started 
For the Selection List Editor to work, the SELEDIT.EXE and SELEDIT.HLP files must 
be in your main WINPACK directory. If the lists in SELEDIT are coming up blank, 
you've probably put these files in the wrong place. Once you start SELEDIT.EXE, there 
is help available with F1. That help is as follows: 

SELECT.TXT Editor 
(For help on the Auto Times, see AUTOTIME.TXT). 
 
The eight lists/windows in the Selection List Editor window (not including the Auto 
Times list/window) represent the eight sections in the WinPack SELECT.TXT file. These 
tell WinPack what bulletins you want to automatically tag for downloading (top 4)  and 
they also allow you to specify items that you don't want to download (bottom 4). As the 
message list is received from the BBS, each message header is checked against these 
lists, and WinPack decides whether or not to tag that header for automatic download of 
the message. 
 
To add an item to a list, key it into the one-line box under the list and then press 
<Enter>. To delete an item in a list, click the mouse on it to highlight it and then press 
the <Delete> key. 
 
The four lists at the top allow you to specify what you want to select for automatic 
tagging for download. Their meaning should be obvious. Examples:- 
 
If you want to download bulletins to WINPAC, you would put  WINPAC in the [TO] list. 
 
If you want to download bulletins with "LOTTERY NUMBERS" in the title, you would put 
LOTTERY NUMBERS in the [TITLE TEXT] list. 
 
The [AT] ("@") list isn't much use in the UK, because "@" is used to define the 
forwarding area, so it is almost always "GBR", "EU" or "WW". (Please don't put any of 
these in the selection list - your sysop won't be very happy at the number of bulls you 
will be downloading!). The one exception is "AMSAT" which is used as an "@" field. 
 
The four lists at the bottom are for specifying things you don't want to download - they 
act as filters on your selections. They are checked first, so if a bulletin would have been 
tagged because it matches one of your top selections, but it also matches something in 
one of your bottom "NOT" sections, it won't be tagged. Examples:- 
 
If you don't want to download any bulletins from G4IDE, even if they would have been 
tagged by one of your selections, you would put G4IDE in the [NOT FROM] list. 
 
If you don't want to automatically download 7plus files, then putting "7plus" and 
<+AUTO7P in [NOT TITLE TEXT] will stop most of them. 
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PLEASE be careful in how you use SELECT.TXT! It can prevent WinPack users getting 
themselves a bad name by indiscriminately downloading the text of a large number of 
bulletins. 
 
Clicking the Ok button terminates the program and saves the lists in SELECT.TXT. 
Clicking the Cancel button terminates the program and doesn't save any changes you 
might have made. 
 
NOTE: Any changes in SELECT.TXT  will not take effect until you restart WinPack. 
 

AUTOTIME.TXT Editor 
(For help on the selection lists, see SELECT.TXT). 
 
The Auto Times list in the Selection List Editor window allows you to tell WinPack the 
times at which you want it to make automatic connections to your local BBS (run an 
Auto BBS session). If you are using it with WinPack V6.3 or later, then you can also use 
it to tell WinPack the times at which you want the bulletins list to be automatically 
pruned, or when you want a script to be run. 
 
If an entry is further marked MAIL, then, on that connect, any personal mail waiting on 
the BBS will be downloaded and mail waiting to be sent will be uploaded, but bulletins 
will not be downloaded. (MAIL can be abbreviated to M.) 
 
Times marked PRUNE tell WinPack to automatically prune the bulletins list. (PRUNE 
can be abbreviated to P.) The pruning method used by WinPack during autotimed Auto 
BBS sessions is as if you have selected Review Bulletins and then clicked the Prune 
button without marking a block, ie. the list is trimmed back to the number set in 
Options>Bulletin Deleting>Bulletins List Prune Size, using whatever option you 
have set for Options>Bulletin Deleting>Block Delete Bulletins. (More help on 
pruning can be found in the WinPack on-line help.) 
 
Times marked EXIT tell WinPack to automatically close down at the specified time. 
PLEASE NOTE - This is an unconditional close down and will occur irrespective of 
whether WinPack is connected to another station. An alternative is to use the CLOSE 
keyword in a script, which will wait until WinPack is disconnected before closing down. 
 
For any time that is followed by any word other than MAIL, PRUNE or CLOSE, then it 
is assumed that the word is the name of a script file, and WinPack will try and run the 
script at the specified time. Example - 12:30 SENDFILE - will run the script 
SENDFILE.TXT at 12:30. 
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To add new times to the list, key them into the one line window underneath the list and 
press <Enter>. The input format is fairly free, all the following are acceptable:- 

1234 
12:34 
12:34 MAIL 
12:34M 
1234P 
12:34 PRUNE 
etc. 

 
To delete a time from the list, highlight the time and press the <Delete> key. 
 
Clicking the Ok button terminates the program and saves the lists in AUTOTIME.TXT. 
Any changes you make to AUTOTIME.TXT will not take effect until you restart 
WinPack.  
 
Clicking the Cancel button terminates the program and doesn't save any changes you 
might have made. 
 
Here is the contents of AUTOTIME.TXT that comes with the WinPack installation disks:  
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; Blank lines and lines starting with a ';' is ignored. 
 
; Put in the times at which you want WinPack to connect to your local BBS. 
; The times don't have to be in chronological order, WinPack will sort  
; them for you. 
 
; At each specified time it will:- 
; 1. Connect to the BBS. 
; 2. Download any waiting mail. 
; 3. List the messages on the BBS so as to update your copy of the 
;    message list. 
; 4. Download any marked messages, including any that have been  
;    automatically marked as a result of listing the messages. 
; 5. Upload any mail that is waiting to go. 
 
; How often you do this is up to you. I think 'a little often' is the best ; way 
to work and so I would suggest every two or three hours. However,  
; you may be influenced in your decision by the attitude of your local  
; sysop and other local users! 
 
; If an entry is followed by the word MAIL, then, at that time, any mail 
; waiting to go will be uploaded to the BBS, any waiting personal mail 
; will be downloaded, but marked bulls will not be read and the message 
; list will not be updated. 
 
; The following example connects every three hours at 25 minutes past the 
; hour. The sessions at 1825 and 2125 will be mail only. 
 
0025 
0325 
0625 
0925 
1225 
1525 
1825 MAIL 
2125 MAIL 
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Themes Editor 
Menu bar: File>Themes Editor 
 
The Themes Editor is a separate “Add-on” program which allows you to create and edit 
filter themes (combinations of criteria), which can be used when reading bulletins in 
WinPack. For more information on themes see “What Are Themes? 
 
When the Themes Editor starts up, an empty theme is loaded and the 4 top criteria 
lists ([TO], [FROM], [AT] and [TITLE TEXT]) are empty. The bottom half of the screen 
shows the existing Selection List Editor criteria (also titled [TO], [FROM], [AT] and 
[TITLE TEXT]), in case you want to use them. (They are only there for reference and 
using them is optional.) 
 

 
 
You can create a new theme from this empty theme or you can load an existing theme 
using File>Load (a list of saved themes will appear and you can select a theme by 
either double clicking to highlight it and then pressing the Enter key, or highlighting it 
and then clicking the Select button). You save a theme using File>Save. You can 
delete a theme using File>Delete. 
 
Themes are identified by their Title description and saved in the 
WINPACK\BULLS\THEMES directory, but with arbitrary, unique file names. The 
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Themes Editor never refers to the actual file name, just the Title.  
 
You can add a ‘selection’ (a word that must be matched) in any of the four criteria lists 
in one of two ways: 

1. by typing the selection word into the one-line text boxes at the bottom of a list 
and then pressing <Enter>. 

2.  by copying a selection word from the bottom Selection List Editor words: either 
double click on the word in the bottom list or highlight it and then press the 
Select button 

 
[Note -you cannot edit the Selections List Editor words from the Themes 
Editor. To edit the Selection List Editor words, use the Themes Editor’s 
SELEDIT menu option to the start the Selection List Editor program. When you 
subsequently close the Selections List Editor, the Selection Lists in the 
Themes Editor will be automatically updated with any changed criteria.] 

 
You can delete a selection word by highlighting it and then pressing the <Delete> key. 
 
In creating a theme, you can link several selection criteria together. Then, when you 
select that theme when reading bulletins in WinPack, only messages meeting all the 
selection criteria for the theme are displayed. 
 
The And and Or option buttons allow you to say whether selected bulletins must match 
the criteria in all the lists (And) or whether they only need to match criteria from one of 
the lists (Or). The default is Or. 
 
Within each list, a match on any of the criteria is sufficient. 
 
Confused? Some examples might make it clearer! 
 
1. An example of an Or theme -  You might create a theme called WinPack, with Or 
checked, and the following selections:- 
 
[TO]   [TITLE TEXT]  [FROM] 
WINPAC  WINPACK   G4IDE 
WINPAK 
WINP7 
 
If a bulletin header matched any one of those criteria, then it would be selected. 
 
2. An example of an And theme - You might create a theme called G4IDE/WINPAC, 
with And checked, and the following selections:- 
 
[TO]   [FROM] 
WINPAC  G4IDE 
WINPAK  G8MZX 
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Only bulletins from G4IDE and G8MZX to the WINPAC and WINPAK topics would be 
selected. Bulletins from G4IDE and G8MZX but not to the WINPAC or WINPAK topics 
would not be selected; nor would bulletins from anyone other than G4IDE or G8MZX to 
the WINPAC or WINPAK. 
 
You can use themes to list the bulletins associated with a particular subject, and then 
decide which you want to download. This is particular useful if a subject tends to attract 
7plus files - you may not want to indiscriminately automatically download many, large 
7plus files.  
 
For example, say you are interested in SSTV but notice that many SSTV postings are 
7plus files. If you use the Selection List Editor you could set it to download all SSTV 
bulletins but then you would either have to pick all or none of the bulletins that had 
7plus in their title.  
 
Using a Theme you can be more selective. You would download the bulletin listing and 
then use a theme to display bulletins [TO] SSTV that have a [TITLE] that includes 
7plus. You could then mark just those of interest for download at the next Auto BBS 
session. 
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Viewers Editor 
Menu bar: File>Viewers Editor 
 
For this section to make sense, you should read Viewers in the Advanced Features 
section. If you haven't read that topic, you won't have any idea what this editor is 
for! 
 
The list of your WinPack viewers currently configured in PACKET.INI is shown in the top 
Window. Each entry in the list consists of a file type and an associated viewing program. 
As you move up and down the list, the highlighted viewer is also shown in the bottom 
Edit Window. The file type is defined by the file extension for which the viewers will be 
used (hence the heading "Ext"), typical extensions for which viewers might be 
configured are JPG, GIF, BMP, WAV, MID, HTM, etc. 
 
If you press the Edit button you can change the viewer associated with that particular 
file type. 
 
If you press the New button, you can create a completely new entry. Once you are 
editing an entry, pressing Yes will save it back into the list, pressing No will abandon the 
edit. 
 
If you press Browse whilst you are editing, a file section dialogue window opens and 
you can browse your way to the required viewer program. 
 
Please Note! If you want to specify that a viewer program is compatible with 
Netscape's DDE features, you MUST add " NDDE" to the end of the viewer name  - see 
Viewers. 
 
When you have finished editing the viewers, press Ok to save your changes in 
PACKET.INI, or press Cancel to abandon the changes. 
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WinpScape 
Menu bar: File>WinpScape 
 
WinpScape is an add-on program that works with Netscape (and maybe Internet 
Explorer). It monitors all text received by WinPack, looking for HTML documents (web 
pages). Any that it finds, it sends to be displayed in your web browser. 

Introduction 
WinpScape does things that no other AX25 packet application has ever done! So,  you 
MUST read this. You will never work out what it does by simply "playing" with it. 
 
A starting point for using WinpScape is that you have WinPack working properly and 
you have Netscape installed and working on your PC. I cannot offer help regarding 
installing Netscape! You can also use Internet Explorer V3, but it is inferior to 
Netscape in terms of DDE support and so most of WinpScape's features aren't usable. 
 

What WinpScape Does 
 
WinpScape only works with WinPack V6.2 or later. When you run WinpScape, it 
makes what is called a DDE link to WinPack (which MUST be running before you start 
WinpScape). It then monitors all the text received by WinPack, looking for HTML 
documents (web pages). It captures any it finds and automatically displays them using 
your web browser. 
 
Not only are they captured and displayed, but, if your browser is Netscape, then you 
can click on specially configured links in the pages and WinpScape will automatically 
download the corresponding documents. Links can also be configured to automatically 
download files using YAPP. 
 
If there are any graphics included in pages, WinpScape can fetch them using YAPP. 
The limitations of the DDE links mean that fetching graphics works differently to when 
you are using the internet. When the page has been fetched it is displayed, then the 
graphics are fetched. After each graphic has been fetched the page is redisplayed. If 
Options>Use Speech is enabled, WinpScape will tell you when it is fetching graphics 
and when it has finished. 
 
WinpScape will hold a cache of recently downloaded pages, so if you select a link to a 
document that has been downloaded within the last hour, it will display the copy in the 
cache rather than downloading it again. 
 
At this point you are probably not understanding what I am saying! Here's an example:- 
 
A BBS puts some web pages in a directory in its files area. You start WinpScape, 
connect to the BBS using WinPack and  "GET INDEX.HTM". WinpScape will capture 
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the document as it is received and display it using your configured web browser. Let's 
say INDEX.HTM has a WinpScape-compatible link in it to BBSINFO.HTM, if you are 
using Netscape and click on that link, WinpScape will automatically fetch the document 
from the BBS and pass it to Netscape for viewing. If INDEX.HTM has a link in it 
configured as a YAPP link to TEST.EXE, then clicking that link in Netscape will cause 
WinpScape to automatically fetch TEST.EXE using YAPP. 
 
Of course, the web pages don't have to be on a BBS, they can be in someone else's 
PMS (Packet Mailbox System). 
 
The single line window at the bottom of the WinpScape screen allows you to key in 
commands that are passed to WinPack. 
 
Chicken And Egg! There's one big problem in all this - before you can download web 
pages, someone has to set some up! So it will need several people in an area to co-
operate before WinpScape can be used... Oh well, there's always hope! 
 

Setting It Up 
You need to tell WinpScape a few things for it to be able to work. 
 
Firstly, you need to tell it the full path to your web browser. If you have configured a 
VIEWER for HTM files in WinPack's PACKET.INI, then WinpScape will ALWAYS use 
that viewer as the browser. Otherwise you must edit WINPSCAP.INI and make an entry 
in the [SETUP] section for a BROWSER. Here's an example:- 
 

[SETUP] 
BROWSER=C:\NETSCAPE\PROGRAM\NETSCAPE.EXE 

 
Please Note - if you are using Win95 and the path to your web browser has long 
directory names, you MUST use the short, DOS compatible, 8.3 directory names. 
 
Secondly, you need to tell WinpScape the file "get" command for the BBSs and other 
stations from which you are going to download html files. 
 
For example, the command for an FBB BBS is GET, the command for a WinPack PMS 
is /GET (see remote access). You put these commands in the [GET_COMMANDS] 
section of WINPSCAP.INI. For example:- 
 

[GET_COMMANDS] 
DEFAULT=/GET 
G4IDE=/GET 
GB7SKG=GET 

 
The default is used for any station for which there is no specific entry. 
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Creating Some Pages 
 
The success of WinpScape will depend on people making web pages available on 
packet! So, why not make some yourself that other WinPack users can read? 
 
Included with WinpScape is a ZIP file called SOMEHTML.ZIP (in the main WinPack 
directory). It contains three very simple pages - INDEX.HTM, LINK1.HTM and 
LINK2.HTM. It also contains a YAPP test file - YAPPTEST.EXE. The pages were 
created using Netscape Gold and give an example of how to make WinpScape 
compatible pages. 
 
If you can persuade your BBS sysop to put these files somewhere in his download area, 
or persuade a friend to make them available on his PMS, then you will be able to test 
WinpScape! 
 
There are two important rules for WinpScape compatible pages:- 
 
1. If you include graphics in your pages, make the size suits your local network 
conditions(in the UK that normally means make them small!) Also, the graphics files 
must be in the same directory as the page, if the image file name includes a path, 
WinpScape will not attempt to fetch it. WinpScape understands graphics references of 
the form IMG SRC="filename.xxx” and it also understands 
BACKGROUND="filename.xxx" on the <BODY> tag. WinpScape will cache graphics 
for a period specified by the user, but the caching isn't very intelligent. If you use a 
graphic called FRED.GIF and someone else also uses FRED.GIF, one will overwrite the 
other in the cache, so try and use names for the graphics files that are likely to be 
unique. 
 
2. Any links that WinpScape needs to process MUST have a protocol type of "ax25", 
"yapp", "command", or "request". E.g. in INDEX.HTM you will find "ax25:link1.htm". If 
your html editor doesn't let you put in non-standard protocol types, simply put in normal 
links and then edit in the "ax25:" or "yapp:" with a text editor. The meaning of the 
protocol types is as follows:- 
 

ax25: - WinpScape will fetch the file as ASCII text. 
 

yapp:- WinpScape will fetch the file using YAPP. 
 

command:- the text following "command:" will be sent back to the system from 
where the page was loaded, WinpScape does not expect to receive anything 
back. 

 
request:- the text following "request:" will be sent back to the system from where 
the page was loaded, WinpScape expects to receive a file. 
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You also need to tell WinpScape the YAPP download command (different from the 
GET _COMMANDS) for the BBSs and other stations from which you are going to 
download files. 
 
For example, the command for an FBB BBS is YGET. The command for a WinPack 
PMS is /YGET (see remote access). You put these commands in the 
[YAPP_COMMANDS] section of WINPSCAP.INI. For example:- 
 

[YAPP_COMMANDS] 
DEFAULT=/YGET 
G4IDE=/YGET 
GB7SKG=YGET 

 
The default is used for any station for which there is no specific entry. 
 
Finally there are two WinpScape options you can set from its Options menu: 

• If you enable Fetch Graphics, WinpScape will try and fetch any graphics in 
pages from the remote system. (See Creating Some pages below). 

• If you enable Use Speech, WinpScape will tell you when it is fetching the 
graphics. 

 

Technical Notes 
WinpScape works by establishing a DDE link to WinPack, which is used to receive all 
the text that WinPack receives. 
 
All text is monitored for the HTML start and end markers <HTML> and </HTML>. If a 
pair of markers has been received, and WinPack is connected to a station at the time 
the end marker is received, then the document is displayed by calling the configured 
web browser. 
 
An attempt is made to call the browser using the Netscape WWW_ShowFile DDE 
 command. If that fails, then the browser application is shelled with the captured html file 
name as a command line argument. Internet Explorer V3, but not earlier versions, also 
supports this DDE command. 
 
WinpScape attempts to register four special protocol types - "ax25", "yapp", 
"command" and "request" - with the browser using the WWW_RegisterProtocol DDE 
command. Only Netscape supports this - it has never been implemented in Internet 
Explorer 
 
If a link is clicked which has a protocol type of "ax25" or "yapp", Netscape passes the 
link information to WinpScape, the file is fetched and then WinpScape passes it back 
to Netscape to display it. If it is YAPP, then it is captured with WinPack's Auto-YAPP 
feature. When WinPack has successfully received the file, it sends an html document to 
WinpScape saying that the file has been received. 
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A description of the "command" and "request" protocol types is given in "Creating 
Some Pages". 
  
To minimise downloading time, WinpScape holds its own very simple cache of html 
documents. It keeps a record of the "owner" of each file and the time when it was 
downloaded. The default lifetime for documents in the cache is 24 hours, but this can be 
changed by editing the CACHE_LIFETIME parameter in WINPSCAP.INI. 
Housekeeping of the cache occurs every time WinpScape is started or terminated. 
Graphics are also cached. The default life time is 7 days (168 hours), but this can be 
changed with the IMAGE_CACHE_LIFETIME parameter in WINPSCAP.INI. 
 
Pages downloaded by means other than clinking links in Netscape are still put in the 
cache, but are given names based on the date and time and are never reloaded. This is 
because WinpScape does not know the correct name for the document (think about it!) 
They will eventually be expired by WinpScape's cache housekeeping. 
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12. Host Modes 
Menu bar: Options>Comms Setup> Host Mode  
 
In addition to working directly with a TNC, WinPack can also work in host mode (as a 
client) with specially programmed TNCs or “host” programs that handle the interface 
with a TNC (or sound card). WinPack will run in the following host modes: 
 
Telnet – internet connection in lieu of a radio connection 
BPQ – G8BPQ's network node software 
AGWPE – the SV2AGW Packet Engine  
TF2.7b -  TNCs with "The Firmware" (TF) or WA8DED firmware; or a SCS PTC-IIe TNC 
TFEMU-  a TF emulator program running as part of PC Flexnet  
 
Click on the hyperlinks above to read more about each mode in the sections that follow. 
 
If you want to put WinPack in any of these host modes, go to the Options>Comms 
Setup menu to call up the Comms Setup window and the Host Mode selection field. 
 
In general, WinPack behaves in a host mode much the same as it does when used in its 
terminal (normal) mode with a regular TNC. Therefore, most of the features and 
information in this manual remain relevant. Some sections, such as TNC Settings, 
obviously are not relevant. 
 
In addition, WinPack has two additional features to take advantage of some of these 
modes: 
 
1. The Multi-channel Terminal helps you manage up to 10 simultaneous conversations 
or connections on virtual channels. See Multi-Channel Terminal below for more 
information 
 
2. The Host Mode Virtual TNC supports TNC-2 style commands and provides some of 
the basic functions of a real TNC. For example, if you are running AGWPE in sound 
card mode, there is no TNC available, so there normally would be nothing to provide the 
cmd: prompt and handle such commands as CONNECT and DISCONNECT. That’s 
what WinPack’s Virtual TNC does.  
 
To reemphasize – in host mode -- any TNC-like prompts and commands are coming 
from WinPack’s Virtual TNC, not from AGWPE, BPQ, etc. The available commands in 
the Virtual TNC will vary significantly according to which host mode is being used. Note 
that the Virtual TNC has on-line help available for all the available commands. See Host 
Mode Virtual TNC for more information. 
 



 

 
WinPack User Manual version 6.80 
0 119 6/13/2002 

Telnet 
Telnet mode uses the internet to make a telnet connection to a BBS. It does not use a 
radio connection or a TNC. If you want to use WinPack with a Telnet connection 
please read this section carefully! Many users have reported problems trying to use 
telnet connections, but virtually all of those problms could be solved by carefully reading 
the section of the manual. 
 
[The information that follows is also available in the TELNET.TXT file in the WinPack 
\DOCS directory. You can easily access this file directly from the WinPack Help menu.] 
 
The telnet-capable version of WinPack is one I once said I'd never write! It allows you to 
make a telnet connection to a BBS via the internet, and so you can use packet without 
using amateur radio. I finally decided to write it so that users who aren't within radio 
range of a reliable mailbox can still read and send packet messages. I think more and 
more amateurs will find themselves in that situation over the next few years. 
 
To use this version of WinPack, you need to: 
 

a) Have a PC with a connection to the internet. 
b) Have access to a BBS that supports telnet connections. All the following 

information assumes that it's a BBS running FBB software. 
 
I cannot help you with either of the above! 
 

Configuring WinPack To Use Telnet 
 
This takes a lot longer to document than it takes to do it! If you are familiar with 
WinPack, have successfully configured it for use on RF, and have a reliable internet 
connection, you should have no problems getting a telnet connection to work. An 
Important Point - You will get in a terrible mess with your bulletin list if you try to use 
the same copy of WinPack with one mailbox on RF and a different one via telnet! It's 
much better to install a second copy of WinPack in a different directory. 
 
In the following, when I refer to connecting to the BBS, I am assuming that your PC is 
already connected to the internet. With Win3.1 that is essential, with Win95 and later it 
is recommended, because WinPack is a 16 bit app, and will not start DUN (Windows’ 
Dial Up Networking) as reliably as 32 bit apps do. For initial testing you must make sure 
your PC is already connected to the internet. 
 
Step by step (remember you need to be connected to the internet already): 
 
1. Find out either the host name or the IP address of the BBS you are going to use, and 
the port number. Also, you will almost certainly need to ask the SysOp for a password. 
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2. In  the Comms Setup window (Options>Comms Setup menu option) select Host 
mode: TELNET. 
 
3. Make a manual test connection to the BBS. Enter the connectin command in the 
WinPack Transmit window.The format for the connection is: 

 C host_name:port_number" or "C IP_address:port_number" 
Examples - 

C gb9xxx.anisp.co.uk:6300 
C 123.456.789.321:6300 

 
4. When you succeed in making a connection, enter your callsign and password when 
prompted. Put yourself in expert mode on the BBS with the X command, and turn off 
paging using the OP command. Take note of: 

• the BBS prompt 
• read any message and take note of the format of the message headers: To, 

From, Date/Time, Message #, Title, and Message End identifier. 
Disconnect with the B command. 
 
5. Correctly configure Personal/BBS Info window (Options>Personal/BBS Comms 
Info menu option) using the information collected in step '4'. Do this with care! 
 
6. Edit the BBS.TXT script in the WinPack’s \SCRIPTS directory and change it to 
something like this (first save a copy of the BBS.TXT file under a different name -- e.g. 
BBSorig.txt -- for future reference):- 
 

HOTKEY F2 
TITLE Telnet connection to a BBS 
SEND c host:port_number       see below for substitutions) 
WAITFOR Callsign :|Winsock error 
SEND .$MYCALL 
WAITFOR Password : 
SEND password     see below for substitution) 
WAITPROMPT 

 
host        - The BBS host name or IP address. 
port_number - The port number used by the BBS preceded with a colon. 
password    - Your password for the BBS. 
 
Notes: 
• .$MYCALL  is a WinPack token for the callsign you enter in the Personal/BBS 

Info window (Options>Personal/BBS Comms Info menu option)  NOTE! 
There's a dot in front of $MYCALL. That dot is VERY important! 

• The  |Winsock error on the WAITFOR line will make WinPack abandon the 
script if a connection error occurs. 

 
Save the changes. 
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7. Make a test connection to the BBS using the F2 hotkey. If it doesn't work, or gets 
stuck, check your script, and also check the  BBS prompt entry in Personal/BBS Info. 
Correctly setting the BBS prompt is the aspect of WinPack that seems to cause most 
problems, mainly because some users don't read the help and others offer incorrect 
advice! See Auto BBS Session Problems.   
 
8. In Mail Options  Window (Mail> Mail Options menu option)- 
 

(a) Uncheck Use FBB unproto lists. If the BBS with which you are going to use 
telnet is a different one to the one you have been using on RF, and you're 
reconfiguring your existing copy of WinPack rather than starting again with a clean 
copy, then you need to get rid of any existing bulletins list. Changing the setting of 
Use FBB unproto lists is an easy way to do it. Also, you should delete 
LASTNUM.TXT in the WINPACK\BULLS directory when WinPack is not running. 
 
(b) You can use compression, but the restriction on having to use Split Sessions 
still applies if you want to use compression in both directions. (That's a limitation of 
FBB, not of WinPack.) You might find that a better arrangement is not to use 
compression, or only use it for downloading - Telnet is usually extremely fast! 

 
9. Run an Auto BBS session. WinPack should connect to the BBS, list the bulletins and 
disconnect. 
 
10.  Go to Mail>Read Bulletins and work your way through all the options on the 
Options>Bulletin Columns... menu. If you don't do this, then the auto-selection 
formatting will never work. 
 
That's it! WinPack should now work via telnet exactly the same as it works on RF. 
 

IP Address Resolution 
(This is a bit technical!) The early versions of WinPack that had telnet support would 
always resolve the host address before attempting to connect. This was done 
irrespective of whether you used a host name e.g. gb9xxx.isp.co.uk or an IP address 
e.g. 123.124.125.126. From V6.59, WinPack does not resolve an IP address before it 
attempts to connect, but resolves it after the connection has been made. This can result 
in a faster connection, but it means that WinPack will announce the connection in the 
above example as being to "123" rather than to "GB9XXX". 
 
If you want to revert to the previous system, then edit PACKET.INI when WinPack isn't 
running, and change RESOLVE_IP_ADDR in the [TELNET] section to TRUE. 
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BPQ 
 
WinPack can be used as a terminal "on top of" the G8BPQ node software. To use it  
you must have version 4.08a or later of the BPQ code. (You can download the BPQ 
software at http://www.ui-view.com/winpack/bpq408a.zip  
 
To enable support for BPQ, start WinPack and use Options>Comms Setup> and set 
Host mode to BPQ .The link should then work without any problems, provided, of 
course, that you have got BPQ running underneath Windows. 
 
In BPQ mode a few things work differently. The split receive screen is used as a main 
window and a monitor window. The screen splits into a 1/3 and 2/3 ratio rather than 
splitting into two halves. (Don't forget that the ratio can always be changed by dragging 
the bar dividing the two sections). 
 
If you are using the FBB beacons, they are monitored all the time, even while you are 
connected to the BBS. 
 
If you use WinPack with BPQ, you need to set up your system to send and receive mail 
slightly differently, see Mail Setup When Using BPQ below. 
 
Please note that BPQ can have a significant impact on Windows performance if the 
node is busy. You may find that the performance of your Windows programs becomes 
unacceptably slow. 
 

The BPQ Terminal 
If you are using WinPack in BPQ mode, a simple terminal program is also available, so 
that you can connect to the node on more than one stream. This program can be 
started either from the WinPack program group or by clicking the BPQ Terminal button 
on the tool bar (only available when WinPack is in BPQ mode). 
 
You can start several copies of this program. They will be indentified as "Terminal 1", 
"Terminal 2", etc. The size and screen position of each Terminal is remembered 
between sessions. 
 
The terminal uses the BPQ virtual TNC, which supports a subset of the commands used 
by the WinPack virtual TNC for other Host modes. To find out what commands are 
available, use the DISP command or see BPQ Virtual TNC commands in the appendix 
 
The top Terminal window is a monitor window and the centre window shows the text 
received on your stream. You can drag the bar between the windows to resize them. 
 
The one-line bottom window is the transmit window - anything you want to send you 
must key into that window and press <Enter>. There are eight scroll back buffers 

http://www.ui-view.com/winpack/bpq408a.zip
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available for the transmit window, so you can reuse previous commands by pressing the 
up and down cursor keys. 
 
The small window at the bottom left shows either "Disconnected" or the callsign of the 
connected station and the stream being used. E.g. GB7IDE [2]. 
 
To connect to the node from the terminal use C. To connect to another station use e.g. 
C GB7IDE. 
 
If you press the Pause button, the windows aren't updated until you either click the 
button again, or 30 seconds elapses. This is to allow you to view the scroll back buffer 
more easily. 
 
The Disconnect button can be used for breaking a connection. 
 
If you drop down the System menu (the menu accessed by clicking on the top left-hand 
corner of the screen), there are options for changing the fonts and the background 
colours for the windows. You can set different colours and fonts for each terminal. So, if 
you have opened two terminals, "Terminal 1" and "Terminal 2", and you change the 
fonts or colours for "Terminal 2", the fonts and colours  used by "Terminal 1", on this 
session or future sessions, are not affected. (If a custom set of fonts and colours have 
never been set for a terminal, then the default is to use the "Terminal 1" setup). 
 
An idle Terminal, i.e. one not connected to anything, can pick up an incoming 
connection to your callsign if WinPack is occupied with another connection. 

Mail Setup When Using BPQ 
 
Callsign 
Outgoing connections, when using BPQ, are made using BBSCALL as set up in 
BPQCFG.TXT. If you want to use NODECALL for outgoing connections, see 
PACKET.INI. For most people BBSCALL and NODECALL will be the same. 
 
Unproto Beacons 
If you are using the FBB unproto beacons, you must make sure that UNPROTO in the 
BPQ Terminal is set to the callsign of your local BBS, optionally with digipeaters in the 
path. 
 
Unproto Port 
If you are using the FBB unproto beacons, you must make sure that UPORT in the BPQ 
Terminal is set to the node port on which you hear the beacons. 
 

Other BPQ – WinPack Information 
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BBS.TXT 
When you are using BPQ, a connect occurs as soon as you connect to the switch. 
There if you send "C GB7OPC" you immediately get a connect, so there is no point 
using WAITCON in BBS.TXT. 
 
The script must rely on WAITFOR, WAITLINE and WAITPROMPT to work out what is 
happening. A simple BBS.TXT is nothing more than:- 
 

SEND C $BBS 
WAITPROMPT 

 
Keeping Window 3.11 Happy! 
It needs a bit of care to get BPQ working properly under Windows. If you have never 
used BPQ with DOS and you try and get BPQ, Windows and WinPack working all in 
one go, you've no chance! 
 
One thing that often confuses people is that the BPQ code must be loaded before 
Windows is started - it is not run in a Windows DOS window. DOS tasks running in 
DOS windows can communicate with BPQ, but the BPQ code is loaded underneath 
Windows. 
 
The approach should be:- 
1. Get BPQ working with DOS so that you can make successful connections using 
PAC4. You don't need any TNCPORT entries in BPQCFG.TXT and you shouldn't load 
BPQHTNC2. 
 
2. Read the BPQ information file WINBPQ.DOC and move BPQDLL.DLL and 
BPQCODE.386 to WINDOWS. 
 
3. Get Windows to run on top of BPQ, so that you can open a DOS window and run 
PAC4 with traffic being transmitted and received correctly, and Windows not 
misbehaving. 
 
4. Still here? You've done the hard bit! WinPack should now work fine in BPQ mode. 
 
One problem that can occur is that if BPQ is using COM ports and Windows "knows 
about" those ports, you're likely to have repeated system crashes. The reason is that 
BPQ will load interrupt handlers for the ports and then Windows will install its own 
interrupt handlers - a definite recipe for disaster! You can easily check to see if 
Windows knows about a COM port by running Windows Terminal and trying to assign 
the port in "Settings", "Communications". 
 
My test system runs with BPQ and two ports, one is a KISS TNC on COM3, the other is 
an ethernet link to my BBS. I use Windows for Workgroups 3.11 and it is completely 
stable. I arranged my COM ports so that BPQ was using COM3 with an IRQ of 9. In the 
Windows’ SYSTEM.INI, I have removed all references to COM3 and put "COM3IRQ=-1" 
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(minus one). That stops Windows trying to take over COM3. There are other ways of 
doing it, but I've found this method to be the best.  
 
Please don't even attempt to share IRQs between a COM port that BPQ is using and 
one that Windows is using. It won't work! That means if you assign a COM port to BPQ 
that is using, for example, IRQ4 (INTLEVEL=4), you cannot have a Windows COM port 
that is also using IRQ4. 
 
Keeping Win95 Happy! 
If you are using Win95, it is easier to hide COM ports from Windows. You do it by 
setting up a hardware profile which does not include the ports that BPQ is using. It is 
very easy to set up two profiles - one which includes the ports for when BPQ is not 
being loaded and one that excludes the ports for when BPQ is loaded. 
 
These profiles can be linked to MS-DOS multiple configurations, so you can have a 
'BPQ' profile that excludes the ports and loads BPQ in AUTOEXEC.BAT before Win95 
starts, and a 'normal' one that includes the ports and does not load BPQ. 
 
See "Creating a hardware profile" in the Win95 help. 
 
Again, please don't even attempt to share IRQs between a COM port that BPQ is using 
and one that Windows is using. 
 
Keeping Windows 98 Happy! 
From the Win98BPQ.TXT file - last update - 30 September 1998 
 
Running BPQ in Windows reliably (i.e. so that it will keep running for days on end, 
irrespective of what else you run on the PC) has always required you to "hide" from 
Windows any COM ports that BPQ uses. This was true for Win31 and Win95, and it is 
still true for Win98. 
 
I have successfully used the techniques described below, on several different PCs, with 
Win95 (original retail version), Win95 OSR2, Win98 Beta 3, and Win98 release version. 
 
If you have been trying to run BPQ with Win98 and had problems with it crashing, 
hopefully these notes will help. I am making three assumptions:- 
 
1. You understand BPQ well enough to have already set it up so if you boot into DOS, 
rather than into Win98, it works properly and reliably. 
 
2. You don't already have any DOS multiple boot configurations set up in CONFIG.SYS 
and AUTOEXEC.BAT. 
 
3. You are using BPQ with a KISS TNC. These notes do not apply to using 
it with Baycom modems. 
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If you follow the instructions below, then you will finish up with a configuration where 
Win98 offers you two boot options - one will boot your PC without BPQ and one will 
boot it with BPQ. The assumption is that the PC will be used for things besides packet 
and so you don't always want to have BPQ loaded. 
 
The following example is based on using COM2 (2F8H, IRQ3) in BPQ, you will need to 
make alterations according to what ports BPQ is actually using. 
 
1. Clear Up Any Mess 
You must check the following:- 
 
(a) In Windows, Control Panel> System>Device Manager>Ports (COM & LPT)" 
should show ALL the COM ports on your PC. None of them should have red crosses 
through them. 
 
(b) In the BIOS, all the COM ports on the motherboard should be enabled. If the BIOS 
allows a setting for a COM port of "automatic" it should not be used. You should use an 
option that assigns a specific address to the port. 
 
(c) The address and IRQ you are specifiying in BPQCFG.TXT for any COM Port that 
BPQ is going to use match the address and IRQ shown for that port in "Device 
Manager", Properties, Resources. 
 
(d) The settings of any address and IRQ jumpers on additional COM port cards match 
the settings in "Device Manager". 
 
(e) No two COM ports should be using the same IRQ. 
 
(f) For now, remove any commands from AUTOEXEC.BAT that are attempting to load 
BPQ, but keep a copy because you'll need to put them back later. (You can, of course, 
just REM them out rather than removing them.) 
 
If you cannot achieve (a) to (f), then give up now, because if you carry on you're going 
to have big problems! 
 
2. Create Two Hardware Profiles 
In Control Panel, select System then "Hardware Profiles". Highlight "Original 
Configuration" and rename it to "Original". 
 
Now select Copy and make a copy of "Original" as "BPQ". 
 
Reboot the PC, and it should offer you a menu with two options - "Original" and "BPQ". 
Select "BPQ". 
 
3. "Remove" The COM Port in the BPQ Profile 
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In Control Panel, select System then "Device Manager". Expand "Ports (COM & LPT)" 
and highlight COM2 (or whatever port you want BPQ to use). 
 
Click "Remove", select "Remove from specific configuration", select BPQ. You will now 
probably be prompted to reboot. 
 
When you reboot, select "BPQ" from the menu. Check in Device Manager and it should 
now no longer list COM2. NOTE - if COM2 is listed and marked with a red cross, you 
haven't followed the above instructions correctly! 
 
Repeat the above for any other COM ports that you want BPQ to use. 
 
4. Changes To CONFIG.SYS 
The aim of the changes to CONFIG.SYS and AUTOEXEC.BAT is to create DOS 
two boot configurations with names that match the names you used for the 
hardware profiles you have created in Windows. 
 
Edit CONFIG.SYS. Put at the top the following lines:- 
 
 

[menu] 
menuitem=Original 
menuitem=BPQ 
 
[common] 
REM all existing CONFIG.SYS entries moved to [Original] below. 

 
At the end of CONFIG.SYS, put the following lines:- 
 

[Original] 
REM put here any entries that you only want to be processed when 
REM BPQ is NOT loaded. 
<insert original CONFIG.SYS entries here> 
 
[BPQ] 
REM put here any entries that you only want to be processed when 
REM BPQ IS loaded. 
<insert BPQ entries here> 
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5. Changes to AUTOEXEC.BAT 
Edit AUTOEXEC.BAT. At the end, put the following lines:- 
 

goto %config% 
 
:bpq 
REM put here your commands to load BPQ. For example, my BPQ is in 
REM F:\BPQ, so I put:- 
f: 
cd \bpq 
REM load any ethernet drivers, etc. 
bpqcode 
c: 
goto end 
 
:original 
REM if you want to have some AUTOEXEC.BAT commands that are only 
REM executed when BPQ is NOT loaded, then put them here. 
 
:end 

 
6. Give It A Try 
Reboot and you will once again get the menu with the "Original" and "BPQ" options. If 
you now select "Original" then BPQ won't be loaded and the COM port(s) won't be 
hidden from Windows. If you select "BPQ" then BPQ is loaded and the COM port(s) are 
hidden. This "magic" occurs because the names of your two DOS configurations 
(menuitems) in CONFIG.SYS match the names of your hardware profiles in Device 
Manager. (If it doesn't work, before you start tearing your hair out, check that your 
spelling of "Original" is consistent throughout! ;-) 
 
Open a DOS window, go into your BPQ directory and run PAC4. You should be able to 
make reliable connections. 
 
 
7. NOTE - How Not To Do It! 
If, in Device Manager, you view the Properties of a COM port, then you will see there is 
an option for "Disable in this hardware profile". DO NOT try and use that option to hide a 
port that BPQ is using - it won't work properly. In a worst situation, it results in the port 
that BPQ is using being disabled in the BIOS, and Windows then assigning the IRQ that 
BPQ is using to a PCI device - with disastrous results! 
 
 
If The PC Is Being Used Only For Packet 
If the PC is to be used only for packet, then you don't need two boot options, and so 
much of the above doesn't apply. All you need to do is to Remove the COM port in 
Device Manager. (Note that '1' and '7' above still apply.) 



BPQ 

129 6/13/2002 
 
WinPack User Manual    version 6.80 

 
You don't need to make the changes to CONFIG.SYS and AUTOEXEC.BAT to create 
two boot options, simply put your BPQ commands in AUTOEXEC.BAT. 
 
 
How "Solid" IS Your Windows/BPQ Configuration? 
As I said at the start, the aim should be to have a system that will run reliably for days 
on end, irrespective of what else you run on your PC. Here are a few tests that a 
properly configured Windows/BPQ system should pass:- 
 
(a) If you open a Windows comms application (e.g. Terminal or Hyperterminal) it should 
not allow you to select a port that BPQ is using. 
 
(b) You should be able to run Windows comms programs on other COM ports 
without BPQ stopping working. 
 
(c) If you connect to the BPQ switch and send the command "s", then "RX Overruns" 
should be no more than a fraction of a percent of "L2 Frames Heard". If you are using 
BPQ in polled mode, "Undrun/Poll T-O" should also be a very small number. If either of 
these statistics are showing high values, then you need to reduce "SPEED" in the BPQ 
port configuration. Also, try and make sure that you are using a port with a 16550. A 
port without a 16550 will suffer badly from "RX Overruns" unless you run it a low speed. 
 
 
Changing WinPack's BPQ Application Number 
PLEASE ignore this section unless you really understand BPQ! 
 
By default, WinPack is BPQ application '1'. That means it will pick up incoming connects 
to the BPQ BBSCALL and respond to the "BBS" (best to change it to "PMS") command 
from the switch. You can change WinPack's application number by editing PACKET.INI 
so that it will respond to a different command from the switch. 
 
For example, if you make it application number '4', and make your applications line in 
BPQCFG.TXT "APPLICATIONS=PMS,,SYSOP", then WinPack will respond to the 
"SYSOP" command from a user connected to the switch. If you make it application '5' 
(4+1) then it will respond to both "PMS" and "SYSOP". 
 
BPQ Application Patches  
A problem has been discovered which very occasionally occurs when decoding nodes 
broadcasts. The problem manifests itself as a GPF in BPQDLL.DLL if the Windows 
application using it calls the function in the DLL which decodes monitored frames, and a 
crash in PAC4.EXE and SWITCH.EXE if monitoring is enabled. The problem occurs 
very rarely, because, for a nodes broadcast to trigger it, the broadcast itself must have a 
very unusual structure! 
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The problem was discovered as a result of GPFs occurring when using BPQDLL.DLL 
with WinPack; also crashes in PAC4.EXE were noted. I would like to thank G4ZEC, 
who was lucky, or unlucky, enough to regularly get the GPFs, for his help and 
persistence in tracking down this problem. Once the cause was found, a suitably 
constructed nodes broadcast would always crash the programs, but finding the cause 
was a very prolonged exercise! 
 
The versions of the programs which have been patched were from the BPQ 4.08a 
release. Normally I would not consider issuing altered versions of someone else's 
software, but my understanding is that the author no longer actively supports the 
programs. The patches have no effect other than to make these programs more robust, 
and so I feel that, in this case, releasing the patches is justified. 
 
If it’s not in the main WinPack directory, you can download the BPQPATCH.ZIP at: 
http://ui-view.com/winpack/bpqpatch.zip  
 
Please read BPQPATCH.TXT in the ZIP before you use any of the files! 
 

http://ui-view.com/winpack/bpqpatch.zip
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AGWPE 
 
Since V6.4, WinPack has supported the SV2AGW Packet Engine (PE) or AGWPE. 
AGWPE supports many different types of TNCs (in KISS mode), Baycom modems, 
DRSI cards, USCC cards, etc. It supports up to 100 TNCs and up to 100 applications at 
the same time.  
 
More recently, AGWPE has included a sound card modem enabling you to run WinPack 
without a TNC! You can find out more about this aspect of AGWPE by going to the 
Sound Card Packet web site at: http://www.qsl.net/soundcardpacket/ 
 
When WinPack is used with the AGWPE, you get true split screen operation and up to 
ten simultaneous connects - one from the main WinPack screen and up to nine others 
from the Multi-channel Terminal screen. 
 
Please note - the AGWPE provides neither a node nor a digi facility, although there are 
compatible programs that can provide those functions – see the AGWPE web site. Also, 
AGWPE is a Win95 program. It cannot be used with Win3.1. The great advantage of the 
AGWPE, compared to BPQ or Flexnet , is that, as a Win95 application, you don't have 
the problems of having to load it underneath Windows. Also, you only need to run it 
when you want to use packet. It isn't stuck there all the time using up processor 
performance when you aren't using packet. 
 

Downloading and Installing the AGWPE 
SV2AGW's web site is http://www.raag.org/sv2agw/ . You need to download 
AGWPE.ZIP. Make a directory for the Packet Engine, say C:\SV2AGW, and unzip 
AGWPE.ZIP. 
 
Run AGWPE and follow the instructions for setting up whatever ports you 
want to use  - it's very easy compared to BPQ or Flexnet ! 
 
To enable support for AGWPE, start  WinPack. and use Options>Comms Setup> and 
set Host mode to AGW. 
 
Note that when you are using the SV2AGW Packet Engine, the COM port settings in 
the COMMS Setup window will not be used – if fact, those fields are gray-ed out and 
inaccessible  -- since your TNC is controlled by the Packet Engine and not by WinPack. 
 
Click OK. If you don't get an error message, then that's it! WinPack should be showing 
WinPack-AGW on its title bar and it should now be able to talk to the AGWPE ports. 
Depending on what you were previously running, if you had created a STARTUP.TXT 
script file it may need altering, and there is a slight chance that BBS.TXT will need 
altering, but that is unlikely. 
 

http://www.qsl.net/soundcardpacket/
http://www.raag.org/sv2agw/
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Using WinPack-AGW 
WinPack-AGW has an internal virtual TNC, this gives it a TNC2-like user interface, even 
though it is being used with AGWPE. What appears to the user as the TNC responding 
to TNC2-style commands is, in fact, part of the WinPack software. 
 
For a list of the available virtual TNC commands, use the ? command from the WinPack 
command line. Help on the individual commands is available using ? followed by the 
commandn name, e.g. ?MONITOR. Please note that most of the TNC "on air" 
parameters are set in AGWPE, so they cannot be set from within WinPack. 
 
See the AGTNCHLP.TXT file in the WinPack directory. 
 
If you have more than one port set up in AGWPE, then some commands can  
take a port number as a parameter - MHEARD 2, CONNECT 3 G4IDE, etc. If you don't 
give a port number, then port 1 is always assumed. 
 
You can split the WinPack screen to give a monitor window at the top and a window for 
your traffic at the bottom by using Options>Split Window or just press Ctrl+S. 
 
You access the Multi-channel Terminal screen using Actions>Terminal or click the 

terminal button . 
 

MH List Time Stamps in WinPack-AGW 
 
MHPE V1.0   is a smart MH list for WinPack when used with the SV2AGW Packet  
Engine. It has tabbed notebook format . You can download it at : 
 http://www.ui-view.com/winpack/mhpe10.zip 
 
 PLEASE NOTE – For the MH List to work correctly, check your AUTOEXEC.BAT to 
see if you have a time zone (TZ) statement in it. If you don't, then you should put one in. 
This is not essential, but without it you are likely to find that the time stamps shown in 
the MH list in WinPack are incorrect. A suitable TZ statement for the UK is:- 
 

SET TZ=GMT00BST 
 
 

A Hint on Setting AGWPE Parameters 
I configure my AGWPE ports with the "Program adjusts Parameters" option in 
AGWPE and AGWPE normally does a good job adjusting communication settings. 
However, on busy channels, I have found that the AGWPE seems to start off with 
MAXFRAME set too high, and so it wastes time until it reduces it to a more useful 
value. There are some comments in the AGWPE help about controlling the range of the 
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automatic settings, and I found that adding the following section to AGWPE.INI made 
things much better:-  
 

[AUTO] 
MAXMAXFRAME=3 
MINMAXFRAME=1 

 



 

TF2.7b  
 
To use this mode you must have a TNC specially fitted with either TF (TheFirmware) 
firmware, WA8DED firmware, or you must be using a SCS PTC-IIe TNC .  

 
Before entering TF2.7B host mode, make sure the TNC-to-computer baud rate is set 
4800 or more, but don't go above 9600 unless you know the

to 

NC has a 16550 UART, with the FIFO enabled (see below Serial Port Requirements
 COM port used by your 

Want to try WinPack in TF host mode, but haven't got a TF EPROM for your 
TNC? In that case, you can download TF EPROM images from this site: 
http://www.ui-view.com/winpack/tf/tf.htm  

T . 

. The Data Bits, Stop Bits 
nd Handshaking settings are irrelevant and will be ignored. 

 

ill 

ither TF or WA8DED firmware, and restart WinPack. (see below “If Things Go Wrong

 
In the WinPack Comms Setup window (Options>Personal/BBS Info), make sure that 
the Baud Rate and Com Port setting match those of the TNC
a
 
When done with the Comms Setup settings, click on OK. The cursor should change to
an hour glass and WinPack will attempt to communicate with the TNC. You may see 
some Invalid Command messages appear on the screen, but eventually the cursor w
return to an arrow and a cmd: prompt will appear. If that doesn't happen, but instead 
you get an error message, close down WinPack, make sure your TNC really does have 
e ”) 

. 

em all from the values saved 
 PACKET.INI

 
WinPack assumes that the TNC is not in it’s host mode and sends the command to put 
the TNC into host mode. WinPack then sends a whole series of initialisation commands
(Unlike when it is using a TNC in command mode, WinPack does not assume that the 
correct parameters are in the TNC, instead it reinitialises th
in  or from default values within the program.) 

a 
re-establish communication. If the recovery fails, then an 

rror message is displayed. 
 

rent for SCS PTC-IIe TNCs 

in 
. 

lt values for these commands, and also for INICMD, will be different for a 
TC-IIe.  

 
If any initialisation command fails to be acknowledged by the TNC, WinPack goes into 
recovery routine and tries to 
e

Virtual TNC Parameters Diffe
The following is important! 
Some of WinPack’s Virtual TNC commands take different parameters when used with 
an SCS PTC-IIe as compared to parameters used with TF firmware. The difference is 
the units used. The commands are FRACK, RESPTIME, SLOTTIME and TXDELAY
The defau
P
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For full information on any command, use the Virtual TNC’s Help: at the cmd: prompt, 
enter  ?<command>, where <command> would be replaced with the actual name of 

e command. For example,  ? DISPLAY will result in help on the DISPLAY command. 
(You can get general help with the command  help or simply  ? .) 

uously poll the TNC - it will not send data to the PC until it is asked. Also, every 
ommand that WinPack sends to the TNC is acknowledged with a response of some 

d 
down because of characters getting dropped on the PC 

OM port, WinPack will attempt to re-establish it. Usually this is successful, but it can 

r because the Windows comms drivers don't service the 
ort quickly enough - there's nothing I can do about that because the drivers are part of 

not be 
 make an entry in 

YSTEM.INI (see WINDOWS.WRI - COM1FIFO). With Win 3.1 a third party 

s, WinPack will 
ma ERR.TXT, which is in the main WinPack directory. 
An

1. orted 

een recovered, 
 

t of 

se Note - turning off the 
NC whilst WinPack is running can cause a lot of entries in the file, because of the 

rubbish that may come out of the TNC as it powers down. 
 

th

 

Serial Port Requirement for TF2.7b mode 
The following is important! 
When the TNC is being used in TF or WA8DED host mode, WinPack has to 
contin
c
sort. 
 
This means that there is a tight, continuous communications loop between WinPack an
the TNC. If this loop breaks 
C
result in some loss of data. 
 
In testing I found that with one PC - a DX2 running Windows for Workgroups - I could 
not get satisfactory comms performance without using a port with a buffered UART 
(16550). Without a 16550, overruns kept occurring on the port when heavy disk activity 
was in progress. Overruns occu
p
Windows, not part of WinPack. 
 
I would certainly recommend the use of a 16550. Most new PCs have them as 
standard. Please Note - if you aren't using Win95, the FIFO in the UART will 
automatically enabled! With Windows for Workgroups, you need to
S
replacement for COMM.DRV, such as CyberCom, is a good idea. 
 
If you are using host mode, whenever a communication error occur

ke an entry in a file called COMM
 overrun on the port will usually cause a series of three entries: 

First the overrun is rep
2. Next the comms loop will fail and there will be an entry saying the comms loop 

has b
3. Finally there may be an entry saying the comms loop has been kicked back into

life. 
When you first start using host mode, keep having a look at this file. If you get a lo
overrun entries, then you really should consider fitting a port with a 16550. If you get 
many entries of other sorts, other than an occasional "COMMS LOOP KICKED" 
message, then I'd be interested to hear what they are. Plea
T
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If Things Go Wrong 
(TF2.7b host mode) 
 
Host mode should perform very reliably. In the event of any communication errors 
occurring, WinPack will make an entry in the COMMERR.TXT file in your WinPack 
directory.  
 
If communications with the TNC are lost, WinPack attempts to re-establish the link. 
There are also two WinPack menu options to help you recover from problems. 
 
 
Host Initialise 
(Menu bar Action>Host Initialise) 
 
This menu option attempts to re-establish communications with the TNC and sends all 
the setup information to it. (This process automatically occurs whenever the program is 
started in host mode). 
 
Host Reset 
(Menu bar Action>Host Reset) 
 
This option attempts to totally reset the host mode firmware and then reinitialises it. It is 
put in because of the possibility that switching from the "norrmal" firmware to the 
WA8DED firmware in a Tiny-2 Mk2 may leave some rubbish in the TNC RAM which 
causes WA8DED problems. I would recommend that this option is used with Tiny-2s 
whenever WA8DED has been reselected. 
 

WA8DED in a BSX2 TNC 
The following comments are my findings with my own TNCs. I would be interested in 
any "learned opinions" on this! 
 
If I put WA8DED (DED) firmware V2.5 from a Tiny-2 in a BSX2 TNC, the results are 
very poor, in fact it is more or less unusable. The problems is not caused by WinPack, 
because I have done extensive tests using WA8DED firmware in terminal mode with a 
simple terminal program - i.e. WinPack was totally removed from the equation. 
 
What happens is that the frames sent by the TNC are often not decodable by the 
receiving system. Even on a solid link with two systems running on dummy loads, or 
with the TNCs connected back to back, many frames cannot be decoded. Listening to 
the frames. I can hear a difference between the ones that are decoded and the ones 
that aren't, but it's difficult to say what it is. 
 
If the DED firmware is replaced with TF2.7b, or with Tiny-2 V3.1, or with TNC2 
firmware, the TNC works perfectly. 
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My conclusion is that there is something about the BSX2 hardware that makes it 
unsuited to WA8DED firmware - but I have no idea what! 
 
So, if you have a BSX2 and you want to try host mode with WinPack, I recommend 
using TF2.7b rather than WA8DED. 
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TFEMU 
 
TFEMU – which is short for TF EMUlator – is a WinPack host mode that uses the 
PC Flexnet software package and its associated TFEMU module.  
 

WinPack and PC Flexnet 
Adapted from the WINPFLEX.TXT in the WinPack directory written in September 1997 
 
 Introduction 
First a disclaimer - my current knowledge of PC Flexnet is very slight. (If anyone who 
has a good knowledge of Flexnet gets WinPack working with it, feel free to update this 
document and send me a copy!) 
 
I implemented support for Flexnet in WinPack because I had seen a lot of comments 
about it, and I wanted to see what it did. I must say that I am very impressed with it and 
I hope that the support for it in WinPack encourages more people in the UK to give it a 
try. 
 
I cannot support Flexnet - I don't know enough about it. You should regard obtaining 
and setting up Flexnet as a separate task to getting it to work with WinPack. (These 
notes aren't intended as instructions, they are intended as guidance to help you in your 
experimentation). 
 
The last URL I have for Flexnet is: http://www.afthd.tu-darmstadt.de/~flexnet/ 
You can do a search for FLEXNET in a web search engine if that no longer works. The 
Introduction link on the index page gives a good overview of Flexnet and the concepts 
behind it. 
 
If you are lucky enough to have a local Flexnet node, then your node sysop may well 
be able to help you, or another local radio amateur may be able to supply you with a 
copy. 
 
To use Flexnet with WinPack, you must obtain a recent version of Flexnet which has 
support for Win95, I am using V3.3f. Please note Flexnet does not support Win3.1. If 
you do not have a pc with Win95+ on it, you cannot use Fexnet with WinPack. 
 
PC Flexnet runs underneath Win95 and puts a significant load on the processor, I 
would say that a 486/DX2 and 16Mb is a minimum for using it with WinPack. 
 

Loading PC Flexnet 
How to load Flexnet is fully covered in the Flexnet docs, I am not going to cover that 
here, except to say that the stages are:- 
 

http://www.afthd.tu-darmstadt.de/~flexnet/
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1. Load FLEXNET - the kernel. 
2. Load your drivers. 
3. Activate the kernel with FLEX. 
4. Load any other required modules. 
5. Run FSET as required for your drivers. 

 
WinPack interfaces to Flexnet via TFEMU – the TFPCX emulator. It is recommended 
that you use TFEMU with DRSI-style interrupts (tfemu -dx), because it is a little more 
efficient than using the default TFPCX-style interrupts. However, WinPack will detect 
which type of interrupts are being used. It will also find TFEMU, even if the -i flag is 
used to assign TFEMU to a software interrupt other than the default of FDh, so you 
don't need to tell WinPack which interrupt number is being used. 
 
As an example, here is the BAT file I have been using on my test system. I haven't used 
all these drivers at the same time, but I've put them all in as examples of what I have 
successfully used. The minimum is that you must load Flexnet, you must load and 
configure one driver, you must run flex, and, for use with WinPack, you must load 
TFEMU. (You can use lh to load the drivers high, but on my PC, loading Flexnet high 
uses up all the available upper memory.) 
 

REM load the kernel. 
lh flexnet 
 
REM load the Baycom modem driver for my COM3. 
REM this will be channel 0. 
ser12 /p=0x3e8 /i=5 
 
REM load the sound card driver - using LPT2 for the PTT. 
REM this will be channel 1. 
smsbc /tl:0x378 
 
REM load 6PACK to drive two TNCs in a ring on my COM4. 
REM these will be channels 2 and 3. 
6pack 4 /b=19200 /c=2 /p=0x2e8 /i=9 
 
REM load the ethernet driver. 
REM this will be channel 4. 
ether32 /c=1 /n0:ipx 
 
REM activate the kernel. 
flex 
 
REM load the 1200 baud sound card modem module. 
smafsk12 
 
REM set the mode and txd for channels 0, 1, 2 and 3. 
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fset mode 0 1200c 
fset txd 0 50 
fset mode 1 1200 
fset txd 1 50 
fset mode 2 1200 
fset txd 2 50 
fset mode 3 1200 
fset txd 3 50 
 
REM set the sound card (SB16) input to line, 
REM and set the input and output gain. 
smmixer /s:line /il18 /ir18 /ol-25 /or-25 
 
REM load TFEMU with DRSI interrupts and TFPCX port numbers. 
tfemu -dx 

 

Testing PC Flexnet 
To test Flexnet without using WinPack, I used BCT.EXE V1.60u, which I downloaded 
from the Flexnet web site, in a DOS Window in Win95. 
 
If you will be using more than one channel for connections, don't forget that Flexnet 
expects the channel to be specified after the callsign, so, to connect to G8MZX via 
channel 1, it's C G8MZX 1 
 
 

SER12 Problems 
The docs for SER12 say " Note: Problems have been reported running ser12 on some 
notebooks and some state-of-the-art computer mainboards with onboard UARTs. It 
seems that some brand of I/O controllers lack special features that are needed for the 
ser12 driver to perform properly." 
 
So far I have tested it with three PCs and I have found that it does not work at all well 
either with the 16550 UARTs in the Triton chipset of my Pentium PC motherboard or 
with a 16550 UART on an expansion card. It works fine with 8250 UARTs on expansion 
cards. 
 

Running WinPack with PC Flexnet 
First, make sure you can answer “yes” to these questions: 

Have you got TFEMU loaded??  
Have you tested Flexnet from a DOS Window?? 

 
Start  WinPack. Use Options>Comms Setup> and set Host mode to TFEMU. Note 
that when you are using PC Flexnet , the COM port settings in the COMMS Setup 
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window will not be used – if fact, those fields are gray-ed out and inaccessible  -- since 
your TNC is controlled by Flexnet and not by WinPack. Now click OK. 
 
There will be a delay of several seconds whilst WinPack initialises the host mode and 
sets some TF parameters. If WinPack can't find TFEMU, it will give you an error 
message. If so, close down WinPack, make sure PC Flexnet and TFEMU are correctly 
loaded, and restart WinPack. 
 
Assuming that WinPack managed to load, pressing <Enter> will give you a cmd: 
prompt from the WinPack virtual TNC. If you input  ?  you will get a list of the available 
virtual TNC commands. Help on any particular command is available by inputing a 
question mark followed by the command name, e.g. ?MON. Please note that several of 
the commands are not available when using TFEMU and will not be accepted if you try 
to use them. TFEMU commands not supported by the virtual TNC can be input using 
the  RAW command. 
 
Note that WinPack has on-line help for quick access (the same as in this manual). The 
host mode help also covers using WinPack with a TNC with TF or WA8DED firmware in 
it, so ignore all references to the TNC - your TNC is controlled by Flexnet , not by 
WinPack. Please make sure you read the on-line help comment in "Enabling Host 
Mode" about setting "BBS_UNPROTO=to FBB" in PACKET.INI. 
 
Have fun! 
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Host Mode Virtual TNC 
In host modes, WinPack uses a Virtual TNC. What appears to the user as responses 
from a typical TNC-2 compatible TNC is, in fact, WinPack "pretending" to be a TNC. 
This gives a familiar user interface to anyone who has been accustomed to using a TNC 
in terminal mode. For example, the virtual TNC will return the familiar cmd: prompt 
when you press the <Enter> key. 
 
Commands available for each host mode will vary. For a list of the available commands 
for the host mode you are in, enter  help or simply  ? . For detailed information on a 
specific command, enter  ?<command>, where <command> would be replaced with 
the actual name of the command. For example,  ? DISPLAY will result in help on the 
DISPLAY command. (You can get general help with the command  help or simply  ? .) 
 
See the AGTNCHLP.TXT file in the WinPack directory for AGWPE commands. 
See the TFTNCHLP.TXT file in the WinPack directory for TF2.7b mode commands 
 
One special feature of the Virtual TNC is that , if WinPack hears a nodes broadcast, it 
will decode it and display it in a tabular format. This is something which a real TNC does 
not do. 
 



 

Multi-channel Terminal 
 
In host modes other than BPQ), WinPack has a separate Multi-channel Terminal 
window that supports up to 9 channels in addition to the 2 possible channels used in the 
main WinPack screen (BPQ mode has its own terminal). To open the terminal, either 
select Action>Terminal on the menu bar , or click the terminal button  on the button bar  

. 

 
 
The number of channels available will be shown by how many buttons are displayed. 
Some versions of WA8DED firmware may only support a total of 4 channels. 
 
The top window in the Multi-Channel Terminal screen is called the monitor window; 
the middle window is the main window; and  the bottom window (one-line) is the 
transmit window. 
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Multi-channel Terminal 

You select the channel you want to use by clicking the large numeric channel buttons, 
or you press Alt+1, Alt+2, etc 

 
If a channel is being used for a connection, the c
station’s CALLSIGN will appear on the channel bu
in red if it’s the active channel (using the main and 
t’s not. The small square to the right of the channel 

button will be green if there is no new traffic on that channel and red if there is.  
 

onnected 
tton, 

transmit windows) or black if i

 you select channel button 1If  you are returned to the main WinPack screen because 
that always uses channel 1. You will find it very easy to switch between the main scree
and the Mulit-channel Terminal screen by pressing the 1

n 
 button in the Multi-channel 

terminal  or the terminal button in WinPack    or the program screen buttons in the 

Windows task bar . 
 

he small monitor buttons at the top right of the Multi-channel 
in 

w you 
wish. The monitor cha

ere's an example of what is possible:- 
dow (with Ctrl+S or Options>Split Window). 

T
terminal screen let you select which channel you want to display 
the top monitor window. The default is to display monitored, 
hich is virtual channel 0, but you can select another channel if 
nnel button that is selected will turn red. 

 

unconnected traffic, 

 H
• Split WinPack’s main Receive Win

In the top receive window display monitored traffic – channel 0.  
Use the bottom receive window — always channel 1 -- to give yo
TNC’s PMS (Personal Mail System) and collect your mail from the BBS. 
Open the Multi-Channel Terminal screen, and connect to the DX cluster

u access to your 

•  on 
channel 2. Now click monitor button 2 (top right) so the DX cluster traffic is in t
Multi-channel’s top monitor window 
 Now click on channel button 3

he 

•  and use the transmit and main windows to 
connect to another station, whilst having the cluster traffic on channel 2 
constantly visible in the monitor window. You'll soon get the hang of it! 

Terminal Window Menus 
r capturing, colours, fonts, beep on connect, etc on the 

n 

The Terminal Opened Itself! 
 in use and someone connects to your system, they will 

 you don't want this to happen, use the Virtual TNC command USERS 1, which will 
stop incoming connections to any stream other than the main WinPack screen, but it 
won’t affect how many outgoing connections you can make..

There are various options fo
Multi-channel Terminal screen’s menu bar. They all correspond to similar options o
the main WinPack screen. 

If your main WinPack screen is
be using a stream on the terminal screen and it will automatically open. 
 
If
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13. Trouble Shooting and FAQs 
(FAQs: Frequently Asked Questions) 
 
Before we get to the FAQs, let’s mention … .. 

Comms Error Log 
(The following comments do not apply if you are using either BPQ, TFEMU or AGWPE. 
With those systems, the COM ports are controlled by the host mode software, not by 
WinPack, and so WinPack cannot log any communication errors that might occur.) 
 
If a communication error occurs, WinPack will make an entry in a file called 
COMMERR.TXT which is in the main WINPACK directory. Note - If you aren't getting 
any errors, then the file won't exist. 
 
If you are having problems with compressed download failing, or downloaded messages 
having characters missing, then have a look at this file. 
 
If you are getting frequent errors, then you have a hardware problem with your PC. 
Errors of this type are nothing to do with WinPack. Please note that by "frequent" errors 
I mean errors being logged regularly all the time that WinPack is running. If you do 
something like switching your TNC off and on again while WinPack is running, you 
might create a whole bunch of errors, but that doesn't count! 
 
The most likely errors will be overrun errors. They occur when Windows doesn't clear 
the characters from your COM port as fast as they arrive. If you find you are getting 
them, here are a few suggestions:- 
 
1. Make sure you are using a port with a 16550 UART. If you are still using Win31, the 
16550 will not be enabled unless you use a third-party comms driver such as 
CYBERCOM.DRV, because Win31 did not support 16550s.  (This comment does not 
apply to Windows for Workgroups.) 
 
2. Reduce the speed between the PC and the TNC. 2400 or even 1200 baud will work 
fine if you are using 1200 baud "on air". 
 
3. With Win95/8, make sure your video card has the latest drivers, particularly if it is a 
Matrox. If you are using more than 256 colours, try changing to 256. If this helps, then 
you definitely have a video card/driver problem. 
 
4. On some systems, Win98 seems to suffer very badly from overrun errors. It affects 
modems more than TNCs, because of the much higher data rate, but I have seen 
evidence to suggest that TNCs can also be affected. Try rebooting and then see if you 
get any overrun errors during the first 10 minutes or so that the system is running - If 

 
W
0 
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you don't, then you are probably suffering from this Win98 problem. Unfortunately I don't 
wing might help:- 

ystem>Device Manager>Properties>Port 
e, and move the receive FIFO setting to 

think there is yet any solution to it, but the follo
 
n Windows, go into Control Panel>SI
Settings>Advanced" on the COM port you us
one of its lowest two values. 
 

Frequently Asked Questions 
 

rom the WinPack FAQ Page at http://www.ui-view.com/winpack/faq/faq.htmF  
 
I've been meaning to do this page for ages! I send out a lot of replies to WinPack help 
requests, and many of them are to the same questions which are asked time and time 
gain. I used to send some replies aa s bulletins, in the hope that my answer would help 

more than one person, but for various reasons I've now stopped doing that. I hope that 
the replies to the Frequently Asked Questions which I have listed below will help people 
o get over these common problems. t

 
I'll add to the questions whenever I find myself answering something and thinking 
"Geesh! I've said this a lot of times before!" 
 
Click on a question to see the answer:- 
 
 1. Why won't my Selections List Editor selections work?  
 2. Why does the BBS.TXT script misbehave at WAITPROMPT? 
 3. Why do I have problems now my BBS has started using FBB V7?  
4. Why does WinPack think my AEA  TNC is connected all the time?  

 5. What's all this about a speech "viewer" in WinPack V6.3?  
 6. Why do I have problems with WinPack and my Kantronics TNC? 
 7. Why do I sometimes get gaps between message numbers?  
 8. Why do I have problems now the BBS has moved frequency?  
9. How do I use WinPack with my B aycom modem?  

10. How do I register WinPack and how do I pay from overseas?  
11. Why can't I use all my Windows fonts in WinPack?  
2.Why won’t WinPack Run?1  

 
 
************************************************************************************************ 

. Problem: I have used the WinPack Selection1  List Editor and put WINPAC in the 

s 

in 
the Selections List Editor

[TO] section, but bulletins to the WINPAC topic are NOT automatically downloaded. 
[Substitute other topics, and [FROM], [AT], [TITLE TEXT], etc, according to taste!] (Thi
question is only relevant if you DON'T use the FBB unproto beacons.) 
------------------------------------------------------------------------ 
Answer: For WinPack to be able to automatically download the selections you make 

, it has to know the layout of the bulletins list. The layout varies 
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from BBS to BBS because the sysop can alter it. To tell WinPack how the bulletins list is 
laid out you use the options on the Options>Bulletin Columns... sub-menu. 

** 
 
**********************************************************************************************
2. Problem:  When WinPack connects to the BBS, either in an Auto BBS session or 
when I press F2, it gets to WAITPROMPT and then sits there until I cancel the script, 
ven though the BBS has sent the prompt. 

 
AITPROMPT disappears before the prompt is 

ceived from the BBS, and WinPack may then abruptly disconnect.) 

nswer: It is very important to input the correct setting for BBS prompt in 

 

pts and the correct setting for BBS prompt. 

ere is what you should put in "BBS Prompt" in WinPack:- 

ote the : is there, but  there is no 2 at the beginning and no > on the end. 

ck:- 

ut some text which occurs in the prompt, but is unlikely to 
ccur anywhere else. WinPack always assumes that the prompt from the BBS ends 
ith a  >, so you don't need to put that  > in. Note that the text you specify must be in 

t, so sometimes 

e

(Another variation of this is that the W
re
------------------------------------------------------------------------ 
A
"Personal/BBS Info window (Options>BBS/Personal Info menu option). Unless this 
setting is correct, the BBS.TXT script will stick at WAITPROMPT or terminate 
prematurely. Remember Help is available if you press F1 when the Personal/BBS Info
window is open. 
 
Here are some examples of BBS prom
 
Here's an example of a very common BBS prompt:- 

2:GB7IDE> 
H

:GB7IDE 
n
 
Here's another prompt: 

(1) G8MZX de GB7IDE BBS 12:34 > 
Here is what you might put in "BBS Prompt" in WinPack:- 

) G8MZX de GB7IDE 
 
Here's another prompt:- 

(3) GB7IDE (H for Help) A,B,C,D, etc (most of the alphabet) > 
Here is what you might put in "BBS Prompt" in WinPa

) GB7IDE (H for Help) 
 
What you're trying to do is to p
o
w
the correct case. 
 
A common error is to put something like:- 

3:GB7SKG 
The leading 3 is a stream number, and will vary from connect to connec
it will work and sometimes it won't. 
 

http://www.ui-view.com/winpack/faq/faq.htm
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Another common error is, with a prompt like the example above with the time in it, to 
put: 

) G8MZX de GB7IDE > 
o 
t, 
>. 

ne other thing which can very rarely give a problem is if you have an absolutely 
es 

he WAITCON 

 

 to take the easy option of putting simply  > . It may appear to work, but 
 will probably cause problems at some stage. It will certainly cause problems if the 

S for testing your WinPack prompt setting. > 

 
the chances 

re that you'll never get as far as the real BBS prompt. 

It w use the FBB unproto beacons, and so 
e BBS and listing it. Packet 

use und the message title with < and >. When WinPack lists the 
essages, it will stop at any line ending with >. 

*** ******************* 
7 and WinPack is giving 

problems. (The problems may be that compressed download and forwarding cannot be 
sed, or that the BBS disconnects you when you try to upload mail after you have 

 some significant differences in the way that FBB V7 behaves 
ompared to V5.15. 

1. Users need to have the F flag set in their status, or they usually can't use 

Remember,  WinPack automatically assumes that the BBS prompt will end with a >, s
you shouldn't put it in the BBS prompt field. By putting the > on the end of your promp
you are specifying something which does not actually occur in the prompt. – an extra  
 
O
superb path to the BBS, and the BBS has very little welcome text, so the prompt arriv
in the first frame almost the instant you connect. In that case remove t
from BBS.TXT. 
 
(The following was added to the FAQ on 2000-Jan-06 as a result of someone sending a
bulletin to WINPAC @ GBR saying that all you needed in BBS prompt was  > .) 
 
Don't be tempted
it
sysop configures the BBS so you see something like this when you connect:- 
 

<        Welcome to GB7XXX!        > 
< A great BB
(1) GB7XXX BBS> 

Note all the  > characters!   If you put  >  in BBS prompt in WinPack, then 
a
 

ill also give you a problem if you don't 
WinPack has to collect the message list by connecting to th

rs will quite often surro
m
 

**************************************************************************
3. Problem: My local BBS has now changed over to FBB V

u
downloaded some messages, or that WinPack sticks at WAITPROMPT, or that 
automatic bulletin selection no longer works.) 
------------------------------------------------------------------------ 
Answer: There are
c
 

compressed download and compressed forward at all. You need to consult your sysop 
about getting the F flag set. 
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2. FBB V7 will not allow a user to use both compressed download and compressed 
forward in the same session. Therefore WinPack users should either not use 
com il>Mail Options>Compressed Forwarding), or they pressed forwarding (Ma
should edit PACKET.INI and put SPLIT_SESSIONS=TRUE in the [FBB] section. This 
stops WinPack trying to use both compressed forward and compressed download in the
same session. Please note that from V6.3 onwards Split Sessions can be set from the 

 

ail>Mail Options window in WinPack, so you don't need to edit PACKET.INI. 

 
, the best thing to do is to manually connect to the BBS and send the X 

ommand to put yourself in expert mode. WinPack does not handle the multi-line 

 
inPack BBS Prompt FAQ  (see FAQ #2 above.)  

. If 
options 

n the WinPack Options>Bulletin Columns.. sub-menu. 
 
5. ( e" in FBB V7 that can 
res ing as if a user's F flag isn't set, even though it is. If "Forward 
nly with known BBS" is set to "No", and the user ports have guest status, then the BBS 

lution is to set "Forward only 
ith known BBS" to "Yes", which is also a slightly more secure setting.  

********************************************************************************************** 

ed 

NC 
 output from the TNC reflect the 

ermanently on, which makes 
 a 

g of JP3 inside the TNC is used to control the behaviour of the 
CD. Again the default setting is that DCD is permanently on. 

*************************************************************** 
. Question: I am confused about the use of the speech "viewer" and the Sound 

Blaster Texto’LE program in WinPack V6.3! 

M
 
3. When a BBS changes over to FBB V7, the BBS prompt may change, so you may 
need to change BBS prompt in Personal/ BBS Info. If you find the BBS sends you a
multi-line prompt
c
prompt very well. Please Note that when you open the Personal/BBS Info dialogue, 
help is available if you press F1. Help on setting the prompt is also available in the
W
 
4. When a BBS changes over to FBB V7, the layout of the message list may change
you don't use the unproto headers, you may need to work through the various 
o

This point is really only of interest to sysops.) There is a "featur
ult in the BBS behav

o
will not accept a SID banner from a user. That means the users are unable to use 
compressed download and compressed forward. The so
w
 
6. If you have problems with FBB V7 after the sysop has changed over to it from FBB 
5.15, then tell him! He may also find a copy of this FAQ useful. 
 
**
4. Problem: When I use WinPack with my PK-232, WinPack thinks that the TNC is 
connected all the time. (More or less any other AEA/Timewave TNC can be substitut
for PK-232). 
------------------------------------------------------------------------ 
Answer: With most AEA/Timewave TNCs it is most important that you use the T
command DCDCONN ON, this makes the DCD
connected state. The default is that the DCD output is p
WinPack, and many other programs, think that the TNC is connected. If the TNC is
PK-88 then the settin
D
 
 
*********************************
5
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------------------------------------------------------------------------ 
Answer: WinPack V6.3 has support for a special message "viewer" which can
to speak messages. An example speech viewer was supplied with the V6.3 update
this example viewer made use of the Sound Blaster Texto’LE program. The use of a 
speech "viewer" was an idea put into WinPack as an area for possible experimentation. 
Apart from being a novelty, with a little bit of development I'm sure it could have some 
practical uses. 
 

 be used 
, and 

 
 

 
 controversy which has occurred on 

e UK packet network about what Sound Blaster packages include Texto’LE, all I can 

********************************************************************************************** 

 

The actual speech "viewer" is SPKVIEW.EXE. As distributed with the WinPack V6.3 
update, that calls Texto’LE, but it was never my intention that SPKVIEW could only be 
used with Texto’LE. The idea was that alternative text to speech programs could be 
patched in by altering SPKVIEW.INI. Also, I hope that other people might produce
better speech "viewers" than SPKVIEW. The structure of SPKVIEW.INI is described in
SPKVIEW.TXT. Please note that there is an error in that file - the key to activate the
speech viewer is Ctrl+T, not Ctrl+S. As regards the
th
say is that I have an SB16 "Plug and Play" card. With that I received a CD labeled 
"Sound Blaster CD", and one of the utilities on that CD was Texto’LE. 
 
**
6. Problem: I am using WinPack with a Kantronics TNC. I am also using Windows 95 
and the COM port on my PC is fitted with a 16550 (buffered) UART. I use compressed
forwarding. I can upload small messages to the BBS ok, but when I try to upload a  
longer message, such as a 7plus part, I get an error message and WinPack discon
from the BBS. 
------------------------------------------------------------------------ 

nects 

nswer: When Kantronics TNCs are used with Win 95 and 16550s, there seems to be 
 

lls and it signals busy, it 
en does not have enough room left in the buffer to accept the few characters that may 

ith other types of Kantronics TNCs. I have never seen it happen with any 
in 95 comms drivers and the 

nd 
AM.  

h 
 the 

l if you want to use 9600 
aud on air:- 
 In Control Panel, select System, Device Manager, Ports (COM & LPT) and then 

 the 

A
a problem in that when the input buffer of the TNC gets full, overrun occurs and one or
two characters are lost. My guess is that when the TNC buffer fi
th
be queued in the UART. 
 
I have personally observed this problem with a KPC-3 and a KAM, and I have reports of 
it happening w
other make of TNC. The problem occurs between the W
TNC, it is not a problem in WinPack. One solution is to run the link between the PC a
the TNC at no faster than 2400 baud. This is the technique I used when I had a K
 
However, Ken, GW3TMH, reports that he has successfully tried a different solution wit
his KPC-9612. His method is technically superior, because it allows the link between
PC and the TNC to be kept at a high speed – which is essentia
b
•

Properties, Port Settings, Advanced... for the port you use with your TNC. 
• Leave "Use FIFO buffers" checked, but move the Transmit Buffer slider fully to

left.  
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This disables the transmit FIFO on the port, but leaves the receive FIFO working. 
A final comment - like with any other TNC, you must use a cable that connects the 
RS232 handshaking lines. A simple three wire cable is not sufficient. See the 
Suggested TNC Settings. 
 
************************************************************************************************ 
7. Problem: I sometimes get gaps between the message numbers in the bulletins list. I 
m using the FBB unproto beacons. 

 

er 
e BBS to roll 

ack by more than its limit, then it sends a special unproto message to your system 
s 

our WinPack system switched off. The last message number you 
our system has been off, the 

 

nly 100, so it sends an instruction to your system to update 
our message pointer to 10,901. The BBS then sends the unproto beacons for message 

 

umbers is then skipped, etc.) 

oved, I have had extreme difficulty connecting to it. It's as if WinPack 

----
 

a move to 12.5 kHz channel spacing. 

a
------------------------------------------------------------------------ 
Answer: There will always be some message numbers missing, because WinPack will 
not include other people's personal mail in your list. However, if you find that a whole
block of numbers is missing, and this correlates with having had your system 
turned off for some time, then it is because of the following:- 
 
When you send an unproto sync request to an FBB BBS, the BBS will only roll back the 
unproto beacons up to a set number of messages. How many it will roll back is set by 
the sysop and varies widely. My local BBS will roll back up to a few hundred, but oth
BBSs may have the limit set as low as ten. If your sync request asks th
b
telling it to update your message pointer, this results in a gap occurring in your bulletin
list.  
 
The following example may help:- 
 
You have had y
received before you switched it off was 10,000. Whilst y
BBS has seen another 1,000 messages, so its latest message number is 11,000. The 
sysop has set up the BBS so that the Unproto beacons will only roll back by a maximum
of 100 messages. You switch on your system and it sends a sync request based on 
message number 10,000. The BBS sees that this would mean rolling back by 1,000 
messages, but its limit is o
y
numbers 10,901 to 11,000. 
 
(This is actually a slight simplification, because if you have any personal mail between
message numbers 10,000 and 10,901, the message numbers will be skipped only up to 
your first personal message, that number is then beaconed, and another block of 
n
 
************************************************************************************************ 
8. Problem: Like most BBSs in the UK, my local BBS has recently moved frequency. 
Ever since it m
doesn't want to work on the new frequency! 

-------------------------------------------------------------------- 
Answer: The recent move of the packet BBS frequencies in the UK also coincided with
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Many BBSs and users have effectively ignored this and are still using exactly the sa
filters and deviation settings in their rigs on the new 12.5 kHz channels as they

me 
 

kHz channels. However, some BBSs, when they moved, 
tted 12.5 kHz receive filters. Your BBS sysop can tell you what filter his BBS is using. 

reat difficulty connecting. The solution is to reduce 
ntil you can connect reliably.) 

nswer: WinPack does not have its own Baycom driver, but WinPack can be used with 

previously used on the 25 
fi
 
If the BBS is using a 12.5 kHz filter, and you are still transmitting with your deviation set 
to around 5 kHz, then you will have g
your deviation to around 2.5 kHz. (Or just turn it down u
 
************************************************************************************************ 
9. Question: I want to use WinPack with my Baycom modem. How do I do it? 
------------------------------------------------------------------------ 
A
a Baycom modem via the BPQ node software or via Flexnet or AGWPE. 
 
Baycom/BPQ/WinPack 
------------------ 
I would be the last person to suggest that this is easy to set up! However, a lot of peo
have managed it. You need to load the BPQ node software underneath Windows, 
config

ple 

ured to use a Baycom driver. You then run WinPack in BPQ mode (this is 
elected from Options>Comms Setup). 

PQ is quite a complex piece of code, it has a lot of documentation with it, but it is in 
it. The 

y 

m 

s
 
B
several DOC files, so you need to do quite a bit of reading to work out how to use 
version of BPQ you need is 4.08a - it is the last version that was released and the onl
version with support for running underneath Windows. 
 
The Baycom driver you should use is the NODE2BAY package which is available fro
the WinPack web site. Do not try and use a DOS BPQ/Baycom driver such as 
BPQAX25. If you get it to work underneath Windows you will be very lucky, because 
there are sound technical reasons why it shouldn't work! 
 
The NODE2BAY package contains a file called NODE2BAY.TXT, which gives some 

ee also using WinPack with BPQ

useful information on setting up BPQ. PLEASE take note of the comments about 
possible problems with the CTS output of some Baycom modems when used with 
modern motherboards! 
 
S . 

lexnet . Since Flexnet has its own Baycom 
em. To use PC Flexnet with a 

 
Baycom/PC Flexnet/WinPack 
------------------------- 
From V6.3 onwards WinPack supports PC F
driver, it allows you to use WinPack with a Baycom mod
Baycom modem, you must be running Win95. 
 



13. Trouble Shooting and FAQs 

 
WinPack User Manual    version 6.80 153 6/13/2002 

A description of PC Flexnet and what it does is beyond the scope of this note. See 
using WinPack with Flexnet for more information and the URL for the Flexnet web site. 
 
Baycom/AGWPE/WinPack 
------------------ 
Using WinPack’s AGWPE host mode, you can interface with AGWPE which can 
interface with a Baycom modem  (may only work with some versions of Windows -- 95, 
98 – although this may change). A explanation of  the AGWPE/Baycom setup is 
beyond the scope of this note. See AGWPE host mode for more information and the 
URL for the AGWPE web site.  (Alternatively, you could use your computer sound card 

---------------------------------------------------------------------- 
n option on WinPack V6.1 and later. If you select Help>Help 

istration, then you will find all the information you need. Registering 

 the easiest and cheapest way to 
gister. (see the Registration section

as a modem with AGWPE instead of using your Baycom.) 
 
 
************************************************************************************************ 
10. Question: I don’t live in the UK. How do I register WinPack? 
--
Answer: Registration is a
Contents>Reg
WinPack gets rid of the "unregistered copy" nag boxes. I appreciate that paying the 10 
UK pounds registration fee from overseas can be a bit of a problem.  
 
Online registration by credit card is by far
re ) 

. In most countries you will find that your bank can supply you with an International 

 US dollars, Australian dollars, 
nd all major EU currencies. Please calculate the amount at the current exchange rate 

 
Here are some ways you can pay, in my order of preference:- 

******************************************************* 
1. Problem: I have a lot of fonts on my PC, but when I select any of the font options in 

s. 
--------------------------------------------- 

 not suitable. 

 
If, for some reason, you do not want to register online, here are some other ways you 
can pay, in my order of preference:- 
 
1
Money Order. This is effectively a cheque made out in UK currency and drawn on a UK 
bank. 
 
2. I can accept cash payment in the following currencies -
a
+ 15% to allow for the cost of me changing the money. 
 
3. A personal cheque (check). Again, please add on 15% to allow for the cost of me
negotiating the cheque. 
 
*****************************************
1
WinPack it only offers a few font
---------------------------
Answer: The only fonts which are really suitable for packet use are fixed pitch fonts 
which support the ASCII character set. Most Windows fonts are proportionally spaced 
and support the ANSI character set, so they are
 

http://www.ui-view.com/winpack/bpqjjf.htm
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If you use proportionally spaced fonts in WinPack, then the bulletin list and any 
messages which are set out in a tabular format will look a complete mess. Fancy 
signatures will also look a mess. 

 which support the ANSI character set, then some characters will be 
ures 

en font and so is not 
vailable for printing. 

 

orrupted. 
) Your PACKET.EXE file has become corrupted. 

's up to you to find out which of the above is irrelevant. A re-installation from files 

 
If you use fonts
displayed incorrectly. In particular the line drawing characters often used in signat
will be incorrect. 
 
Whenever you start WinPack, it causes Windows to temporarily install the special 
WINPACK font. Unless you have a really good reason to use a different font, you 
should always use the WINPACK font. However, it is a scre
a
 
************************************************************************************************ 
12. Problem: WinPack Won't Run! 
-------------------------------------------- 
Answer:  If, when you start WinPack, it immediately shuts itself down without a warning
message, there are three possibilities:- 
 
(a) You have a WINPACK.REG file on your system that has become c
(b
(c) PACKET.EXE has been "infected" by a virus. 
 
It
downloaded from the WinPack website   http://www.ui-view.com/winpack/index.shtml 
should fix that. 
 
Also, WinPack installs some Visual BASIC support files in your WINDOWS\SYSTEM
directory. If you have severe problems running WinPack at all - e.g. it persistently 
stops 

 

with GPF messages, or the screen colours are weird, then check to see if there 
re old copies of any of these files in your WINDOWS directory. If there are, try moving 

MDIALOG.VBX, MCI.VBX, 
SCOMM.VBX, and THREED.VBX 

a
them into a temporary directory where Windows can't find them. You should be able to 
safely delete them, but I wouldn't do that until you are happy that all your applications 
still run ok. The files concerned are:- VBRUN300.DLL, C
M

 



 

 
inPack User Manual version 6.80 

155 6/13/2002 

APPENDIX 

A. Menu Layouts  
 

iles Menu F
Edit Window 
Selecting this opens a special Edit Window in the bottom hal
the screen. It has the same effect to pressing the Edit button
S

f of 
. 

electing this option when the Edit Window is already open hides 
the window. The Edit Window has its own submenu which is 

 Edit Window

accessed by pressing the right mouse button. 
 
If you hide the  whilst you are composing a message, 

ide the window and either Send or Abandon 
the message. To remind you that the edit is still effectively active, 

e n allows you to open a capture file. All received text will be stored in 
 kept 

e 

te 

the message is not abandoned. You remain in "composing mail" 
mode until you unh

the image on the Edit button has a red box drawn round it. 
 
Capture 

lecting this optioS
the file until you close it by selecting the option again. Capture files will normally be
in the CAPTURE subdirectory. This option has the same effect as pressing the Captur
button. 
 
Send 
This option allows you to select a file, which will then be sent to the TNC. Please no
that this option should only be used for text files. See also Using Drag and Drop. 
 
Delete 
This option allows you to delete files from a dialogue window that will open. When you 
have selected a file to delete, you will be prompted for confirmation before it is deleted
You can delete multiple files by clickin

. 
g one file name and then holding the shift key 

down and clicking other file names. 
 
Print 
Selecting this menu option allows you to print the contents of one of the WinPack text 
windows. For more information see Printing from WinPack. 
 
Exit 
This option allows you to exit from the packet terminal. 
 
Besides the above options, this menu may also display some WinPack "Add-On" 
options. These will come between Print and Exit. (see WinPack Add-Ons) 

W
0 

http://www.ui-view.com/winpack/index.shtml
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Edit Menu 

These menu options are only active in certain conditions, e.g. when you are in a window 
with text. Even then some options will be gray-ed out and in active. 

Cut  Ctrl+X 
If you select this optio . 
 
Copy  Ctrl+C 
If you select this optio
 
Paste  Ctrl+V 
This option is only av

 

 

n, the currently highlighted text is cut and placed on the clipboard

n, the currently highlighted text is copied to the clipboard. 

ailable if the Edit Window has the focus and there is text on the 
t causes the text from the clipboard to be pasted into the window at

+Q 
ailable if the Edit Window 

clipboard. Selecting i  
the cursor position. 
 
Paste & Quote  Ctrl

his option is only avT has the focus and there is text on the 
 Selecting it causes the text on the clipboard to be pasted into the window and clipboard.

then quoted as if you had pressed <F10> and selected "Quote" from the pop-up menu. 
 
The idea of this option is to make it easy to quote text from a message to which you are 
replying. You mark the passage you want to quote, select "Copy", put the cursor in the 
Edit Windowand then select "Paste and Quote". 

 

 
 
Many on thes menu options are also accessible by right-clicking in the window with the
ext. t
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Mail Menu 

 

l mail

 

Read Mail 
This option allows you to read persona . 
 
Write a Message 

personal message or a bulletin. See also the write 
This option allows you to  write a message - either a 

message window. 

Edit a Message 
This option allows you to edit a message that you have 

ail 

opy A Message 
 easily send someone a copy of a message that you have 

aded into the Edit Window

 

already written and which is currently in your outgoing m
queue t. 

 
C
This option allows you to
already written and which is currently in your outgoing mail queue. You select the 
message you want to copy and the write a message header form is displayed. When 
you fill in the recipient information and click OK, the message you selected to copy is 
lo . 

ou have already written which is 
urrently in your outgoing mail queue 

eading bulletins

 
Delete a Message 
This option allows you to delete a message that y
c
 
Read Bulletins 
See r  
 
Auto BBS Session 
See running an Auto BBS session 
 
Mail Options 
This option displays a form which allows you to specify whether you want to use 
compressed forwarding and also whether you want to use the FBB unproto message list 
beacons, if they are available from your local BBS. For a full discussion of this topic see 
mail options. 
 
Repair Bull List 
This option allows you to repair the bulletins list should it ever become corrupted for any 
reason. It makes sure that there are no corrupted lines in the list and that no bulls are 
marked with Y or 'N' if the downloaded bull no longer exists. Corruption is unlikely to 
occur, but one sure sign of it is when you click a bull marked Y or N to read it, and 
nothing happens. 
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NUM 

This is an advanced option s unlikely that most people will ever need to use it. It is 
only in WinPack to compensate for a  problem which occurs very occasionally with FBB. 
 
WinPack has an internal vari roto 
headers, LASTNUM is used in deciding the sync request number. If you don't use the 
unproto headers, but your Li  Personal/BBS Info is set to something 
like LR $NUM-, then the valu
command is sent to the BBS
 
On very rare occasions FBB BBSs seem to misbehave and will refuse to send the 
beacon corresponding to a particular message number, so WinPack repeatedly syncs 
on a number and the BBS ins er. 
Or FBB will not respond corre
"LR 12345-" which means "list all bulletins from 12345 onwards", and the BBS will 

spond "There are no messages", even though there are lots of bulletins with numbers 

s. 

 you are absolutely sure about what you are doing! 

cts any SEND servers

Change LAST
! It i

able called LASTNUM. If you use the FBB unp

st Bulletins field in
e of LASTNUM is substituted for $NUM when the 
. 

ists on sending the headers starting from the next numb
ctly to an "LR nnnnn-" command. E.g. WinPack sends 

re
higher than 12345. 
 
This menu option allows you to adjust LASTNUM and so work round these problem
The most you should ever need to adjust it is upwards by one. 
 
Don't use this option unless
 
 
Test Servers 
This option allows you to see what effe  you are using will have on 

e messages they send. It is mainly for use with servers that add HTML content to 
 introduced in WinPack V6.41, because there was an obvious problem 

g HTML "blind" and often had no idea what their messages 
oked like when viewed by the recipient. 

il “out box” can be selected and you can specify 
hich servers you want to test. A copy of the message is then processed by the 

rs and put in WinPack’s \TEMP directory with the name TESTMESS.TXT 
how 

ecause some servers (carbon copy servers, etc) result in messages being put in the 
nd MAIL\SEND directories, WinPack checks what messages are in 

 

th
messages. It was
that users were sendin
lo
 
A message that is waiting in the ma
w
selected serve
so you can look at it and see what changes the servers have made. You are told 
big the message is. If the message contains HTML, you are offered the option of 
viewing it with your HTML viewer. 
 
B
MAIL\RECEIVE a
these directories before the servers are run, and removes any messages that are 
created as a result of testing the servers. If it didn't do that, you could finish up sending
out large numbers of duplicated messages! 
 
 



Appendix A. Menu Layouts 

Action Menu 

support. 

 list of 
able signature files and you can pick which one you want 

 

ptions

 
Note - Some of the options on this menu will be “gray-ed out” 
and inaccessible if you are not using the features they 
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Signature 
Selecting this option will allow you to add a signature to a 
message you are writing. You will be presented with a
avail
to use. 
 
Note that if you use the Signature button rather than this 
menu option, then the default signature is used - you won't be 
able to select your signature. (However, right clicking on the

Signature button gives a short cut to this menu option). 
 
See also Signature O . 

Pause 
ormally the receive windows will automatically scroll as new dN ata is received so that 

to 

rrives the screen scrolls down again! 

s it off. 

the latest data is always visible. This can be a nuisance if you are trying to scroll back 
iew something that has gone off the screen, because as soon as some new data v

a
 
If you select this option then the automatic scrolling is disabled and so you are able to 
scroll back and view previous data. Don't leave pause on for too long, because while it 
is enabled all new data that is received is put into a buffer, which can only hold about 
30,000 characters. 
 

electing the option whilst pause is on turnS
 
This option has the same effect as pressing the Pause button. See also automatic 
pause facility. 
 
 
Disconnect 

ressing this button should cause aP  disconnect (assuming you are connected to 
somebody!) It sends a Control+C and then D to the TNC. It has the same effect as 
pressing the disconnect button. 
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Auto BBS Disable 
 this option is checked, then Auto BBS sessionsIf  will be temporarily disabled. The 
etting is not retained - if y

start WinPack. If you wan
s ou check the option it will be unchecked the next time you 

t to permanently disable Auto BBS sessions, use 
r, and remFile>Selection List Edito ove all the times from the Auto Times List. 

 
 
Unproto Buffer 
This option is only available if your BBS is using the FBB beacons (see FBB unproto 
lists).This option displays 
currently being held in memory waiting for gaps in the list of received beacons to be 
filled. It gives an idea of how well, or how badly, you are receiving the beacons from 
your local BBS. Gaps occ
 
With perfect reception of t

essage header, preceded by 
y is always padded with '0's to 

 WinPack to easily sort the headers into numerical order. 
(The message number in the header is left justified and so will not always sort into the 

order). 

a form which shows any FBB unproto beacons that are 

ur when your system fails to hear beacons.  

he beacons, the list will always be empty and the option will 
be unavailable. If there is a list, each line is the text of a m
 second copy of the message number. This second copa

6 digits in length and enables

correct 
 
Ctrl+B provides a shortcut to this option 
 

tatistics S
This option gives a display of some statistics relating to the current WinPack session - 
Start time, up time, number of auto sessions, number of messages downloaded and 
uploaded, and comms errors. NOTE - comms errors are not reported if you use BPQ, 
AGWPE or TFEMU, because with all those modes the COM ports are controlled by the 

ost software, not by WinPack. See also Comms Error Logh . 

n, towards the left-hand end, is a 

ync Request 
electing this option sends an FBB sync request to the local BBS. This is intended to be 

ence to the old method of using F5, which runs a script to send the sync 
 The 

ill 
han 20 seconds have elapsed since the last one was 

ent. 

 
ouble clicking on the status line on the main screeD

short cut to this option. 
 
S
S
used in prefer
request. (However, F5 will still work.) Shift+F5 provides a shortcut to this option. 
option is only available if you are using the FBB beacons. Please Note - WinPack w
never send a sync request if less t
s
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Stay Connected 
If you select this option during an Auto BBS session, when the session ends WinP
won't disconnect you from the BBS. However, please note that if the session uses 
compressed forwarding, this option will not be ava

ack 

top Tune 
ing a WAV or MIDI file, selecting this option will stop it. 

ilable. 
 
 
S
If WinPack is play
Alt+[Backspace] provides a shortcut to this option. 
 
 
Terminal 
If you are using BPQ, this option starts the BPQ Terminal. If you are running another 
ost mode, then it will start the Multi-channel Terminalh . Otherwise this option is not 

 
ise it. This option is only available if you are using a special host mode. 

therwise this option is not available and “gray-ed out. 

Host Reset 
 carries out a complete reset of the host mode firmware, and then 

 

available and “gray-ed out”. 
 
 
Host Initialise 
If host mode communications with the TNC is lost for any reason, this option allows you
to try to reinitial
O
 
 

This option
reinitialises it. It is only available with some special host modes. Otherwise this option is
not available and “gray-ed out”. 
 



 

Options Menu 
 

 

W
0 
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to 
portant operating parameters. See Personal/BBS Info

 
 

Personal/BBS Info 
Calls up the Personal, BBS, and Log Information screen 
set im   

Comms Setup 
Calls up the Comms Setup screen to set important operating 
parameters. See Quick Start and  Comms Setup.  

Signature Setup 
See also Signature Options. 

have this option enabled and you also add a signature manually, you will sign the 
message twice! 

 
In other words, if you have Auto Sig enabled, don't use the signature button or the 
Signature menu option when you are writing messages. 

 
Default Signature 
This option allows you to choose which signature file you want to use as your default 
signature. This signature is used by the Auto Sig option, and also when you press 
the signature button. You will be given a list of available signatures, with the current 
default signature checked. 

7plus Setup 
See also 7plus

 
Auto Signature 
If Auto Signature is enabled, every mail message you write will have the default 
signature file appended to it. This means you don't have to press the signature 
button, or use the Signature menu option to sign it. BUT it also means that, if you 

 
 

Auto 7plus Decode 
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If this option is checked then all personal mail and bulletins are scanned as they are 
 if they contain 7plus data. If they do then the data is extracted and 

put in WinPack’s 7DECODE directory. 
 
When all the parts of a 7plus set have been received, the program will decode the 
file and send you a personal message as to whether the decode was successful or 
not. If it is successful then the parts are deleted. If it is unsuccessful then a .ERR file 
will be produced. 
 
Scan Capture Files 
If this option is checked WinPack will scan Capture files for 7plus

received to see

 parts. The 
scanning is done immediately after Capture is turned off. Any 7plus parts found will 
be identified in the log as coming from a capture file, apart from that the processing 
is exactly the same a
 
Keep 7plus Parts 
If this option is checked, then, when a set of 7plus parts have been successfully 
decoded, the parts o  
option is not checked
 

nly available if either the  Auto 7plus Decode or Scan Capture 
cked. 

e 
s 
u 

y available if either the  Auto 7plus Decode or Scan Capture 

ou to set the maximum part size used for 7plus messages sent 

s in the UK quite correctly forward "smallest first", so if 
very large part size, you will probably delay your own mail! 

s for mail. 

f the file are moved into WinPack’s 7PLUSOLD directory. If the
, then the parts are simply deleted. 

This option is o
Files option (above) is che
 
Log 7plus Decod
If this option is checked, then, every time that WinPack attempts to decode a 7plu
file, an entry will be made in the log file 7PLUSLOG.TXT. By looking at the log yo
can see when a file was decoded, if the decode was successful, whether it was 
received as a bulletin or as personal mail, and who sent it.  
 
Thi  option is onls
Files option (above) is checked, otherwise it is ‘gray-ed out’ and inaccessible. 
 
7plus Part Size 
This option allows y
by WinPack. The default is 4000 bytes. Personally I think that is quite adequate and 
nothing is to be gained by using a larger part size, but I have had so many requests 
to make the size a user option that I've finally given in! 
 
Don't forget that many BBS
you use a 
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Us
es access to a submenu that allows you to 

select when WinPack will use your sound card to 

cluster. Iit will tell you when someone is calling you with 
the  remote command, and it can make a sound when YAPP File Transfers

e Speech  
This option giv

announce various events. It can announce connections 
and disconnections, the arrival of new mail, the callsign 
and frequency of 'spots' when you are connected to a DX 

 /talk   
ter
 
The
a h
 
For more information see Speech

minate. 

re is also an option on the submenu to replay the last announcement. Control+L is 
ot-key to this option. 

. 

Pa
Thi
pas u can specify either NNA 
style or FBB sysop style passwords. See also Password Support

ssword 
s option allows you to specify if you want to use WinPack with a BBS that has 
sword access for its users. On this version of WinPack yo

. 
 
Fo
When choosing a font please bear in mind the following:- 
 

 From version 5 onwards, WinPack only makes available fixed pitch fonts. It also 

re 
making their own problems by choosing crazy fonts! 

ould make sure that "ANSI to 
ASCII" isn't checked on the Fonts... menu. Please Note - If you use an ANSI font 

 
• The default font for all the text windows is WinPack 11 point. You may prefer 

one of the other sizes. The 12 point is an exact replica of a DOS VGA font. If you 
have problems with the WinPack font, try Terminal. 
 

nts 

• Most Windows fonts are proportionately spaced, also most Windows fonts are 
ANSI fonts and cannot display the IBM ASCII graphics characters that are 
frequently used in packet messages.  
 

•
will not allow Windows to 'fake' a font style that doesn't really exist. These 
changes were introduced in an effort to stop complaints from users who we

 
• By default ANSI to ASCII character code conversion is applied to all keyboard 

input’, thus "ANSI to ASCII" will be checked on the Fonts menu. This is done so 
that extended ASCII characters, such as accented characters, can be keyed in 
correctly. If you wish to use ANSI fonts, then you sh

in WinPack, then recipients of your message may not see all the correct 
characters unless they also use a compatible ANSI font. 
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• On all the font selections for the text windows, the text background colour is 
always whatever you h  
Control Panel 'Color' u

 
Receive Window 1 
This option allows you to 
receive window. 

 

ion allows you to set the font size and text foreground colour for the lower 
receive window. 

This option allows you to set the font size and text foreground colour for the transmit 

 
dow 

it 

ave set for Window Background colour in the Windows
tility. 

set the font size and text foreground colour for the upper 

Receive Window 2 
This opt

 
Transmit Window 

window. 

Edit Win
This option allows you to set the font size and text foreground colour for the Ed
Window. 
 
Printer 

 option allows you to set the font characteristics for the printer. If you select a 
nd find a  near match for it. 

NB- if you get in a mess, the default font is Courier and the default size is 12 point. 

Bullet
 
On  y
your lo
Option

Fro
At 

Tit
and fo
messa

Bullet
 

Block Delete Bulletins 

line
hav  lines you must first kill the 
bulletin. If you enable Block Delete Bulletins, these lines will be deleted and the 
associated bulletins will automatically be killed. 

This
font that your printer doesn't support, Windows will try a

 

in Columns 

ce ou have got WinPack working and have collected your first message list from 
cal BBS, call up the Bulletin list (Mail>Read Bulletins), then go to this 
s>Bulletin Columns menu option. Use each item on this submenu in turn 
m 

To 
le 
llow the prompts on the status line to mark where each item is in your BBS’s 
ge header. 

in Deleting 

If you prune the bulletins list, or delete a block of lines from it, then normally any 
s within the deleted section for which a bull has been downloaded and which 
e a status of  Y will not be deleted - to get rid of those
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- you cannot delete bulletins with a status of *or N in this way. WinPack will NB

assume that if you have marked bulletins, you want to download them, and if you 
have downloaded them, you want to read them. However, bulletins marked D will 

espective of the setting of Block Delete Bulletins, because always be deleted, irr
they are 7plus parts from which the 7plus has been extracted and put in the 
7EXTRACT directory. 
 

ize 
 

 list will be pruned down to approximately the number of bulletins 
et by this option. For example if you have Bulletin List Prune Size set to 2,000 

0 lines in your bulletins list, then the first 8,000 lines will be 

The final number left in the list may be slightly more, depending on the setting of 
ulletins and whether you have any bulletins in the section to be 

he default value for Bulletin List Prune Size is 5,000. 

Lo

isconnections in a file called TEXT\TEXT.TXT. I'm not sure if this log is sufficent 
per' log. Any comments on this will be appreciated. 

Auto Dump 
p 

 and 

u have auto-dump enabled, then be warned that, if you are very active on 
ket, AUTODUMP.TXT can get very large very quickly! Every time you enable this 

, WinPack checks to see if AUTODUMP.TXT already exists, if it does then you 
ant 

and start again, simply disable and then re-enable the option. 

/Power 
This option allows you to select a different frequency and power to be used in the 

 starts up, the default is always to use the frequency and 

Bulletin List Prune S
If in Read Bulletins you click the Prune button, and you haven't marked a block of
bulletins, then the
s
and you have 10,00
deleted and the last 2,000 will be left. 
 

Block Delete B
deleted which are marked  *  or N. 
 
T

gging 
Auto Log 
If this option is checked then WinPack will log all connections and 
d
to replace a 'pro
 

This option allows you to enable or disable the 'auto-dump' facility. When auto-dum
is enabled, then, whilst you are connected to another station, all transmitted
received text is saved in the file TEXT\TEXT.TXT. 
 
If yo
pac
option
are given the option of overwriting the existing file or appending to it. So, if you w
to clear the file 
 
Log Frequency

auto-log. When WinPack
power as specified in your personal information and those values are automatical
added as the first item on the Log Frequency/Power sub-menu. 
 

ly 
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If you want other frequency/power options to be available, you must create a file in 
 is 

 

 on the menu, that frequency and power will be used in 
 

 
 
Co

This option gives access to a submenu that allows you to 

he LEDs, and the colour of the progress 
indicators in the YAPP

the WINPACK directory called LOGFREQ.TXT and put some settings in it. Here
an example of the required format for the data in this file:- 
 

144.650MHz/10dBW 
144.675MHz/10dBw 
432.675MHz/13dBW

 
When you select an option
log entries, but WinPack will always return to the default values when the program is
restarted. 

lours… 
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change some of the colours used in WinPack. You can 
change the background colour of the text windows, the 
colour of t

 and compressed forwarding 

 

Vie
For

windows. 

 
wers… 
 more information on what viewers are please see Viewers. 

Use Viewers 
f this option is checked, then WinPack will use viewers whenever a 

 

suitable viewer 
 it isn't checked, then WinPack will not attempt to use any viewers. 

he default is that this option is 

I
is available. If
 
Auto Viewers 
If this option is checked, then, if a viewer is available for a message, WinPack will 
se it without first asking "View this file using.... ?" Tu

not checked, and so WinPack will always ask before using a viewer. 
 
Ignore "^.TXT" In Titles 
If this option is checked, then a viewer for TXT files can be configured but it won't be 
used when reading bulletins or mail, even if the message title contain "^.TXT". The 
eason behind this is as follows:- r

 
The main idea of configuring a TXT viewer is so text files contained in 7plus ZIPs 
can be automatically viewed. (README.TXT, etc.) However, it has become a 
common practice to put "^.TXT" in bulletin titles (I think it's something to do with 
HTML converters). This results in the TXT viewer being triggered to read these 
ulletins, which can be annoying. b
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Scan For HTML 
If this option is checked (the default) then all messages are scanned for HTML, and
the HTML viewer is called (assuming you have configured 

 
one) if it is found that a 

essage contains HTML - that is how WinPack V6.3 behaved. 
 
If this option isn't checked, then the "^.HTM" trigger in the message title is used to 
decide if a mesage contains HTML - that is how WinPack V6.2 behaved. 

ot 

hough their reply doesn't contain HTML. The V6.3 technique is not so 
good when people put a small amount of HTML in a message, but the main content 
is not HMTL, because you tend to look at the message in the viewer and you don't 

on-HTML part. 

Split Window Option 
This option allows you to spl ile 
the screen is already split, th For 
more information select rece

m

 
Which is best depends on how the use of HTML develops. The V6.2 technique is n
so good when people send replies to HTML bulletins, and leave the "^.HTM" in the 
title, even t

see the n

it the receive screen into two windows. If you select it wh
en the single large receive window will be restored. 
ive windows. 

Word Wrap 
he receive windows may receive a text line that is too long for the screen. It this 

rizontal     scroll bars will appear which allow you to bring into view any 
ap':  when text reaches 

e right hand edge of the window, it wraps onto the next line, rather than disappearing 
off 
 
Ch
Normally, text keyed into the transmit window isn't sent to the TNC until <Enter> is 
pressed at the end of the line. This is usually the best way to operate. However, there 
are
imm a 
Tin occasions it is 
best to switch the program into character mode.  
 
In c
ope
the wn local echo of the characters. This does not 

ork very well in character mode and so, when you switch to character mode, it sends 
EC
 
If th  
nor
 

T
happens, ho
text that is off the screen. Alternatively, you can enable 'word wr
th

the screen. 

aracter Mode 

 some circumstances when it is necessary to send the characters to the TNC 
ediately when a key is pressed. For example, if you run the 'CAL' command on 

y-2, you need to be able to send the single letters K, D,  etc. On such 

haracter mode, the transmit window is not used, so you lose the split screen 
ration and the 8 transmit scroll-back buffers. The program normally operates with 

 TNC’s ECHO OFF and does its o
w

HO ON to the TNC. 

e program is already in character mode, selecting this option will switch it back to
mal mode. ECHO OFF will be sent to the TNC. 
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En
Sel
be ill 
sen oes not have a tick 
against itt. This option has the same effect to pressing the 'bell' button. 
 
Ctr
 
Re
Ena
you  a 
bee
run  
spo
 

o remain visible. This is useful since the 
following information is displayed on the icon label.:- 

ming 

able Beep 
ecting this option alternately enables and disables the program's 'bell'. The bell can 
useful if you are connected to the DX Cluster, since the default is that the Cluster w
d a 'bell' with every 'spot'. When the bell is disabled the option d

l+S is a shortcut to this menu option. 

store on Beep 
bling this option means that If the program is minimised (running as an icon) and 
 have the bell enabled, then the program will be restored to normal size every time
p occurs. The option was put in with the idea that you could leave the program 
ning as an icon whilst connected to the DX Cluster and it would 'pop up' whenever a
t occurred. 

 
Icon on Top 
If this option is selected then if WinPack is minimised (run as an icon) the icon will 
always stay on top of other programs ans s

 
1. If you are connected to the DX Cluster, the callsign and frequency from any inco
'spots' is shown (see also the DX Cluster support section). 
 
2. If you are carrying out a YAPP file transfer, the file name and the number of bytes 
that have been sent/received is shown. 

re 

 
Enable Remote 
This option allows you to enable or disable the WinPack remote commands. These a
the commands prefixed with / that are available to users of your system. See also 
Remote Access Commands. 
 

Show Button Hints 
This option allows you to enable/disable the hints that appear when you pause the 

g! 

 box. 

 If you find that the flashing Scroll 
ock gives you problems with other applications that you  run at the same time as 

WinPack, then the only solution is to disable this option. 

mouse over the buttons on the tool bar. You may find the hints useful or totally irritatin
 
Flash Scroll Lock 
If this option is enabled, then the keyboard Scroll Lock key LED will flash if you have 
unread mail in your mail
 
Please note that direct manipulation of the keyboard state in this way by a Windows 
application is not really good programming practice.
L
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Scripts Menu  
 
Play a Script 
This option allows you to play a script. For more information select about scripts. 
Ctrl+S is a short cut to this menu option. 
 
Edit a Script 
This option allows you to edit a script file. 

This option allows you to send a file using YAPP protocol. For more 
information see YAPP File Transfers

 
 

YAPP Menu 
Send a File 

  . See also Using Drag and 
Drop. 

e 

 
Receive a File 
This option allows you to receive a file using YAPP protocol. For more information se
YAPP File Transfers  . 
 
Receive Resume 

his option allows you to  resume receiving  a file using YAPT P protocol, when the link 
has failed part way through a previous attempt. For more information see YAPP File 
Transfers  . 
 
Auto Receive 
This option allows you to automate reception of files using YAPP protocol. For more 
information see YAPP File Transfers  . 
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Help Menu 

he Main Help file. 
 
View README.TXT 

ou to view the WinPack README.TXT file. 
This file contains some useful general information about the 
program (also included in this manual). 
 
 

View CHANGES.T
This option allows y
made between the 
 

iew LICENCE.TXT 
s you to view the LICENCE.TXT file, which outlines the conditions you 

 
Help Contents 
This option opens t

This option allows y

XT 
ou to view the CHANGES.TXT file, which describes the changes 
last base version of the program and recent updates. 

V
This option allow
accept by installing and using WinPack (also in this manual – see licencing ) 
 
View TELNET.TXT 

ou to view the TELNET.TXT file, which describes how to run This option allows y
WinPack via an internet connection instead via radio. (also in this manual -- see Telnet
 
Registration  

 

 Details
electing this option will display the registration information for this copy of the program 

/registered; if registered, registration details 

stration information, once you have registered 
your copy of WinPack. For more information on registering the program, see the 
Registration section of the help. (also in this manual – see registration

S
–not registered 
 
Register WinPack 

his option allows you to input your regiT

 
 
About... 
This option shows some information about the program. 
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 B. Button Bar 
 

 
The button bar is the row of buttons along the top of the main screen 

Customizing the B
The button bar can be

Show Button Hints 
 Button Hints menu option to enable/disable the hints that 

 

ttons 

utton Bar 
 customised in several ways:- 

Use the Options>Show
appear when you pause the mouse over the buttons on the tool bar. You may find the
hints useful or totally irritating! 
 
The Gap Between Bu
The buttons can be spaced farther apart by altering the BUTTON_GAP entry in the 
[TERMINAL] section of PACKET.INI. 
 
Changing The Icons 

button 

g out artistic talent, I was very near the end of the queue, so the 

on the icons themselves, so 
e buttons can now be edited by the user. They are in a subdirectory 

ne will 
 - they zip up 

 few kb. The "icons" can be either icons created with an icon editor (file 
). For example, if you want to 
ULL.BMP. If you use bitmaps, 

on't use a colour depth greater than 256 colours. 

Adding Buttons 
Buttons to run Add-ons/external programs can be added to the button bar. See 
WinPack Add-ons

I have been asked by a few people, from time to time, to change the icons on the 
bar with the black crosses on them. Either on the grounds of ugliness, or because the 
ifference between the active and inactive states is not very obvious. Unfortunately, d

when God was handin
existing icons are as good as you're going to get from me! 
 

owever, I am sure that some users will be able to improve H
all the icons for all th
of the main WINPACK directory called ICONS. It should be obvious from the names 
wihch icon belongs to which button. When WinPack starts, it loads the icons from that 
directory, if they exist, and uses them to replace the default ones. Perhaps someo
e able to produce a really nice collection and send them out on packetb

into only a
extension .ICO) or small bitmap files (file extension .BMP
create a bitmap file to appear on the bulls button, call it B
d
 

 for more information. 

 
W
0 
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What the Buttons Do 

Edit Button 

 

 
 
Pressing this button opens an Edit Window in the bottom half of the screen. It has the 

Edit Window is open the same  effect to selecting Files>Edit on the menu.. When the 

button will no longer have a cross or X on it . If you hide the Edit Window whilst you 
sage, the message is not abandoned. You remain in "composing 
nhide the window and either Send or Abandon the message.  

are composing a mes
mail" mode until you u
 
There is an edit submenu which can be  accessed from the Edit Window by pressing 
the right mouse button. Pressing the button when the Edit Window is already open 
ides the window To remind you that the edit is still effectively active, the image on the h

edit button is shown with a red box drawn round it   . 
 

Capture Button  
 
Pressing this button allows you to open a capture file. All received text will be stored in 
the file until you close it by pressing the button again. Capture files will normally be ke
in the CAPTURE subdirectory. This button has the same effect to selecting Capture 
from the Files submenu. When capture is on the button will

pt 

 have no longer have a 

cross or X on it   . 
 
 

Send  
 
Pressing this button allows you to select a file and send it to the TNC. It works like 
selecting the Send option on the Files menu. Please note that this option should only 
be used for text files, not binary files. 
 
 

Print  
 
Pressing this button allows you to print the contents of one of the WinPack  text 
windows. For more information see printing from WinPack. 
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BBS Session  
 
Pressing this button initiates an automated BBS session.  
 

Read Mail  
 

 

Write Message  

Pressing this button brings up the “Select a Message to Read” window. 

 
Brings up the "Write a Message" window. 
 
 

Bulletin  
 
Brings up the Bulletin List. See reading bulletins 
 
 

Signature  
 
This button allows you to add your signature from the default signature file to a 

added at the end he
message that you are creating. If the Edit Window is open then the signature will be 

 of t  text in the window. If the Edit Window is not open, but you are 
onnected to another station, then the signature will be sent to the TNC for 
ansmission. 

 
at t is button uses the default signature, if you want to select from a list of 

vailable signatures, use the "Signature" menu option. Right clicking with the mouse on 

c
tr

Note th h
a
the signature button gives a short cut to the Signature menu. 
 
See also Signature Options 
 
 

Word Wrap  
 
Pressing this button has the same effect as selecting 'Word Wrap' on the Options 

enu. When word wrap is on the button will no longer have a cross or X on it.   m
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Pause   
(get it? Paws...Pause) 

ormally the receive window
 
N  will automatically scroll as new data is received so that the 
latest data is always visible. This can be a nuisance if you are trying to scroll back to 

ing hat has gone off the screen, because as soon as some new data 
rrives the screen scrolls down again! 

 you press this Pause Button then the automatic scrolling is disabled and so you are 
able to scroll back and view previous data. When pause is on the button will no longer 

ave a cross or X on it. 

view someth  t
a
 
If

h   Don't leave pause on for too long, because while it is 
 into a buffer, which can only hold about 

0,000 characters. See also automatic pause facility
enabled all new data that is received is put
3 . 

ct

 

  Disconne
 
Pressing this button should cause a disconnect (assuming you are connected to 
omebody!) It sends a Control +C and then D to the TNC. 

This button will not work if you are in the middle of a YAPP File Transfer

s
 

  - you must first 
nsf  and then disconnect. abort the tra er

Window Button (only visible if the Split Window option is selected) 
 
If the receive window is split then this Window Button allows you to swap between the 
two  windows. If it shows 1 the upper window is selected, 2 means that the l
window is sele

ower 
cted. For more information select receive windows. 

 
If you are using WinPack in BPQ mode, this button is replaced by one that allows y
start the BPQ Terminal program. 
 

ou to 

Terminal (only visible in Host Mode; ) 

ee The Multi-channel Terminal
 
S . If you select Host Mode while operating with split 
receive windows, the Window button (above) is replaced with the Terminal button. 
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In & Out Boxes  

The In Box (picture of a mail slot) and Out Box (picture of a post box) 
how only if you have any new messages waiting to be read and if you have any 

ox, 

licking on the In Box has then same effect as selecting Mail>Read Mail. from the 

s
messages wa arded to the BBS. The numbers against the pictures show 
the number of messages in each box. If there aren't any messages waiting in either b
the images are not displayed. 
 

iting to be forw

C
menu. Clicking on  the Out Box is equivalent to selecting Mail>Edit a Message. 
.



 

W
0 
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C. Suggested TNC Settings 

rameter for your TNC. 

ith 
even Plus. 

BREAK ON 
I don't think all TNCs have this parameter, but Tiny 2's certainly do. It is either ON or 
OFF. The default is ON - don't change it! 
 
CMDTIME 1 
This is the "guard time" for sending three COMMAND characters to get the TNC out of 
transparent mode. Set CMDTIME 1, or whatever value equates to 1 second with your 
particular brand of TNC. 

CMSG ON 
It doesn't need to be ON, but if you put in some CTEXT and then wonder why it doesn't 
get sent when someone connects, it is almost certainly because CMSG is OFF! 
 
COMMAND $03 
This is the character that puts the TNC back into command mode when you are 
connected. The default is $03 (control C). If you change it you will probably struggle to 
get YAPP

 
While TNCs often have similar commands, the command or parameter names may be 
different. Listed below are suggested TNC settings for WinPack, but you may have to 
translate the command and pa

8BITCONV ON 
You must set 8BITCONV ON. If you don't then you will never have any success w
S

 to work. 
 
CTEXT Welcome to WinPack. Send /h for HELP... 
Some packet programs require you to put an SID banner in the CTEXT, e.g. something 
like [PROG-1.0-$]. You don't need to do this with WinPack and it isn't recommended 
because it might trigger another system into starting to try to send you mail. So simply 
make the CTEXT a friendly greeting. 

DCDCONN ON (AEA TNCs) 
On the PK232, PK-96 and probably some other AEA TNCs, you must set DCDCONN 
to ON. 

ECHO OFF 
ECHO OFF is recommended. If you have ECHO ON, then everything you key in will 
appear on the screen twice! 
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HEADERLN ON 

EADERLN ON. 

hould then be even more confused! 

F 

TREAMDB OFF 
OFF is recommended because TNCs running TNC-2 firmware, or 

t 

 $00 

 to 
end 7plus files unless this is changed to a non-printing character. STREAMSW $00 is 

d should be used unless you have a really good reason to use 

 you want to use the FBB Unproto List to collect your message list, you must set 
.g. UNPROTO GB7OPC) or to a 

 

If you want to use the FBB Unproto List to collect your message list, you must have 
H

MCON OFF 
MCON must be OFF. 

NEWMODE ON 
NEWMODE ON is recommended. If you want to know what it means, read your TNC 
manual, you s

NOMODE OF
NOMODE OFF is recommended. Same comment as above! 

S
STREAMDB 
derivatives of it, double the streamswitch character even when the TNC is in transparen
mode, the only exception being if STREAMSW is set to $00. (To me this seems to be 
incorrect behaviour!). 

STREAMSW
The stream switch character is the one thing that will definitely foul up 7plus transfers if 
the normal default setting of  |  (pipe character) is used. You will find it impossible
s
recommended an
something else. 
 
UNP O <bbs> ROT
If
UNPROTO either directly to your local BBS callsign (e
path via a digipeater that will enable your sync requests to be heard by the BBS (e.g. 
UNPROTO GB7OPC VIA STUMP). This is explained in more detail in enhanced mail
facilities. 
 
XFLOW OFF 

N/XOFF (software) flow control, please don't use it if Although WinPack supports XO
you have any intention of using compressed mail or YAPP file transfer. If you do, 
you'll get in a terrible mess and the TNC will probably have to be switched off and on 
again to bring it back to life. So set XFLOW OFF(hardware control), unless you have a 

ason for not doing. really good re
 

 



 

 D. Bulletin Topics Lists 
 
When sending bulletins, you are much more likely to receive a reply if you send them to 

elds) that are in common use. A lot of people select the messages they 
sing "L>" on FBB BBSs). 

  
PICS.TXT is in WinPack’s BULLS directory. It is a subset of a list 

 
he topics it contains:- 

 
Description 

 144MHZ  2m news 
6m news 

SAT (satellite etc) 
Amstrad computer 

Amat.Radio Television 
BARTG news & information 
Baycom H/W & S/W 

 Info about G8BPQ nodes 
CLOVER  Clover 

Commodore Computer (C128/C64) 

DOS   Disk operating software topics 
 DX   DX general information 
 DXCC  DXCC information 
 DXNEWS  Specific DX news bulletins 
 FAX   Fax information 

topics ("To" fi
read by topic (e.g. by u

The topics list TO
suggested by Brian, G8ASO. I have removed some that I thought were not used much
in the UK and altered one or two others. Here are t

 Topic  
 

 50MHZ  
 70CM  70cm news 
 9600  9600 baud operation help/info 
 AERIAL  Aerial topics 
 AMIGA  Amiga computer 
 AMSAT  AM
 AMSTRD  
 AMTOR  Info about AMTOR 
 APPLE  Apple PC (see MAC for Mac's) 
 ARCHIM  Archimedes 
 ASTRO  Astronomical news 
 ATARI  ATARI Computer 
ATV    
 BARTG  
 BAYCOM  
 BBC   BBC computer 
 BBCTX  BBS transmitter news 
 BEACON  Propagation Beacons information 
 BIKE  Motorbike topics 
 BPQ  
 
 COMMDR  
 CONTES  Contest news & information 
 CQ   Looking for act
 DCC   DCC information 
 DEBATE  Debate - general topics 
 DISABL  Disabled 

 packet cont s 

 

 
W
0 
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 FBB   Info about 
 FOOD  Recipies, e

F6FBB software 
tc 

FOOTY  Football (for GBR only) 

stem 
ELP  General requests for info/help 

information 
rmation 
system 

ormation 
rio gear 

rian Elements 

system 

s 
 comment 
rt & leisure 

A software 

t. 

 

 

 
 GIF   GIF files 
 GP   Graphic Packet help/info 
 GPS   Global Positioning Sy
 H
 HUMOUR  Jokes, amusing stories, etc. 
 IBMPC  IBM & compatible information 
 ICOM  ICOM gear 
 INET  Internet 
 INFO  General info
JNOS  JNOS tcp/ip  
 JVFAX  JVFAX inf
 KENWOO  Kenwood/T
 KEPLER  Satellite Kepla
 KPC   Kantronics gear 

ics  LANDY  Land Rover top
 LINUX  LINUX operating 
 LOTTER  Lottery information 
 MAC   Macintosh 
 MFJ   MFJ gear 
 MODEM  Modem topics 

info, equipment mod MODS  Request or 
 MORSE  Morse operating and

 spo MOTOR  Motoring news -
  MSDOS  Msdos info. 

 MUSIC  Music info. 
mation  NASA  NASA news & Infor

s  NEWS  News bulletin
 NNA   Information about G1NN
 NOS   NOS tcp/ip system 
 NOVICE  Novice news and information 
 OS2   OS/2 info. 

 gear  PACCOM  PacComm
 PACKET  Information about the packet ne
 PACTOR  Pactor 

E   PAK T  PAKET program info/help 
 PENPAL  Penpals info 
 PMR   PMR equipment mods, etc 

on topics  PROP  Propagati
 QRP   QRP topics 

on  RAE   RAE notes and informati
 RAFARS  RAFARS 
 RAIBC  RAIBC topics & news 

  RALLY  Rally news 
 RAYNET  Raynet 
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 RIG   Remote Imaging Group 
 RIPOFF  Ripoff comment!! 
 RMG   RSGB Repeater Management Group 

. 

tatistics 

 

 
ral 

 help/info 

ram help/info 
information 

nfo 

o 

rmation 
ite info (not Keps) 

 RNARS  RNARS 
 RSARS  RSARS 
 RSGB  RSGB 
 RTTY  RTTY general information 
 SAT   All satellite information 
 SATTV  TV Satellites 
 SCAN  Scanner info 
 SCHOOL  School & Education topics 
 SOLAR  Solar data, Flare etc 
 SPACE  SpaceNews items, etc
 SSTV  Slow Scan TV info 
 STATS  Network & mailbox S
 STOLEN  Stolen Ham Gear reports 
 SWL   SW Broadcast news
 TCPIP  TCP/IP topics 
 TECH  Technical Enquiries/Info
 TNC   TNC information, gene
 TPK   TPK program
 TREK  StarTrek 
 UFO   U.F.O's 
 UHF   UHF .. all bands above 1000MHz 
 UKIP  UK IP information 
 UNIX  Info about UNIX systems 
 UPAK  UltraPak prog
 VHF   VHF news amd 
 VIRUS  Computer virus warnings/i
 WAB   WAB info 
 WIN31  Windows 3.1/3.11 help/info 
 WIN95  Windows 95 help/inf
 WINPAC  WinPack program help/info 
 WX   Weather Info
 WXSAT  Weather Satell
 YAESU  Yaesu equipment info 
 



 

E. PACK T  File Settings E .INI

e s p in  for WinPack is held in a file called PACKET.INI which is in 
ority of the entries in this file are changed by using the 
owever, there are some things which can only be 

 has a header line, e.g. "[TNC]". The 

below, exit from WinPack before 
es will be reset when the program 

! 

ons on the button bar. The 

rmat for the date/time on the 
mm yyyy hh:nn" which gives a date/time like "02 

ll get ISO 8601 format. If 
"yyy  modification of the ISO 

ate/time formats being correct.) 

MI IZE and servers are run 

FOCUS - nd servers are given the focus 
 for versions of WinPack before 
hich worked with versions f 

ems to get stuck, 

If you want program to minimize itself after a period of inactivity, change the line that 
says MINIMIZE_TIME=0 to, for example, MINIMIZE_TIME=10. That will cause the  
program to minimize itself after 10 minutes with no input from you. 
 
MODEM_IDLE_SECS - if you are using WinPack in "modem mode

 
Most of th etu formation
the WINPACK directory. The maj
various WinPack menu options. H
changed by editing the file. 
 
The file is divided into sections, each section

t s ows afollowing lis h ll the entries that may be edited. 
 
If you need to change any of the options listed 

changyou edit PACKET.INI. If you don't all your 
is closed down

Section [TERMINAL] 
 
BUTTON_GAP - the gap, in screen pixels, between the butt

 0. default is
 

specify the foDATE_TIME_FORMAT allows you to 
 title ar. Th  "dd mWinPack b e default is

Nov 1998 13:45". If you use "yyyy-mm-dd hh:nn", then you wi
1SMD's suggestedyou use y-mmm-dd" then you will get G

8601 format. (Subject to my understanding of these d
NOTE!! Months are "mm" or "mmm"; minutes are "nn". 
 
EXTERN_ NIM D - controls whether external programs 

. minimized. The default is FALSE
 

grams aEXTERN_  controls whether external pro
when they are run. The default is FALSE, but the default

m w6.3 was TRUE. If you find a server or external progra
WinPack before 6.3 gives problems with V6.3 or later because it se
then put EXTERN_FOCUS=TRUE. 
 

" with a telephone 
modem and there is no activity on the phone line for this number of seconds, WinPack 
will disconnect you. The default is 60 seconds. 
 

 
W
0 
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NO_CONNECTED_NAME - this is the d
token, if the callsign of the currently conn

efault value for the $CONNECTED_NAME 
ected station cannot be found in the WinPack 

ddress book. See the tokens lista . 

r example, PAUSE_SECONDS=10. This will enable a 10 
econd auto-pause every time you scroll the screen. 

f all YAPP File Transfers

 
PAUSE_SECONDS - if you want the receive window to automatically pause when you 
scroll it instead of having to use the Pause button, change the line that says 
PAUSE_SECONDS=0 to, fo
s
 
PERMANENT_YAPP_LOG - WinPack creates a log o   . By 
efault the log is put in the MAIL\RECEIVE directory and appears as an X status 

t in the mail directory where it can be deleted easily, then put 
PERMANENT_YAPP_LOG=TRUE and the log will be put in the TEXT subdirectory. 

UB_DIR - this gives the path to the WinPack public files directory. The default is 

ECONNECT_DELAY - sets the delay in seconds before a script will try to reconnect if 

d
message in Read Mail. The idea being that you will get a message whenever any 
YAPP transfers have taken place and you can read it and then delete it. If you don't 
want the YAPP log pu

 
P
WinPack\PUB, you can replace it with any valid DOS path. 
 
R
a disconnection occurs, see about scripts. 
 
REPLY_QUOTE - right clicking on the Reply To Sender or Reply To Topic buttons 
whilst reading messages, will put you immediately into the Edit Window with any text 
you marked in the message quoted in the window. There will be a lead-in to the quote
text consisting of the sender's callsign and the words sp

d 
ecified by REPLY_QUOTE. 

.g:- 

> some quoted text 

IGHT_CLICK_WIN95 - from V6.4 onwards, if you are running Win95 and you right 

E
 

G4IDE wrote:- 

> some more quoted text 
> etc. 

 
If you put REPLY_QUOTE=* then there will be no lead-in text before the quoted text. 
 
R
click in the Edit Window, you immediately get the WinPack pop-up edit menu. On 
previous versions you first got the default Win95 menu for text boxes. If you want to 
keep the old behaviour, change RIGHT_CLICK_WIN95 from FALSE to TRUE. 

zone name and [nn] is an optional 
orrection to apply to your PC's local time. The default is "TIME_ZONE=UTC", that will 

put "UTC" on the Title bar and assumes that your PC clock is set to UTC, since no 
offset is specified. If your PC's clock is set to BST (one hour ahead of UTC), but you 

 
TIME_ZONE allows you to specify the name of the time zone to be displayed on the 
Title bar, and the offset of your PC's clock from that time zone. The format is 
"TIME_ZONE=AAA[nn]", where AAA is a time 
c
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want WinPack to use UTC, then you would put "TIME_ZONE=UTC1". From V6.41 
onwards, the time zone name does not need to be three characters long, although that 
will normally be the case. WinPack regards the name as ending with the first character 

hich is not a letter. 

ike the 

eral times to see if the program 
ould send a bull even if the user has clicked "Reply To Sender". My conclusion is that it 

at 

w
 
WARN_BULL - I have seen many bulletins from WINPAC users that looked l
sender intended them to be an SP. They have always been replies to bulls. In fact I 
have seen so many that I have checked the code sev
c
is user error. From V5.56, if you click "Reply To Topic", WinPack asks you to verify th
you really want to send a bulletin. You can disable this feature by putting 
"WARN_BULL=FALSE". 
 
ZIP and UNZIP - if you want to use WinZip instead of PKZIP/PKUNZIP for zipping 
7plus files and for unzipping 7plus zips for the viewers, you can put 
"ZIP=C:WINZIP.EXE -min -a" and "UNZIP=C:WINZIP.EXE -e -o -j". If you are using 

our copy of WINZIP. Note 
at you must use DOS compatible path names, i.e. no more than 8 characters, so 

 line "02 Nov 95". Experience tells me that dates in that format are universally 
nderstood and unambiguous! However, I was once told that a popular logbook 

program could not import a log with the date in that format, so a useful alternative might 
be 
 
LOG_FIELD1="A FIXED LOG FIELD" - you can put up to six fixed fields that will be 
ppended to the end of each log entry (LOG_FIELD1 to LOG_FIELD6). You can put 

ave to use any. This is to help with importing the WinPack log into logging programs 

ll 

SE_QUOTES=FALSE then the quotes will be omitted. 

Win95, the WinZip file name is probably WINZIP32.EXE. Don’t forget the ending 
parameters. Obviously you should input the correct path for y
th
PROGRAM FILES becomes PROGRA~1 
 
 

Section [LOG] 
 
DATE_FORMAT - the default is "dd mmm yy" which gives a date format in auto-log 
entries
u

"dd/mm/yy". 

a
whatever text you want in the fields, and use as many of them as you want, you don't 
h
that require some fields, e.g. RST, to be present. 
 
USE_QUOTES - the auto-log entries are in comma separated values (CSV) format. A
the fields are surrounded by quotes, which is correct. However, if you put 
U
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Section [FBB] 
 
AUTO_KILL - the default is that WinPack will kill personal mail after it has been 
ownloaded using FBB compressed mode. If you don't want your mail killed as soon as 

 

 saying that is 
 it to leave the message marked, so WinPack will try to 

ownload it again on subsequent connects, put AUTO_RETRY=TRUE. 

WinPack does an 
't, 

ts are 

 it 
his is ever necessary! 

OWNLOAD_RESUME - if FBB compressed download is used, then WinPack 
supports download resume. This means that if you are downloading a message and you 

, WinPack will tell the BBS to start downloading again from where the 
terruption occurred, so the whole message doesn't have to be resent. This feature of 

82 
d. 

e. 

_A_SYSOP - normally WinPack will not put other people's personal messages in the 

AX_SYNC_REPEATS - this is the number of times WinPack will send a resync to the 

 it, you 
th to the BBS is too poor. 

nless you haven't got HEADERLN ON in your TNC settings!) 
 
PERSONAL_MSG_TYPES - this specifies what types of message should be regarded 
as personal messages, the default is AP, and I doubt if it would ever need altering. 
 

d
you have downloaded it, put AUTO_KILL = FALSE. NB- This only applies to 
compressed download, if you are not using compressed download, then the mail will
always be killed. 
 
AUTO_RETRY - by default, if a message is unavailable on the BBS, WinPack will 
remove the selector indicator * from it in your list and send you a message
is unavailable. If you want
d
 
CHECK_LINK_STATE - if you are using the FBB unproto beacons, 
awful lot of checking to make sure that it doesn't send a sync request when it shouldn
e.g. when it is connected ot another station. If you are convinced that sync reques
sneaking out when they shouldn't then putting an entry of 
CHECK_LINK_STATE=TRUE will cause WinPack to do even more checking before
sends a sync request. I will be surprised if t
 
D

get disconnected
in
FBB seems to be undocumented. It has been implemented by observing what TPK 1.
does and by analysing the data that FBB sends when a download resume is requeste
If WinPack finds the BBS is FBB 5.15, it will automatically enable download resum
You can over-ride this by setting DOWNLOAD_RESUME to TRUE or FALSE. 
 
IM
bulls list, even though they are broadcast in the FBB unproto beacons. The reason is 
that there is no point putting them in the list because normally you can't read them. If 
you have sysop privileges, then you my wish to put IM_A_SYSOP=TRUE, which will 
result in all the personal messages being put in the list. 
 
M
BBS for the same message number before it gives up and sends you a System 
message. The default is 20. You can change it, but if you need to increase
shouldn't be using the unproto beacons, because your pa
(U
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RESUME_ALLOWED - if your local FBB BBS indicates that it supports FBB forward 
 1 protocol), then WinPack will use that protocol. If you want to stop it 

sing forward resume for any reason, then put RESUME_ALLOWED=FALSE. 

 using a 

E". Please Note - V6.1 and earlier defaulted to FALSE. 

y default WinPack removes the R: lines from messages. If you put 

 by TIME_OUT and return to 

 you are reading bulletins

resume (version
u
 
SEND_FQ - the default of SEND_FQ=TRUE means that, after using FBB compressed 
forward, WinPack will disconnect from the BBS by sending "FQ" rather than by
hard disconnect. If you want it to use a hard disconnect, you must put 
"SEND_FQ=FALS
 
 

Section [BULLETINS] 
 
B
STRIP_R_LINES=FALSE, then it leaves them in. 
 
If you leave WinPack on the read bulletins screen, then it will time out after a default of 
10 minutes of inactivity or whatever other value is specified
the main screen. If you put TIME_OUT=0, then it will never time out. 
 
If  and you select the To button, WinPack will prompt you as to 

er want 

ee Using Short cut Keys

whether you want to create a list of all topics in the message base. If you will nev
to create a list of topics put TOPICS_LIST=FALSE. If you always want to create a list of 
topics and don't want to be prompted every time, put TOPICS_LIST=TRUE. 
 
 

Section [SHORTCUTS] 
 
S . 

y default WinPack is BPQ

 
 

Section [BPQ] 
 
B  application 1, which means it is the application that uses the 

=4". 

 application number, 
dit the APPLICATION entry. 

BPQ BBSCALL and responds to the command BBS (or better, PMS) from the node. If 
you want it to have another application number, put, for example, "APPLICATION
 
If you want to use the NODECALL for outgoing connections, put 
USE_BBS_CALL=FALSE. If you want to change WinPack's BPQ
e
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Section [WINPTF] 
(deals with TF host mode) 
 
INIT_ALL_CALLS - when used with TF firmware, WA8DED firmware, or PC Flexnet 
and TFEMU, WinPack initialises the callsign on channel 0 and channel
up to whatever callsign has been set in Personal/BBS Info

 1 when it starts 
. Unless you often change the 

allsign on the terminal channels to a completely different callsign, initialising channel 0 
nd channel 1 is quite adequate. If you do use different callsigns (note - different 

callsigns, not different SSIDs) on the terminal channels, then putting 
E will make sure that all the callsigns get reset to the the 

efault callsign each time you start WinPack, but it makes WinPack take slightly longer 

FEMU_POLLRATE - if you use WinPack with PC Flexnet and TFEMU

c
a

INIT_ALL_CALLS=TRU
d
to start up. 
 
T , WinPack 
constantly polls TFEMU for received data. The default is that it polls it 20 times a 
second. You can, if you wish, set a lower poll rate, but this variable was really put in for 
my own experimentation during development. 
 
TFPCX_INT - if you use WinPack with PC Flexnet and TFEMU, WinPack expects 
TFEMU to be using DRSI style software interrupts. (I.e. TFEMU loaded with the 
command "TFEMU -dx"). If, for some reason, you wish to use TFEMU with TFPCX style 
software interrupts, then you must put TFPCX_INT=TRUE. 
 

Section [MAIL] 

_ALLOWED - if you put T_ALLOWED=TRUE then WinPack will allow you to send 
s 'P' and B. This is only of use in countries where NTS 

affic is carried on the packet BBS network. In the UK you should NOT send type 'T' 
essages. 

 
 - the maximum length of the title for a message. The default is 30 

haracters. (The exception to this is that if you reply to a message, then "Re: " is added 

cross a network: 
 of the mail directories 

RECOUNT_MAIL - enables rescanning of mail on the PC that is running WinPack if the 
mail directories are also being accessed from a remote PC. 

 
T
messages of type 'T' beside
tr
m

TITLE_LENGTH
c
to the original title and the length restriction does not apply.) 
 
Please Note - The following two entries are only relevant if you are using WinPack 
a
RECOUNT_INTERVAL - the number of minutes between rescans
when WinPack is being used across a network. 
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Section [PRINTER] 

IGHT_MARGIN_MM - set the printer margins. 

r 

 
LEFT_MARGIN_MM and R
 
 

Section [YAPP] 
 
SHOW_TIME_ESTIMATE - if you want to disable the display on the YAPP transfe
window of the estimated time remaining, put SHOW_TIME_ESTIMAT
 
 

E=FALSE. 

ection [UIV_VIEWER] 
 UIV 

er, 

PPLICATION - The file name, without path or extension, of the program acting as the 
d 

W.EXE 

OPIC - The DDE topic used by the UIV viewer, the default is UIVIEWDATA. 
 

item used by the UIV viewer, the default is LABCOMMAND. 

se 
 

ee the Viewers

S
This section allows you to change the DDE definition for the application used as the
viewer. The default settings are correct for using UI-View or UI-View32 as the view
but they can be changed to allow another application to be used. 
 
A
UIV viewer. WinPack will regard any viewer with this name, or with this name suffixe
with "32", as being the UIV viewer. The default is UIVIEW, therefore either UIVIE
or UIVIEW32.EXE will be regarded as the UIV viewer. 
 
T

ITEM - The DDE 
 
To be usable as the UIV viewer, an application must support the DDE definition in the
three INI file entries. It will receive the file names to process in the format "LOGPLAY
filename" where filename is the full path name of the file. 
 
S  section of the help for more information, and also the "UI-View As A 
WinPack Viewer" section of the UI-View help. 



 

 

F. BPQ Virtual TNC Commands 
Q host There is a virtual TNC in WinPack which is used when WinPack is using BP

m
v

ode. (Other Host modes – AGWPE, TMEFU, TF2.7b– have a similar but different 
irtual TNC and different commands/parameters.) The Virtual TNC provides some of the 

l TNC provides.  

or example, if you are in the transmit window and press <enter> when not connected 
 

ions 
r the commands very much like a normal TNC. Tthe minimum abbreviation for each 

ommand is shown in upper case. 

 are as follows:- 

Q sends the beacon 
xt as a UI frame at the interval specified by BTINTERVAL in BPQCFG.TXT. (Setting 

features that a rea
 
F
to another station, you should get a cmd: prompt, just as if you were using a normal
TNC.  The virtual TNC only understands a few commands. It will accept abbreviat
fo
c
 
The supported commands
 
BText 
The text that WinPack will pass to BPQ to send as beacon text. BP
te
BTINTERVAL=0 disables the beacon text). The UI frame is sent to the address 
specifed by the UNPROTO entry in BPQCFG.TXT. BTEXT can include WinPack 
tokens, see the tokens list. The default BTEXT is "WinPack/BPQ". 
 
If you wish, you can make BTEXT multi-line. To make it multiline, you must edit 
PACKET.INI when BPQ isn't running, look for the BTEXT entry in the [BPQ] section, 
nd use ^M (two characters) to split the lines. E.g. "This is line 1^MAnd this is line 

ch is set up in BPQCFG.TXT 
nd sent at the interval specified by IDINTERVAL in BPQCFG.TXT. 

Connect to the node. 
 
Connect <callsign> 
Connect you to another station. E.g. C GB7OPC. 
 

a
2^MAnd this is line 3" 
 
Multi-line BTEXT is limited to a total of 250 characters. 
 
Note - do not confuse the beacon text with the IDMSG whi
a

Connect 

 
W
0 
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CText 
The text that WinPack will send to a station that connects to your system. There are two 

 by the BPQ TerminalCTEXTs, one used by WinPack and one used . The one used by 
WinPack can include WinPack tokens, see the tokens list, the one used by the Term
canno

inal 

I

t. 
 
The CTEXT used by WinPack can be made multiline if you require it. To make it 

ultiline, you must edit PACKET.INm  when BPQ isn't running, look for the CTEXT entry 

eters. 

 
e 

ou can exclude all the ports by using the command "MASK 0". 

 
 

last value it used for setting the MASK, it 
ay not be the value currently in use! 

 you alter the MASK setting for a Terminal session, you also alter it for WinPack. That 

on transmissions. 

OFF. It controls whether protocol control frames are monitored. 
B- because of the way that BPQ works, the MCOM command affects all Windows 

Inbuffers 
MINBUFFERS - sets the minimum number of buffers which must be available in the 
node for WinPack to queue any more transmitted frames. the default is 30. 

Monitor 
MONITOR can be ON or OFF. It controls whether monitored frames are displayed. 
Even with MONITOR OFF the frames are still processed for FBB beacons. 
 

in the [BPQ] section, and use ^M (two characters) to split the lines. E.g. "Welcome to 
WinPack^MSend /h for help^MSend /m to leave a message" Multi-line CTEXT is 
limited to a total of 250 characters. 
 

isplay D
Display the current settings for all the param

MAsk 
The list of ports on the node that will be monitored. The format of the command is, for 
example, "MASK 1,2,3,4" if you want to monitor ports 1, 2, 3 and 4. If you are using the
FBB beacons always have the port on which you hear the beacons included in th
mask! 
 
Y
 
NB!!  - Because of the way that BPQ works, the MASK command affects all Windows
tasks using the node. Also, it is impossible to read from the node the current MASK
setting, the value reported by WinPack is the 
m
 
If
is only a problem if you are using the FBB unproto beacons and you don't include the 
beacon port in the MASK, because WinPack won't then see any beac

MCom 
MCOM can be ON or 
N
tasks using the node. 

M
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MTx 
MTX can be ON or OFF. It controls whether frames transmitted by your node are 
monitored. NB- because of the way that BPQ works, the MTX command affects 
*allWindows tasks using the node. 
 
Paclen 

ult is 

B sync requests. It defaults to the BBS callsign, 
hich is usually correct. If you want to include digipeaters then put, for example, 

GB7OPC,G8MZX,G4IDE - G8MZX and G4IDE being the digipeaters. 

The node port on which FBB unproto sync requests will be sent. It defaults to port 1.

The PACLEN used by WinPack when sending frames to the BPQ node. The defa
120. 

Unproto 
The unproto address for sending FB
w

 
UPort 



 

G. Using WinPack with BPQ and a Baycom Modem 
From http://www.ui-view.com/winpack/bpqjjf.htm 

ote: you’ll find several other usefuN l Baycom related links at the above page, 
 
Also see FAQ #9 for other methods of using a Baycom modem with WinPack 
 
A Baycom driver for WinPack is now available to use WinPack with BPQ node software 

derneath Windows. The driver uses BAYDRV.VXD, written by G7JJF and a 
h I (G4IDE) have written to interface BAYDRV to BPQ. The driver comes with 

u 

 it’s not in the main WinPack directory, you can download the driver from: 
ww.ui-view.com/winpack/nodbay13.zip

running un
TSR whic
a reasonable level of documentation, but, if you aren't familiar with the BPQ node, yo
need to learn about that from the BPQ docs. 
 
If
http://w  

If you downloaded V1.1 of the driver, it's still worth downloading this latest version. 
Firstly, because I have renamed it and I would prefer this to become the default version. 
Secondly, because the comments in the docs about problems with 16550 UARTs are 
now MUCH more optimistic! Certainly my own problems that I was experiencing with 
some 16550s are now completely solved. The new docs contain details of a suggested 
mod for modems built on PCBs from a well known UK supplier (Badger Boards). Click 
here if you don't want the driver but are interested in this modem mod. 
 
A Plea - If you download this driver and decide to put out a message on packet about it, 
PLEASE first read the NODE2BAY.TXT file! Really, I don't think anyone should be 
announcing it on packet if they haven't tried it themselves. What's the point? You could 
be telling the world about something which is totally crap! 
 
I have chosen not to announce it on packet myself, because, to keep my life as hassle 
free as possible, I don't do that sort of thing any more. Therefore, please put sufficient 
detail in any packet message to ensure that it won't result in people asking me 
questions about it which are clearly answered in the docs. 
 
Here is the first paragraph of the the .TXT file:- 
 

NODE2BAY.EXE V1.3 (c) G4IDE, June 1997 
This file contains some very useful information. The last paragraph might be just as 
interesting and useful as the first, so please try and read it all! 
 
What It Does 
 
NODE2BAY.EXE acts as an interface between G8BPQ's BPQCODE node software 
and G7JJF's BAYDRV Baycom driver for Windows - that is why it is called 
NODE2BAY. It allows Windows packet applications which support BPQ (such as 

 

 
W
0 
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WinPack) to be used with BAYDRV and therefore with a Baycom modem. 
er, which is © 

iece of software and I would like to 
 you 
lease 

NODE2BAY is not in itself a Baycom driver.  BAYDRV.VXD is the driv
Jon Welch, G7JJF. BAYDRV is a very clever p
thank G7JJF for giving his permission for it to be used in this application.  If
have any problems using BAYDRV in conjunction with NODE2BAY.EXE, p
contact me, G4IDE -- DO NOT contact G7JJF.” 
 

 
GW7LHI's helpful notes on getting WinPack going with NODE2BAY, a Baycom modem, 
and BPQ are in the WINPAKGO.TXT file available at: 
 
http://www.ui-view.com/winpack/winpakgo.txt

http://www.ui-view.com/winpack/bpqjjf.htm


 

W
0 
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H.
 
Bo
spe
 

he Kenwood TH-D7 is a dual band (2m/440) hand-held radio 

 “These notes are based very much on a packet bulletin I sent to TH-D7@GBR in June 
1999, in reply to someone saying that they were having problems using a TH-D7 with 
WinPack. The only change I have made is to update it for the fact that WinPack from 
V6.5 onwards can collect the FBB unproto headers with HEADERLN OFF - a change 
that was made specifically for TH-D7 users. It is rumoured that a firmware update (G) 
will be available for the TH-D7 early in 2000, which obviously may affect the validity of 
some of my remarks. 
 
The following comments apply to using the TH-D7 with any packet software that 
supports a TNC in terminal mode. Hopefully this information will prevent a bit of hair-
tearing by people trying to get their TH-D7 to behave itself! The specific examples relate 
to WinPack, but I'm sure the general principle can be extended to other programs. For 
DOS lovers, from what I can remember of Paket 6, I would think all the information 
below can be modified for use with that program. 
 
A few points about the TH-D7's TNC:- 
 
1. It's comms parameters are 9600 bps, 8 databits, 1 stop bit, no parity, XON/XOFF 
(software) handshaking. If your PC has a 16550 UART COM port  and you are using 
Win95, then I would advise disabling the COM port transmit FIFO in the port properties 
in Device Manager. I found that overrun problems occurred when sending data to the 
TNC if the FIFO was enabled. (A very similar problem occurs with Kantronics TNCs.) 
 
2. It doesn't support transparent mode, so you can't use compressed download or 
upload when sending/reading messages and you can't use YAPP. There is no problem 
with either sending or receiving 7plus. 
 
3. It doesn't have a "HEADERLN" parameter, and behaves as if you have set 
HEADERLN OFF. When used with WinPack prior to V6.5, that stopped it being able to 
collect the FBB unproto headers. From V6.5 onwards it isn't a problem. The correct 
setting for the WinPack Mail Options

 Using WinPack with a Kenwood TH-D7 or D-700 

th of these radios contain an integral TNC. Although designed for APRS packet 
cifically, they can of course can be used with packet programs like WinPack. 

TH-D7 
 
T
 

 is to check Use FBB unproto lists if you want to 
use the unproto headers, or to check nothing if you don't. 
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4. It doesn't have NEWMODE and NOMODE parameters, and behaves as if you have 
t to the cmd: 

rompt when you disconnect from the BBS or any other station. One effect of this is that 
r 

his is easily fixed by modifying BBS.TXT, you need to put these lines:- 

et the TH-D7 into command mode. 
SEND ^C 

 

C if the TH-D7 doesn't seem to be responding to your 
ommands. 

r 

set NEWMODE OFF and NOMODE OFF. So it needs a Ctrl+C to return i
p
the default WinPack BBS.TXT script doesn't work, or it only works the first time afte
switching the TH-D7 into TNC mode.  
 
T
 

;G

WAITFOR cmd: 

Just before these lines:- 
 

; Send the command to connect to my local BBS. 
SEND c $BBS 

 
With other programs, if scripting isn't supported, or the scripts can't send control 
characters, press Ctrl+
c
 
5. It only uses a three wire connection to the PC, so there is no support for DCD. You
software won't be able to use the PC's DCD status line to tell if the TNC in the TH-D7 
has established a connection. In WinPack Comms Setup, you must put DCD shows 
con NO. If other programs have an option of using the "*** CONNECTED to" TNC 
message to recognise connections, then you should select it. 

meters when switched off. You need to set any 
quired parameters each time you enter TNC mode. With WinPack the only ones 

 
L 

 it 
hould work fine. 

e the TH-D7's TNC when you start the program. 
he TH-D7 control commands aren't documented in the manual, but they can be found 

ialise the 
 

 sample STARTUP.TXT 
 

 
6. The TH-D7 doesn't retain its TNC para
re
needed are MYCALL and ECHO OFF. (The TH-D7 will use as its default callsign the
callsign set under menu option 2-1, so if you put your callsign in there, setting MYCAL
isn't essential.) 
 
Once you've taken note of the above (and of course put the TH-D7 into packet mode!)
s
 
Beyond that point, you can try something "cool" like making your packet software's start-
up script automatically open and initialis
T
on several internet sites. Here, as a "taster", is a WinPack start-up script to init
TNC and an exit script to close the TNC. It shouldn't be difficult to translate them for use
with other programs. You can do much more than this, setting the data band, and 
setting the frequency are obvious enhancements. 
 
A
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;Completely close the TNC. 
SEND TC 1 
WAITLINE TS 1 
;Lock the radio, so you don't accidentally change the settings 
;while you're using packet. 
SEND LK 1 

;Open the TNC in packet mode. 

 PORTOUT 

END ECHO OFF 

;Set your callsign. 

: 

e TH-D7 into command mode. 
SEND ^C 

SEND LK 0 

WAITLINE LK 1 

SEND TC 0 
WAITLINE
;Turn ECHO off. 
S
WAITFOR cmd: 

SEND MYCALL $MYCALL 
WAITFOR cmd

 
A sample EXIT.TXT 
 

;Get th

WAITFOR cmd: 
;Close the TNC. 
SEND TC 1 
WAITLINE TS 1 
;Unlock the radio. 

WAITLINE LK 0 
 
Have fun! 
Roger, G4IDE 1999-Dec-16 
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TM-D
 
The Ke n TNC, 
similar to the TH-D7. Designed for APRS work, it can also be used for regular packet, 
but it has some limitations*. 
 
[The T

• phasis when sending 1200 baud data  -- the high tone (space) is 
e low tone (mark) 

• CK timer for AX.25 connections - it won't ACK until the other 
d retries with the Poll bit set; the D700 TNC always sets the 

hy the lack of an ACK timer doesn't impact throughput 
reciably. 

 
he fo ipt will simplify the parameters changes necessary for regular 
acket.  

inPack STARTUP script for the Kenwood TM-D700. 
 
The Sc s a suggested TM-D700.txt script for the TM-D700. You can 
access s>Play Script>TM-D700 Initialisation menu option. 
 

700 

nwood TM-D700 is a dual band (2m/440) mobile radio with a built-i

D-700 limitations reported include; 
lack of preem
similar in deviation to th
does not have an A
station times out an
Poll bit, which is w
between D700s app

T
p

llowing Startup scr

W

ripts directory ha
 it from the Script
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nes For The Use Of The Packet Radio Network  
in the United Kingdom …but makes sense everywhere 

nformation, the seeking of help and advice and the 
ublication of amateur radio related news. It is not uncommon to find messages giving 

imilar AMATEUR RADIO related 
acti e e 
area of rk is what was in many operators 
min  w
 
With th
microwave bands, the Packet Radio Network is developing and hopefully will continue 

 do so for many years to come. 

B Data Communications Committee, in consultation with the 
Radiocommunications Agency, has devised the following guidelines with which all 

) The need for messages to be within the terms of the licence conditions and the 
implications if they are not. 
 
2) Messages which could result in legal action being  taken by other amateurs or 
outside bodies. 
 
3) Actions to be taken when amateurs identify cases of abuse. 
 
4) Unattended Operation. 
 
5) General Advice. 
 
 
SECTION 1: Types of Message 
 
a) All messages should reflect the purposes of the amateur licence, in particular "self 
training in the use of communications by wireless telegraphy" 
 
b) Any messages which clearly infringe licence conditions could result in prosecution, or 
revocation, or variation of a licence. The Secretary of State has the power to vary or 
revoke licences if an amateur's actions call into question whether he is a fit and proper 
person to hold an amateur licence 
c) The Radiocommunications Agency has advised that the Amateur Radio Licence 
prohibits any form of advertising, whether money is involved or not 

..
 
The packet radio network in the UK and throughout the world is an immensely useful 
tool for the dissemination of i
p
information on AMSAT,RAYNET or other s

viti s.The GB2RS news is also available on the network, as is local club news in th
 a particular mailbox. This use of the netwo

ds hen they spent large amounts of time and money indeveloping it. 

e advent of high speed modems and use of dedicated links, some in the 

to
 
The RSG

operators are urged to comply. 
 
These guidelines have been split into five sections in order to reflect: 
 
1
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d 

oid overloading the network 

ss 
us 

ity 

ther like programs to pass text and binary based material in compressed form via the 

 
re which when decoded and used may contravene the 

l BBS. If in doubt 
 representative 

 any copyright or contravene the Data Protection Act. 

rporate privacy e.g. ex-
rs or addresses withheld from the callbook. 

in Cases of Abuse 

) Any cases of abuse noted should be referred in the first instance to the DCC 

hould be dealt with by the 

d) Messages broadcast to ALL are considered acceptable but should only be use
when of real value to other radio amateurs, in order to av
 
e) Do not send anything which could be interpreted as being for the purpose of busine
or propaganda. This includes messages of, or on behalf of, any social, political, religio
or commercial organisation. However, our licence specifically allows news of activities 
of non-profit making organisations formed for the furtherance of amateur radio 
 
f) Do not send messages that are deliberately designed to provoke an adverse 
response. Debate is healthy but can sometimes lead to personal attacks and animos

hich have no place on the Packet Network w
 
g) Unfortunately the very success of the network has resulted in messages appearing 
which are of doubtful legality under the terms of the UK Licence. The use of 7plus and 
o
Network has become common practice.  
 
Users must always be aware of the licence conditions in BR68 (also copyright, and
legal use of software, or softwail

License) when entering such messages into the Network via their loca
onsult your local Sysop or your local RSGB Data Comms Committeec

 
SECTION 2: Legal Consequences 
 
a) Do not send any message which is libellous, defamatory, racist or abusive. 
 
) Do not infringeb

 
) Do not publish any information which infringes personal or coc

directory telephone numbe
 
SECTION 3: Action 
 
a
Chairman care of RSGB HQ. 
 
b) It is worth noting that any transmissions which are considered grossly offensive, 
indecent or obscene, or contain threatening language, may contravene the Wireless 

elegraphy (Content of Transmission) Regulations 1988 and sT
police. This action should also be co-ordinated by the RSGB DCC initially. 
 
c) Mailbox Sysops have been reminded by the Radiocommunications Agency that they 
should review messages, and that they should not hesitate to delete those that they 
believe to contravene the terms of the license or these guidelines. It is worth 
remembering that their licence is also at risk as well as your own. 
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SECTION 4: Unattended Operation 
 
a) As of July 1994 unattended operation of Digital Communications cannot be carried 
out without giving 7 days notice in writing of operation to the Manager of the Local 
Radio Investigation Service (RIS). (BR68 Para 2 (5) ) 
 
The manager may, before the commencement of operation, prohibit the Unattended 

y 

he RSGB Data Communications Committee recommend supplying the following 
 

r other means of closing down the station, 
which is separate from the rest of the premises 

3) Travelling times and availability times (I.E.: 24hrs) of close down operators of 

 
owers 

used 

5) Use of Station for Digital Operation. (I.E. PMS, NODE etc) 

from the RIS 

up 
PQ and similar applications) via a PC and radio. The 

SGB DCC strongly recommend that users contact their local packet group and local 

closely with 
ach other to determine route qualities and node tables, to aid the fast movement of 

e 

Operation or allow the operation on compliance with the conditions which he ma
specify 
 
T
information when applying to your local RIS ofice for permission to operate unattended
digital operations 
 

1) An external close down switch o

 
2) A list of 4 persons including telephone numbers who can close down the 
Station. (Not all need to be amateurs) 
 

the Station 

4) Frequencies of operation (within BR68 clause 2 4(c)) antennas and p

 

 
6) Only the licensee can re-activate the Station after permission 

 
SECTION 5: General Advice 
 
a) With the advance in software writing it is now possible for packet users to set 
intelligent software nodes (G8B
R
BBS Sysop before starting operation of such nodes 
 
Appearance of such nodes without co-ordination causes problems within the local and 
inter- BBS/DXcluster/TC/PIP Network routing tables. Network Sysops work 
e
traffic via the National Trunk System 
 
The appearance of uncoordinated (rogue nodes) causes in some cases sever
problems in traffic routing 
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Packet users can experiment with software nodes without affecting the node tables of 

oftware parameters of the node to stop propagation 
f the node into the Network. 

s or 

t write in the heat of the moment. Word process your bulletin first, then reread 
. You may feel differently after a few minutes 

 you really need to send them, are they amateur radio related, would 
ey be better sent on disc in the post ?? 

 
e) Plea  Sysop. Remember that you are 
using, in most cases his own equipment, which is in his home. Try to comply with any 
reques
 
f) When accessing your local Mailbox at busy time and are having problems holding the 
link, try
busy 
 
g) Obe
 
 
RSGB
Radiocommunications Agency 
July 19

local network nodes, by setting the s
o
 
Advice can be sought on the setting of software parameters from local node Sysop
BBS Sysops 
 
b) Do not send "Open Bulletins" to individuals 
 
c) Do no
it
 
d) Stop to think before sending GIF images and the like which sometimes are in large 
multi- part files, do
th

se try to show some consideration for your local

ts he makes of you 

 not to turn your power up just to maintain the link. Try later when it is not as 

y the Golden Rule - If you would not say it on voice do not send it on packet 

 Data Communications Committee 

95 
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Kenwood T
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lic
lo

 

M 75, 121, 149, 

M
m

ing, 43 

 

Netscape, 94, 112 

NNA BBS, 21, 22, 39, 49, 50, 51, 56, 

opening screen, suppress, 68 
29, 33, 47, 49, 51, 61, 
86, 94, 97, 98, 112, 

1, 149, 
 

pa BS, 25 
pa 64 
pause window scrolling, 81 
PC Flexnet, 138 
ph
P

, 173 
prune, bulletin list, 35 

registering WinPack, 5, 7, 153, 171 
 6 

68, 183 
, 71, 170, 183, 195 

s & tokens, 63 

sc se window, 81 

Selection List Editor, add-on program, 
36, 104 

se

servers, request files, 84 

9, 162, 174 

, 
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BB unproto list, 73 

7, 90, 92 
te
Te
TF
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Th
Th
TN

onics, 150 

C cards, 131 
15, 177 
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to , 92, 100, 
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172, 182, 189, 190
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KZIP, 57, 94, 184 

print, 6, 11, 47, 155

receive window, 9, 11, 12, 81, 165 
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right click, 12, 29, 43, 
scripts, 58, 59, 63, 64

control character
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rolling, pau

send file, 48 
nd messages, 43 

serial port, use without, 68 

short cut keys, 86 
signature, 46, 65, 87, 15
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sound card, 18, 72, 88, 102, 118, 131

139, 140, 164 
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saving & re
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183, 189, 190

TPK, 25, 38, 73, 74, 75, 185 
transfers, file, 48 
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189 
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44, 189 
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